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The Artlantis Family

Artlantis combines the most advanced and effective functions for realistically simulating the material and lighting
effects needed for any 3 dimensional project. Artlantis Render communicates directly with leading CAD architecture
software (such as ArchiCAD, VectorWorks, SketchUp, AutoCAD, Arc+, etc.) and can import the main CAD file
formats formats: DXF, DWG, 3DS, DWF, OBJ, FBX SKP, GS1. As well as OBJ, DWF, FBX, SKP, U3D expert
functions.

Artlantis technology is available in two main versions, offering a product line suited to different needs and practices.

Artlantis Render - Radiosity for fixed images

Artlantis Render is a unique and ideal tool for performing very high resolution rendering easily and in real time. The
FastRadiosity™ engine lets you calculate radiosity images... with preview in real time. Artlantis Render uses 3D com-
ponents and 3D vegetation directly in the preview window by simply dragging and dropping them. This enables
users to work quickly on the various scenarios and simulate virtual scenes in a real environment.

Artlantis Studio - Animation for everyone

Artlantis Studio is the perfect tool for professionals who design presentations based on fixed images, animation,
QuickTime VR panoramas, etc.

Equipped with the new FastRadiosity™ engine, Artlantis Studio offers advanced functions such as scene animation
and object animation, to name just a few. Just like with most Artlantis functions, camera pan, viewpoints and aim
points are defined easily and intuitively.

Artlantis Media

In addition to the standard library, Abvent offers theme-oriented CD-ROMs that provide a multitude of materials and
3D objects that you can use to produce composite images. These are produced specially for Artlantis by a number of
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Chapter 1 kd

industry partners or independent designers.

e

—| This icon indicates functions that are particular to the Artlantis Studio version.

New Features in Artlantis 3.0

New radiosity rendering engine

e Improvement in the light model which shows a fine level of detail. See " Example: light model" page 3

e Access to predefined interior and exterior light settings. See "Display of rendering options for the "realistic
photo" engine in the current mode" page 159

e Working in Expert mode allows the user to find the best lighting performance. See " Viewpoint rendering set-
tings in Expert mode in the "Photorealistic" engine" page 160

New geometry management

o Geometry is handled by Hierarchy See " The Objects Inspector by Hierarchy" page 122 or by Layer. See "
The Objects Inspector by Layer" page 124

o When an object is saved, this can be done externally (.aof) or internally (linked to the current project). See "Cre-
ating the object” page 131

o Billboards and 3D vegetation have a transparency factor. See "Transparency:" page 133

New graphic repositioning of an object's anchor point

e Internal or external (.aof) object anchor points can be instantly redefined from the 2D view. See " Working with
Objects in 2D View" page 38

New light falloff
9. 9 predefined lighting projections.
New Feature: animated water

e Water can be animated directly from the Shader Inspector. There is no longer any need to adjust their settings
in animation mode. See "Animation settings:" page 109

New Feature: cloud animation

e Clouds can be animated directly from the heliodon Inspector. There is no longer any need to adjust their set-
tings in animation mode. See "Wind " page 145

New management of Medias when a project is opened

¢ Missing media can be: searched, replaced or deleted. See " Opening an Artlantis File" page 15

New Feature: exporting a project in another format

e U3D, DWF, OBJ, FBX, SKP. See "Saving a Document" page 21

Import upgrade

e DWG, DXF and DWF compatible with the AutoDesk 2010 range. See "Opening Documents" page 15
e For ArchiCAD 13 users, Artlantis 3 now retrieves all the defined levels. See "Opening Documents" page 15
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- Opening old Artlantis files

Example: light model

Artlantis Studio 3 ambient lighting.

Opening old Artlantis files

Opening Artlantis 2 files

By default, the files will keep the same appearance as in version 2. The Radiosity rendering settings will be under
Custom in the drop-down menu. According to the type of view you can redefine an interior or exterior lighting type.

You can also define other custom settings - see Expert settings.
Opening Artlantis 1.2 files

Scenes produced in Artlantis 1.2 must be converted.

Shaders Inspector
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Texture Definition Controller

In Artlantis 3, the software's engine automatically computes the level of texture definition.

Modifying the Material Definition

In earlier versions of Artlantis (including version 1.2), material definition was based on an "Extended Phong"
model that was perfectly suited to rendering for launching rays, but was not appropriate for radiosity. Artlantis 3.0
interprets material components more realistically. The definition of Shaders is not changed by compatibility concerns
with the Shader collection acquired.

Viewpoints Inspector

The old Atmosphere function is no longer supported and more advanced functionalities are available in the Hel-
iodons inspector (simulation of sky and sun, natural fog, cloud editor).

The 2-color gradation has been replace with a new 3-color gradation.
Gradation rotation is no longer supported.
Depth of field effects are slightly different.

The hatch engine is no longer available and has been replaced by the Post-Production Effects.

Heliodon Inspector
The radiosity contribution check box has been removed. The sun and sky contribute to overall illumination.

5 colors have been deleted for customizing the sky. Artlantis 3 uses a new sky and sun simulation with natural
lighting. When files produced in 1.2 are opened, they are converted to this new physical simulation model.

Light inspector
Artlantis 3 uses a physical light model that is not compatible with the version 1.2 light settings.
The radiosity contribution check box has been removed. The light contributes to overall illumination.
The parallel light has been removed.
The spot and lighting point are merged under lights.
The blurred shadow and transition parameters have been removed and replaced by a variable that is available for all
lights.
Catalog
It is no longer necessary to catalog the media folder.
Simply specify your preferred folder.

System Requirements

Minimum System Requirements

Intel Dual-Core 2.66 GHz or equivalent

CPU running at 2.66 GHz

RAM : 4 Gb.

System: Windows XP SP3, Vista Home Basic x32 or 64 bit
128 MB graphics card, OpenGL 1.4 capable.

Display resolution: 1024 x 768 million colors

Internet access

QuickTime™?7.6.2

3-button mouse with wheel.

Recommended System Configuration

Intel 8 Core or equivalent

CPU running at 3 GHz

RAM : 4 Gb.

System: Windows XP SP3, Vista Home Basic x32 or 64 bit or Windows 7
512 MB graphics card, OpenGL 1.4 capable.

Display resolution: 1600x 1200 or greater

Internet access
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e QuickTime™7.6.2
e 3-button mouse with wheel.
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Serialization

About the Software activation. 3

In this chapter you will learn about the following subjects:

Activating and Evaluating Artlantis. .. ____ ... 7
License Activation for Windows. . .. ... ... 7
Deactivating the License. .. ... ... 9
Evaluation Period. . .. ... .. .. e 11
Install and activate network license. . . ... ... ... 11

Activating and Evaluating Artlantis

The first time Artlantis is launched, the activation and evaluation dialog box appears, as shown below:

Evaluation Version

License not activated

W The evaluation period will expire in 30 daps.
“You can activate a new license, run Artlantis in evaluation mode, or quit.

[ Evaluate H Check Metwork. ” Gt ] I Activate License

License Activation for Windows

By Internet

License Manager

1°] Enter your sarial number
2% Clhick the Activate License button

Enter your serial rumber: [T —
Activate Lkense

e Locate the serial number * (composed of two numbers separated by a dash) that is shown on your registration
card or was e-mailed to you.

e Check that you are connected to the Internet. Artlantis will have to connect to the activation server.

NB: when launched, Artlantis will check automatically for an Internet connection.

e Enter the serial number.

e Click on the Activate License button. A message will display confirming activation. Close out of the message to
display the open file dialog.
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NB: *the serial number can be used regardless of whether you are using a Mac or Windows.

Potential Problem

License Cannot Be Validated:

M WUnable to activate heense: Mo more beenses avalable (1)

The maximum number of users associated with the license in question has been reached. To activate the license
number of a new workstation, you must first deactivate it on the workstation(s) currently using this license*. You can

then activate the number on the new workstation. Another solution is to purchase a new license at a reduced cost.
Contact your reseller for more information.

NB: * You do not have to uninstall the sofiware.Simply deactivate the license.

Manual

In case of no Internet connection.

License Manager

Hanual activation, o server connection avalable:

1°f Enter your serial number

2°] Enter the 'ldentity’ number &t hitp: [ activation. srthantiz, com
3°] Enker the activation code returned by the server

4 Chek the Ackivate License button.

Erter your serial number: OBt 000
Your identity number is: | .

Enter the adtivation code:

Actvate Ukense

e Locate the serial number (composed of two numbers separated by a dash) that is shown on your registration
card or was e-mailed to you. Jot down the identification number located on the license handler (this number
is encrypted).

o Use a machine connected to the Internet and go to the Artlantis activation site at: http:/-
/activation.artlantis.com

e Once the activation page appears, enter the identification number that you had written down earlier then click on
the button "Connect to server".
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Serialization - Deactivating the License

= vin

ARTLANTIS

1°/ Enter your Identity Number here

29/ Connect to server by clicking this button

Connectta server... )

39/ Copy this code and enter it in Artlantis dialog

You will then receive a license number that you will copy and paste in the Enter your Activation code field of the
license handler.

Click the Close button to confirm

M Congrabulatiorss! "Your boense has been achivated.

Deactivating the License

Help Menu> Edit License... click Deactivate.

A keense can be activated on only one computer 2t a kime, For your converssne, you can deactivate a
guhmm:mmdmummhmmﬁnm&nmﬂwm-m&mh
tware.

Youcan ko bury addiional cences st & specal decount. Plaass contact your local distributor or recellsr
For more information.

Deactivate License

To deactivate the license, click on "Deactivate license". Then click Close.

Manual

In case of no Internet connection.
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A lcense can be activabed on only one computer ak a time. For your conversnce, you can deactivate a
:l:\sefrmom(wma\dmu on another one without instaling andjor unvinstaling the.
tware.

also buy addiional l s & special discount. Ple your bocal distributor or reseler
For more information.

Marnsal deactivation, no server connection avalable:

1°f Click the: Deactivate button

2%f Enker your Identity number af. http:[factivation. artlantis.com

37 Enter the desctivation code raturned by the server

4°f Chick. on the Close button,

Deactivate License

e Click on the Deactivate license button then confirm the deactivation.

A lcense can be activabed on only one computer ak a time. For your converssnce, you can deactivate a
::'\sefrmor\e(wma\dmu on anather one without instaling andor un-instaling the:

tware.
You can slzo buy addrional licenses st & special discount. Please contact your kel distributor or reseler
Fior more information.
Marusal deactivation, no server connection avallable:
1°f Click the: Deactivate button
2% Enkes your [dentity number ot http:/[activation. artlantis.com
3°] Enter the deactivation code returned by the server
4% Chick. o the Close button,

Your identity nusmber i:
Enter the deactivation code:

e Jot down the identification number located on the license handler (this number is encrypted).

o Use a machine connected to the Internet and go to the Artlantis activation site at: http:/-
/activation.artlantis.com

e Once the activation page appears, enter the identification number that you had written down earlier then click on
the button "Connect to server".

ARTLANTIS

19/ Enter your Identity Number here

29/ Connect to server by clicking this button
( Connect to server_._)

3%/ Copy this code and enter it in Artlantis dialog

The server will send you back a code number that you have to copy and paste in the Enter the deactivation code
field in the License Manager.

e Click on the Close button, then validate to confirm the deactivation.
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Serialization - Evaluation Period W

M Appicalion was conecty deaciivated Anlanis: wil now quil

Evaluation Period

Clicking on "Evaluate" launches Artlantis in evaluation mode for 30 days. All of the software's commands are oper-
ational for this period of time: Open, Save, etc. The only restriction is that the Artlantis demo logo appears at the bot-
tom of renderings.

The application will no longer open files after the 30-day trial period has expired. However, it will continue to start up
so it can be activated. Contact your reseller to purchase a license.

Evaluation Version

Licénse not acltivated

M The evaluation peiod has spaed
You can activabe a new boense of quit

Check. Metvek. ][ Qust ]l Actvate License ]

o Click on "Activate License" to access the activation dialog.
e Click on "Quit" to close out of the program.

NB: With the licensed version, you can continue any work you started using the evaluation version.

Install and activate network license

Purpose:

Using the Artlantis Keyserver enables you to launch Artlantis on a specific number of client computers connected to
the same network.

At an instant t, Artlantis can be launched on x-number of client workstations simultaneously (with "x" being the
number of licensed workstations). Once it is launched on x-number of workstations, Artlantis will not launch on any
additional workstations without first quitting out of it on one of the stations where it is open.

Requirement:

e asingle network with Mac and/or PC workstations connected (Important: no sub-network).
e A special "Network" serial number.
e The Artlantis Keyserver application located in the Artlantis installation directory.

Installation:

Install and validate the license either over the Internet (recommended) or manually.

Step 1 - Activate the network license on the server

e OnalLAN, select the computer that will act as the server*, then launch ArtlantisKeyserver in the Artlantis instal-
lation folder.

* The server can be any computer connected to the network. It is best to select a computer that is connected to the

Internet.

e Click on "Edit License...". The license manager is displayed,
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= Artlantis Key Server

ARTLANTIS

STUDIO

KEYSERVER

© Copyright 2005 - 2009 Abver e
No netwoek boanse on ths computer. Artlantis KeyServer

[ pdate ucerses | [(Edeucerse... |[ o |

Validation by Internet:

1°f Enter your sarial number
2°f Chck the Activate Licerse button

Erier your serisl rumber: [—
Actvate License

e Enter the network number (composed of two numbers separated by a dash) that is shown on your registration
card or was e-mailed to you.Then click on Activate License. A message should confirm that the license has been
activated correctly.

Validating manually:

A lcense can be activabed on only one computer ak a time. For your converssnce, you can deactivate a
gmrrmm:mmmdmu on anather one without instaling andjor un-instaling the:
tware

You can sleo buy addtional kesnsas st a spacial discount. Plaass conkact your loesl distributor or resellsr
For more information.

Marnsdl deactivation, no server connection avalable:

1°f Click the: Deactivate button

2% Enker your Identity number ot http:[factivation. artlantis.com

3| Enter the deactivation code returned by the server

4°f Chck o the Close butkon,

Your identity number is:
Enker the deactivation code:

e Locate the serial number (composed of two numbers separated by a dash) that is shown on your registration
card or was e-mailed to you.

e Jotdown the identification number located on the license handler (this number is encrypted).

o Use a machine connected to the Internet and go to the Artlantis activation site at: http:/-
/activation.artlantis.com

e Once the activation page appears, enter the identification number that you had written down earlier then click on
the button "Connect to server".
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Serialization - Install and activate network license W

L

ARTLANTIS

1°/ Enter your Identity Number here

2°/ Connect to server by clicking this button

39/ Copy this code and enter it in Artlantis dialog

You will then receive a license number that you will copy and paste in the Enter your Activation code field of the
license handler.

M Congrabulations! 'rour Beanze haz been activated.

Start the Artlantis Keyserver * application located in the Artlantis folder that was installed.

NB: Artlantis KeyServer must be launched only on the server workstation. The server identification number
is activated only once on client workstations.

* In order for the client workstations to be able to use Artlantis, the Server must be activated and Artlantis Key-

Server launched. They can operate on the Artlantis server and Artlantis Keyserver at the same time.

Step 2: Install Artlantis on the client workstations.

e Make sure that Artlantis Keyserver is launched on the server.You can now launch Artlantis on the client sta-
tions.

e Click on Check Network to find an available key. If there is an available license on the server, the application
will be activated immediately.

o network icense on this computer. Artlsntis KeyServer i not ensbled!

[ Updsteticenses |[Edtikense. |[  qut |

Potential Problems

e If Artlantis prompts you for a serial number on a client workstation: Check that the computer is connected to the
local network. Check that the Artlantis Keyserver has been started on the server.

e On the Server with Windows XP in SP2 mode and Firewall activated.

e Click the unblock button when the Firewall shows that the ArtlantisKeyserver or Artlantis is trying to use the
network.

e For another Firewall, ensure that port TCP 49151 is open.

NB: changing this setting does not affect the security of the Mac or the operation of other sofiware.
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Opening Documents

Artlantis reads the following document formats:

NB: for ArchiCAD 13 users, when you export to Artlantis, you have the option of exporting the geometry
according to the ArchiCAD layers. In Artlantis’ Objects Inspector, the ArchiCAD layers will be listed in the Layers

tab. If you do not want to export the geometry in multiple layers but in a single layer only, check Single layer in the
export dialog box.

NB: ArchiCAD, SketchUp and Vector Works export** directly to the Artlantis ATL format.
**If you do not have the export plug-in for one of the programs, you can download it at: www.ar-

tlantis.com/download/update

In this chapter you will learn about the following subjects:

Opening 3D Files. ... il 15
Opening an Artlantis File. .. .. 15
Opening DWG/DXF Files. . . ... . 17
Opening DWE Files. . . ... 18
Opening OBJ Files. _ .. . il 18
Opening FBX Files. _ ... il 19
Opening GS1 Files. . .. .. 19
Using reference files. . ... ... 20
Opening 3DS Files
Scale Factor Moves

1,000 Dir aring uindts ®: | 0.000000 om

Wil b corveited to ¥r o | 0,000000 o

1.000 i i | 0000000 om

[+] Canvvert eameras [#] Conwvert bght= Impsort

e Scale factor : reduces or enlarges object size. The scale factor is a homothetic coeftficient.
o Converting cameras or lights: Imports lights and/or cameras defined in the original model.
e Translation: Redefines the position of the imported object relative to the scene's geometric tag.

NB: Artlantis imports material names, textures and fixed cameras.

Opening an Artlantis File

Either by:

Page - 15


http://www.artlantis.com/download/update
http://www.artlantis.com/download/update
http://www.artlantis.com/download/update

Chapter 3

Double clicking on an ATL or AOF file.

When the following dialog appears when the file is opened, this means that one of the Medias associated with the
project is missing. Click on the missing element(s)

Locale missing media

Medkia usad in this dotument but not found:
us paralel Obe,ipg

X004 ASH

Shroers. aof

05 _standard mapds. saf
Beergamot_2_alicolours, aof

Dets || Foker.. || Replacewith.. |

e Delete: permanently deletes the missing linked Media, it will no longer be requested when the document is
opened.

e Folder...: lets you browse through the hard disk to define the folder containing the missing listed elements.

e Replace by...: allows the missing Media to be substituted by another.

e Continue: closes the dialog box taking account of the options selected.

Opening a File when the Application Launches

Open (@]
Look i | (3 Island_Final “ OF @ (7] Show preview mape

5 Cy0biects
CiPictres

My Focent
Docuent:

Deskiop

yshaders
olskod Foal ]

My Documents

M’S»!
T T -
Feolps st 001 D

My Ntk [ Open 2 readory

Open Recent

e Lists the last 10 Artlantis documents opened.
Open...

e Displays the dialog box for opening documents.

Artlantis files saved in a version earlier than 2.0 must be converted when they are opened. When this occurs, Art-
lantis displays a data conversion dialog:
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Opening Documents - Opening DWG/DXF Files d

This file was crested by an older version of Artlantis.

—  When saved, R wil be transformed into the new Artlantis format, not openabie by clder versions.

W7 Rutlantis 2.0 uses o physcal e rendeing enine 50 some of the vakues st be adhusted cr converted to abtai serie
rendering resdts.

Fhoase us the settings below For & smocther transtion.
Sun snd Sky ighting parameters vl be replaced by 3n sutomatic Sun snd Sky physical smulstion

) [Econvern alight pover valuss to: 500.00
¥ waluos higher y

a By defoult the "Neon” shaders will ot participate to the bohting of the scena. Use the new manu in the Visw
Inspectoss to actrvate them.

@ [ Replace Badkground by natural sun and sky for the visws using an helodon.

‘Tha Atmasphers ssttings Used in 1.2 have bean replaced by clouds, fog and polution which you can adjust in
the Heliodon inspector.

@ [activate Ground

Cee ]

Convert lamp power:

In version 1.2, lamp powers varied from 0.10 to 5000. From version 2.1, the power varies from 1 to 1000000.

m  Box checked: The lamp power values will be readjusted according to the new 1 to 1000000 scale. If you use the
digital field to set the value beyond that, the power values will not be replaced.

m  Box unchecked: Lamp power values are retained. Note: the lamps will not have the same intensity.

The neon Shaders are not activated, so they will not take part in the lighting of the scene:

By default, the neon Shaders in version 1 will be deactivated. Y ou can activate them using the viewpoint inspector
drop-down menu.

Replace current background with natural sun and sky:

m  Box checked: The sky and sun replace the background defined in version 1.2.
m  Box unchecked: The version 1.2 background is not changed.

Activate infinite ground:

m  Box checked: An infinite ground will be placed at an altitude of 0. The altitude setting will be made in the Object
inspector.

m  Box unchecked: No infinite ground. However, infinite ground may be activated in the Object inspector.
Quit
e Closes the program without opening any document.

Drag/Drop a file to the Artlantis icon

NB: Artlantis also reads the old OPT/DB file formats produced by Artlantis 4.0

Opening DWG/DXF Files
File Import Options X
Materinl affectation Scade Factor
(%) By color 1.000 Draming units
Oy layer Wil b corverted to
Eéock, Treatment
OBy biock S ||
) By block instance
© b Hokrae Subdivision degree: | 16
= [import dosed edges
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e Scale factor reduces or enlarges object size. The scale factor is a homothetic coefficient.
o Curve segmentation value: The number of stops needed to define a curve or a circle entity.
e Import closed contour: Considers closed contours the same as surfaces.
e Block treatment: Interprets the block's material based on the following:
= [ts composition
= [ts instantiation
m [ts name
m A distinct block has a distinct material.
= Each component of a given block has a distinct material.

m A distinct material is attributed to each bloc name.

o Allocating materials: To be defined either depending on the colors or the block layers.

NB: Artlantis recognizes the ACIS 3DSolid entities of AutoCad dwg and dxf files. Artlantis imports material
names and fixed cameras.

Opening DWF Files
DWF Import Options E
Scale bachoe Coordingbe system
1.000 Dirawwineg units: Conwert from up-acs ) W
Wil ke converted te
1.000 |om v Conwert from handedness | Hoht v

[use urits and cocedinate system settings from the DWF file

e Scale factor reduces or enlarges object size. The scale factor is a homothetic coefficient.
o Coordinate system:
m Vertical axis orientation: The height defined in the modeler according to depth axis Y or height axis Z.

m  According to handedness: Right or left, viewed from above, changes the object's symmetrical view.

o Use system coordinate and unit parameters: import the file with the standard settings.

NB: Artlantis imports material names and textures.

Opening OBJ Files
0B Import Options %)
Scale bachoe Coordingbe system
1,000 Drawang units Comwert From up-ats ¥ w

Wil b corverted b
1.000 em » Conwert from handedness - | right v

e Scale factor reduces or enlarges object size. The scale factor is a homothetic coefficient.
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e Coordinate system:
m Vertical axis orientation: The height defined in the modeler according to depth axis Y or height axis Z.
m  According to handedness: Right or left, viewed from above, changes the object's symmetrical view.

NB: Artlantis imports material names and textures*.
*You must also generate an MTL file when importing textures. The OBJ and MTL files must be side by side when

importing.
Opening FBX Files
FBX Import Options @
Scale Factor Coondinate sychem
1.000 Draedng units Conrvert from up-aods L w
Wil b comerted to
1.000 am ¥ Corvvert from handedness | right ¥,

[ Use uits and coordinate system settings from the FEX fie

e Scale factor reduces or enlarges object size. The scale factor is a homothetic coefficient.

e Coordinate system:
m Vertical axis orientation: The height defined in the modeler according to depth axis Y or height axis Z.

m According to handedness: Right or left, viewed from above, changes the object's symmetrical view.

NB: Artlantis imports material names, textures, light sources and fixed cameras.

Opening GS1 Files

File Import Options

e Scale factor increases or decreases the size of the scene. The scale factor is a homothetic coefficient.

e Drawing units : Choose a unit of measure equivalent in m, cm, feet, inches.

NB: Since Arc+ versions 14 through Progress 4 are limited to 16 colors for distinguishing materials, you
can use the Merge geometry from file command to open more than one document in the current Artlantis ses-

sion.
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Using reference files

File Menu > Use Reference File...

My Comguites
File neame: o Open
"‘ J Filez of type: At 3] w Cancel
= —
My Netvoek 10000 a2 readory

[¥] Reploce curment shaders with reference file shaders

y @ » 9
= = &)

Trripn
Q@ ¥ @
B B B B

(o
This command lets you:

o Refer to a previously created .atl file in order to recover Shaders, Lights, Heliodons, Objects, Perspectives,

e
Parallel Views, Panoramas, VR Objects or Animations | as desired.
e Update the geometry and materials between the modeling software and Artlantis.

In the dialog box, check the elements to be recovered from the reference file: Shaders, Lights, Heliodons, Objects,
Perspectives, Parallel views, Panoramas, VR Objects, Animations.

Example of Updating Geometry*:

Let us assume that you need to add a door to a document named "A .atl" that is dressed, lighted, etc.
Steps:

Save the current 4.atl document.
. Return to the modeler and add the door. Export the file again and rename it B.atl.
3. Open the B.atl file in Artlantis. Select Use Reference File... from the File menu and select the reference file 4.atl
in the dialog box.

Artlantis will apply the checked options from file A to file B, i.e. Shaders, Lights, Heliodons, Objects, Perspectives,
Parallel Views.

NB: for files from modelers which export in file formats DWG, DXF, 3DS, FBX, OBJ, DWF, GS1, etc. , you
must first save the files in .atl format.

NB: limitations to the Use reference file... command :
1 - if a material has been renamed or reassigned, it will not be included

2- if a part of the geometry has been saved as an object, the destroyed geometry will reappear
3- if the Artlantis layers containing the geometry of the scene are renamed, the geometry they contain will not be
included.

NB: * the CAD sofiware ArchiCAD and Vectorworks allow you to directly update an atl file already worked
on in Artlantis. Please refer to the documentation for the sofiware involved.
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Saving a Document

Artlantis saves to the following document formats:

ATL The working document.

AOF Format for scenes, as well as objects.

Archive Contains all elements of a project.

DWEF, the vector graphics file format for AutoCAD 2D and 3D.
FBX, Fbx file format.

OBJ, Wavefront file format.

Universal 3D, (U3D) the standardized file format for the universal exchange of 3D files.

SKP, SketchUp file format.

In this chapter you will learn about the following subjects:

Saving an ATL Document. . ... ... ...

Saving an AOF Document.
Saving a U3D Document.

Saving an FBX Document. . ... . ...l
Saving a DWF Document. ... ... il

Saving an OBJ Document.
Saving an SKP Document.

Saving an Archive ...

Saving an ATL Document

Saves the current Artlantis document to your file system. If you try to close an unsaved document, or you go to quit
out of Artlantis when an unsaved document is open, Artlantis will warn you to save your work before continuing.

File > Save

NB: Saved documents will no longer be compatible with earlier versions.

Saving an AOF Document

Saves the entire active scene as an .aof object. Does not replace or close the file you are currently working on.

NB: The origin of the created object is similar to the Scene origin, to modify See "Transfer the origin of the

anchor point:" page 128

e Select File > Export as Object...

My Compter

.f\ Save at type: Astlanits Object (" acf] v | canca |
My N.:t_w:ak
[¥] inchade bght group Light Group_t v
Object placemenk property:  (3) Perpendicular to support

O Bhusys vertical
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1. Include light group:
e Choose the light group you wish to save with the object. This group will be automatically integrated

into the project concerned.

2. Object positioning:
o Always vertical to project regardless of the surface to which it is applied (for example, a vehicle).

e Perpendicular to the surface on which it is placed.

Saving a U3D Document

Saves the whole active scene in Universal 3D (U3D) format. Does not replace or close the file you are currently
working on.

e Select File > Export...> U3D.

Save As: l_Lof_t:SlarIZS_ B
Where: | (g Pictures. 3
File format; « dwf g
foe
obj
skp 3
u3d h‘—

Saving an FBX Document

Saves the whole active scene in tbx format. Does not replace or close the file you are currently working on.

o Select File > Export...> fbx.

Save As: l_Lof_t:SlarIZS_ @
Where: | [iF] Pictures B3|
File format; + dwf g
fox
obj
skp . :’
udd h‘—

Saving a DWF Document

Saves the whole active scene in DWF format. Does not replace or close the file you are currently working on
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Saving a Document - Saving an OBJ Document

o Select File > Export...> DWF.

A
Save As: | Loft_Start23 =)
Where: | (i Pictures hﬂ

File format; « dwf i
fx
obj I
skp
udd B

Saving an OBJ Document

Saves the whole active scene in OBJ format. Does not replace or close the file you are currently working on.

e Select File > Export...> OBJ.

Save
Save As: | Loft_Start23 | =)
Where: | (i Pictures HH

File format; ¥ dwf i
fhix
obj I
skp
udd E

Saving an SKP Document

Saves the whole active scene in SketchUp format. Does not replace or close the file you are currently working on.

e Select File > Export...> SketchUp.

Save
Save As: | Loft_Start23 | =)
Where: | (i Pictures HH

File format; ¥ dwf i
fhix
obj |
skp
udd B

Saving an Archive

Saves the current document in the folder that groups all of the elements pertaining to the active document: *.atl files
and media folders: Shaders, Objects and Images and an ArchiveReport.txt file. This is a useful function for users to

share their projects.
File > Export as Archive...
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Artlantis Interface

General Information

By default, the Artlantis menu bar, the inspector navigation palette and the Preview window appear when the pro-
gram is started up.

The following other elements can be called up: General Preferences, the 2D View window, the Media Catalog, the
Timeline and the Batch Rendering window.

Place the cursor over the palettes and window commands to display pop-up help bullets.

You can drag/drop objects, Shaders, textures, background images from the catalog or directly from the hard drive
to the Preview window.

Placement of Artlantis Palettes and Windows

Menu bar
Document preparation palette(dockable palette)

Navigation tools palette (dockable palette)
Artlantis tools palette (dockable palette)
Viewpoint and layer selector (dockable palette)

Inspector palette

Viewpoints List
Preview

2D View Window
10. Catalog (dockable palette)

e A T

—_—
—_—

Timeline (dockable palette)

Temps courart: Dusée:

= EEE‘@B @ [‘onos18 | | sequenca: [0010:0C

LI

In this chapter you will learn about the following subjects:

Navigation InSpPector. . . .. 26
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The Artlantis Menus. . . ... 27
File Venu. . e 27
Edit Menu . 28
Display Menu. - . il 28
Inspector Menu. . ... 30
WINdow MenU. .. e 31
To0ls VN, . .. 31
Help Menu. _ ...l 31

The 2D View Window. . . . il 31
Editing in 2D VieW. L. e 32
Fixed Images. . ... e 32
ANIMations. | .. 32
2D View Display and Navigation Tools.. ... ... ... ... 32
Customizing the 2D View Toolbar. . ... .. . 33
Modifications in 2D VieW. . . .. e 33

Editing the Clipping BoxX _ .. ... il 74
In 2D VaeW. | . 74
Preview Representation. ... . ... e 74
The Preview Window. . ... 75
Preview display and navigation tools . ... _._ ... 76
Customizing the Preview Toolbar. .. ... . 77

The Timeline Window. . .. ... 77
Introduction:. . . 77
DS plaY. .. 78
ANIMating . ... 78
The Timeline window is divided into the following 4 areas:.._ ... .. .. _ . _ . _ . .. .. . ... _............... 78

Keyframes and Guides. . .. ... .. ... e 82
Keyframes. .. ... 82
GUideS . i 85

Navigation inspector

Enables the user to edit viewpoints and animations, to configure model dressing, apply lighting effects and integrate
the project into its environment.

The behavior of certain mouse and keyboard shortcuts is dependent on the current Inspector.

The Inspector is a detachable palette, Ctrl + click at the top of the palette. To move it, click at the top of the window.
To re-insert into the window, drag it to the left-hand part of the window.

The following 9 inspectors are available:
Shaders

Lights

Heliodons

Objects

Perspectives

Parallel Views

B

e
Panoramas |

VR Objects — |
g

Animations _
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S ¥ || @ -
Activation and changing from one Inspector to another: either via the Inspector menu, or via the document prep-
aration toolbar available in the toolbar.

e Click on the desired Inspector (e.g. Heliodon in the figure below).

&H ¥ x4 @- B

» Perspectives
Paraslel Views
Parioramas
Vit Objects
Arimations

e To navigate between viewpoint and animation inspectors, click the arrow on the right.

The Artlantis Menus

Use the menu bar to access the following commands: file management, display, navigation among the various edit
modes, managing window opening and closing, and online help.

In this chapter you will learn about the following subjects:

File Menu. . il 27
Edit VIenu . . e e eiaieiaaa.. 28
Display Menu. . . e 28
Inspector Menu. . . . il 30
WIndow MeNUL . . ... 31
To0ls MeNU. . ... e e 31
Help Menu. . 31

File Menu

Contains the commands for managing documents (opening, saving, printing).

Open...

Saved Artlantis *.atl document. This command will directly open files in the following formats: atl, aof, opt/db, dwg,
dxf, dwf, obj, fbx, gs1, skp and 3ds.

NB: Artlantis recognizes the ACIS 3DSolid entities of AutoCad dwg and dxf files.

Keyboard Shortcut: Ctrl O
Merge Geometry from File...
A file currently opened can be merged with another file: atl, aof, opt/db, dwg, dxf, dwf, obj, fbx, gs1, skp and 3ds.

Save

Saves the current Artlantis document to your file system. If you try to close an unsaved document, or you go to quit
out of Artlantis when an unsaved document is open, Artlantis will warn you to save your work before continuing.

NB: Saved documents will no longer be compatible with earlier versions.

Keyboard Shortcut: Ctrl S
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Save As...

Opens the Save As dialog box, pointing to the current folder. You can save the current file as a new document. (Ena-
bles the user to rename the file and save it to a different folder). The new file becomes the active document.

Reverts to the saved version

Active document when it was last saved.
Export as Object...

Saves the entire active scene as an ".aof" object. Does not replace or close the file you are currently working on.

Export as Archive...

Saves the current document in the folder that groups all of the elements pertaining to the active document: *.atl files
and media folders: Shaders, Objects and Images and an ArchiveReport.txt file. This is a useful function for users to
share their projects.

Export...

Exports the geometry of the current document in Fbx, OBJ, SKU, U3D or DWF format.

Use a reference file...

Recovers all or part of the elements from a different .atl file into the current file. This can import shaders, lights, hel-
iodons, objects and cameras from Perspective and Parallel views.

Edit Menu

Standard commands for handling files: Undo/Redo/Cut/Copy/Paste/Erase/Preferences.
Undo

Undoes the last command.Also allows the user to step backwards undoing all operations performed since the doc-
ument was opened. The number of operations that can be recovered is limited only by the amount of memory avail-
able. The command's heading shows what action is undone and applies to the active window. Redo is the opposite
operation of Undo.

Keyboard Shortcut: Ctrl Z
Redo

Reverses the last Undo command and displays the action to be redone in the heading.

Keyboard Shortcut: CTRL Shift Z
Cut

Works in numeric fields and inspector lists.The cut element is stored in the clipboard. Clipboard contents are retained
until the next Cut/Copy operation is performed.

Keyboard Shortcut: Ctrl X
Copy

This command works in digital fields and inspector lists. The element copied is stored in the clipboard. Clipboard con-
tents are retained until the next Cut/Copy operation is performed.

Keyboard Shortcut: Ctrl C
Paste

Pastes the contents of the clipboard into inspector lists and numeric fields. Clipboard contents are retained until the
next Cut/Copy operation is performed.

Keyboard Shortcut: Ctrl V

Delete

Removes the items selected in inspector lists, numeric fields, and objects in the scene.

Preferences

Defines the program's overall behavior.

Display Menu

The project's display commands are in the active view (Preview window, 2D View window).
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Enlarge/Reduce

° In the Preview window
Factor of 1.5x from center. Sizes are to be defined in the Artlantis Preferences. Maximum size 1200x1200,
minimum size 640x640.

° In the 2D View window
Factor of 1.5x from center.

Keyboard Shortcut: Enlarge + and Reduce -
Fit in Window

. In the Preview window
Fit the view to the window size.
. In the 2D View window
Instantly displays all elements of a project.

Keyboard Shortcut: =
Back to Original View

Returns to the viewpoint present when it was activated.
Zoom
Acts the same way in the Preview and 2D View windows except that, in Preview, the camera target and the focus are

recomputed.

. Zoom + click in the window enlarges the view 2x from the point clicked.
. Zoom + click, followed by dragging and dropping into the window enlarges it in relation to the center of the
rectangle.

To zoom out, press the Alt key before clicking or describing the limiting box. The tool deactivates when the command

is finished.

NB: In Windows, only the 2D View is affected.

Pan
Drag and drop to move the content to the appropriate window. The tool deactivates when the command is finished.
The camera target is recalculated for the Preview window.

NB: In Windows, only the 2D View is affected.

Holding down the middle button on the mouse produces the same effect.
Change 2D View

Replaces the current projected view with a different one: Top, front, right, left or rear.

Keyboard Shortcut: Ctrl 1, 2, 3,4 or 5

2D View Display

Enables the user to change the type of display: Wireframe or Textured mode.
Back

In 2D view, this enables the user to navigate by back-stepping upwards through the sequence of views displayed in
the tree structure.

Keyboard Shortcut: Ctrl <
Next
In 2D View, this enables the user to navigate downwards through the sequence of views displayed in the tree struc-

ture.

Keyboard Shortcut: Ctrl >
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Hide Toolbar

Displays/hides the bar for the view active in Preview or 2D View.

Status Bar

Displays/hides the bar and provides information on the display progression in the Preview window.
Toolbars

Displays/hides the command groups belonging to the bar in question: Prepare Document, Navigation Tools, Artlantis
Tools, Viewpoint Selector, Radiosity box, Show Text, Lock Toolbars.

Inspector Menu

Contains the inspectors for views (perspectives, parallel views, cuts), lighting effects (lights and heliodons), scene
dressing (shaders, textures, objects), and environment (background and foreground images, insertion to site, depth of
field, atmosphere, ambient).

NB: It is not always necessary to change the edit inspector to modify a project. There are sufficient com-
mands available, regardless of which inspector is active.

Perspectives

Displays the Perspectives inspector.

Parallel Views

Displays the Parallel View inspector.

Panoramas
Displays the Panoramas inspector.

VR Objects
Displays the VR Object inspector.

Animations

Displays the Animations inspector.

Shaders

Displays the Shader inspector.
Lights

Displays the Lights inspector.
Heliodons

Displays the Heliodon inspector.

Objects
Displays the Object inspector.

Render

Displays the Render Window for defining rendering options and format, as well as destination.

Keyboard Shortcut: Ctrl R
Partial render

In the Preview window, draw a rectangle by dragging across two opposite corners to define the area you wish to
render. The rendering appears in a new window. The Save Image dialog box appears when you close the rendering.

Keyboard Shortcut: Ctrl Shift R
Batch Rendering...

This window handles the status, destination and format of batch renders that have been defined in advance using the
Render command.
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Window Menu

Contain the window activation commands: 2D View, Catalog and Timeline.

Inspector
Displays/hides the Inspector palette

2D View

Displays the 2D View window: Top, front, right, left or rear.
Catalog

Displays the Media Catalog.

Timeline

Displays the Timeline.

Rendering Parameters

Displays the rendering settings dialog.

Scene information:

Displays the scene settings dialog .

Tools Menu

Create Shader
Opens the Edit Shader dialog

Create a Postcard™

Saves the current view as a Postcard™

Help Menu

Artlantis Help

Online Artlantis documentation containing reference information on each of the program's functions, plus detailed
illustrated tutorials.

Keyboard Shortcut: F1

Artlantis Web Site

Opens your Web browser to the Artlantis page of the Abvent site by default: The English language Artlantis
forum, product information, updates, FAQs, training, etc.

Tutorials

Displays the tutorials page in the help window.

Additional Media

Displays additional media available on the Artlantis Web site
On-line registration...

Lets you register the product directly on the Abvent site. Fill out the form displayed then confirm.
Edit License
Displays the License activation manager.

About Artlantis

Shows the version number.

The 2D View Window

This is used for viewing and editing the project in the following 5 projected views: Top, front, right, left or rear.

View display is independent of the current inspector. Example: In the Perspectives inspector, you can edit lights in
2D View without activating the Lights inspector.
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2D View display and navigation tools

Customizing the 2D View Toolbar
Keyboard and Mouse Shortcuts

Editing in 2D View

Right clicking on the element you wish to edit displays a pop-up menu for the current operations: Duplicate, Delete,
Attribute To, etc. These are performed in real time in the Preview window and in the relevant inspectors.

Fixed Images

Working with Objects in 2D View
Working with Parallel Views in 2D View
Working with Perspectives in 2D View
Working with Lights in 2D View
Modifying Heliodons

Working with the Clipping Box in 2D View

Animations

Working with Panoramas in 2D View ]
Working with VR Objects in 2D View

Working with Panoramas in 2D View ]

2D View Display and Navigation Tools
‘-‘Q\ - &-[@|x &8 B =

Default Tools Available

&

Previous and Next: Used for moving between displays.

> Fit in Window: Maximizes the display of all of the geometry and lights to the full size of the window.

™ Zoom: Increases the zone defined by a rectangle. Alt+Zoom reduces the display.

—=—Pan : Reframes the content of the window.

1 (i . k.,
."| 1 ] el .

Change View: A drop-down menu for selecting the projected view.
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.J'_

object

Edit Path: In animation mode, is used for creating or modifying a path relative to a camera, a light or an |

Customizing the 2D View Toolbar

The following tools are available by right clicking on the bar:

[ Auadable tookar buttons: Cugrent tookar bttons: [ Close |
| Chost
-~ . :
Separston P Back |__Resst
Add -»
[E waehame
B Shaded
w

e To add or delete tools, select them from the "Available buttons" or "Toolbar Buttons" columns. You can use
drag/drop between these two columns.

@.

v Wiraframe

haded? Display mode: Switches from wireframe to textured display.

Modifications in 2D View

In this chapter you will learn about the following subjects:

Working with Perspectives in 2D View. ... ... i 34
Working with Parallel Views in 2D View. .. .. .. e, 36
Working with Objects in 2D View. . . . 38
Working with Lights in 2D View. .. 40
Modifying Heliodoms. . _ . . ... il 44
Working with the Clipping Box in 2D View. . .. .. il 46
Working with VR Objects in 2D View. .. .. .. 47
Working with Panoramas in 2D View. ... ... 51
Working with Camera Animation in 2D View_ .. _ ... ... 53
Working with Light Animation in 2D View. ... il 60
Working with Object Animations in 2D View. . .. 67
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Working with Perspectives in 2D View

Display Wireframe Mode

State or Action

Comments

Viewpoint inactive

Represented by the cam-
era (gray point).

Active viewpoint selected.

Represented by the camera
(red point), the target (gray
point), the focusing angle
(blue lines) and the angle's
bisector line (gray line).

or

+]
% e Move the camera. e Move the red point.
% o Move the target. o Move the gray point.

Move the camera in a o Move the gray bisect-

parallel direction. ing line.

Change the focusing o Move one of the 2

angle. blue lines.

Duplicate viewpoint ® Press ALT and move
the camera (red
point).

or
4] . .
e Right click on the

camera then select
"Duplicate" in the
Ppop-up menu.
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s

Delete

Add to Parallel View Lis
Add to Panorama List
Add to VR Object List
Add to Sequence List

Edit Heliodon
Edit Light >
Duplicate e Delete viewpoint e Right click on the
,, camera then select
"Delete" in the pop-
Add 1o Parallel View List up menu.
Add 1o Panorama List
Add vo VR Object List
Add o Sequence List
Edit Heliodon
Edit Light | 4

Duplicate
Delete

Add to Panorama List
Add ta VR Objeet List
Add to Sequence List

{

Add to Parallel View Lise

e [Edit an active light
with this viewpoint.

e Right click on the
camera (red point).In
the pop-up menu,
choose "Edit Light",
select the name of
the light.

Add to Panorama List
Add to VR Object List
Add to Sequence List

7

Edit Heliodon I~

Edit Light

Add to Parallel View List

point.

i Edit Hellodion
| - NB: The inspector pal-
Edit Light Ld Light [ ette switches from Per-
spectives mode to Lights
mode.
e e [Edit an Active Hel- e Right click on the
Delete iodon with this View- camera (red point)

then select "Edit Hel-
iodon" in the pop-up
menu.

NB: The inspector pal-
ette switches from Per-
spectives mode to Heliodons
mode.
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Working with Parallel Views in 2D View

Display Wireframe Mode

State or Action

Comments

Viewpoint inactive

Represented by the camera
(gray point).

Active viewpoint selected.

Represented by the camera
(red point), the target (gray
point), the width of view
(red lines) and the symmetry
axis linking the camera and
the target (gray line).

o Move the camera.

o Move the red point.

o Move the target.

o Move the gray point.

o Move the camera in a
parallel direction.

o Move the gray sym-
metry axis.

o Define the view area.

e Move one of the red
lines.

or

SESIS N IS i)

e Duplicate the view-
point

® Pressthe ALT key
then move the cam-
era (red point), tar-
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Delete

Add to Perspective View List
Add va Panorama List
Add 1o VR Objeet List
Add ta Seguence List

get (gray) or the
symmetry axis
(gray).

or

e Right click on the

[ Delete .

Add to Perspective View List
Add to Pusorama List
Add ta VR Object List
Add o Seguence List

SHEEE camera then select

Edix Light 3 "Duplicate" in the
pop-up menu.

Dugplicate e Delete viewpoint e Right click on the

camera then select
"Delete" in the pop-
up menu.

MAdd o Panorama List
Add 1o VR Objeet List
Add 1o Seguence List

[Edit Heliodon

Edlit Light [ ]

Duplicate e Addto Viewpoints Right click on the camera
Delete List: Perspectives, Pan- then select "Add To List..."

oramas, VR Objects or

Sequences

in the pop-up menu.

Add to Perspective Wiew List
Add to Panorama List
Add to VR Object List
Add to Sequence List

[Edlit Light [ ]

Edit Heliodon

Edit Light [ ]

Duplicate Edit an Active Hel- e Right click on the
Delete iodon with this View- camera (red point)

point.

then select "Edit
Heliodon" in the
pop-up menu.

NB: The inspector
palette switches from the
Parallel View mode to Hel-
iodons mode.

Duplicate
Delete

Add vo Pers pective View List
Add to Panorama List
Add 1o VR Object List
Add to Seguence List

Edit Heliodon

e [Edit an active light

with this viewpoint.

e Right click on the
camera (red
point).In the pop-up
menu, choose "Edit
Light", select the
name of the light.

NB: The inspector
palette switches from Par-
allel View mode to Lights
mode.
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Working with Objects in 2D View

I Display Wireframe Mode

State or Action

Comments

Object deselected Represented by the geometry
g and a green center point.
Selected object Represented by the geometry

and a blue center point.

e Move an object.

o Move the blue point if
the object is active or
green point if it is inac-
tive.

e Duplicate an Object.

e Press Alt and move blue
or green point.

e Multiple duplication of
an object

1. Press Shifi+Alt keys and
draw out a (green) line.

2. Hit the "plus" key to
indicate the number of
copies (pink points).
Press the "minus" key to
remove them.

3. Validate by hitting
Enter.

T
1
;‘\
& .
T
2
e
3
1
2

Make Multiple Duplicates of
More than One Object.

e Select the objects:
o Ctri+click the objects

1. Press Shifi+Alt keys and
draw out a (green) line.

2. Hit the "plus" key to
indicate the number of
copies (pink points).
Press the "minus" key to
remove them.

3. Validate by hitting
Enter.
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Use as camera target/Do not
use as camera target for an
animation or perspective

Find all Sirmilar Instances

view
-Fihl‘l .all Similar Instances
Redefine the anchor point of e Select the object, press
an object D then in 2D View drag
the object's blue anchor
point.

This works for internal or

external object).

NB: Object deletion is done from the inspector list.
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Working with Lights in 2D View

Display Wireframe Mode State or Action Comments
Deselected light is off Represented in shaded yellow.
L
Selected light is off Represented in shaded yellow cir-
cled in black.
=]
Deselected light is on Represented in bright yellow with
thin black circle.
a

Selected light is on Represented in dark orange with
thick black circle.
o
o Move a light Move the yellow point(s) depend-
o ing on the type of light.
# e Turn On/Off Turn current light light on/off
Duplicate
NB : Selecting more than
Cut one light enables you to turn them
Copy on/off at the same time.
Delete
Edit View Using This Light b
e Duplicate a light. e Hit the A/t key to move the
yellow point.
or
Bimbe
Turn On e Right click on the yellow
Turn QFf point and select "Duplicate"
in the pop-up menu.
Cut
C
D::“ NB: The duplicated light
103 .
retains the parameters of the ref-
Edit View Using This Light ke erence light (power, shadows, etc.).
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e Multiple duplication 1. Press Shifi+Alt keys and
of a light draw out a (green) line.
‘ 2. Hit the "plus" key to indi-
cate the number of copies
(pink points). Press the
"minus" key to remove
them.
3. Validate by hitting Enter
1
-]
]
]
2
L
L]
-]
o
3
e Make multiple dupli- e Select lights belonging to
cations of more than the same group:
one light Cirl+click the lights.
1. Press Shift+ALT keys and
o draw out a (green) line.
2. Hit the "plus" key to indi-
° ° cate the number of copies
(pink points). Press the
° o "minus" key to remove them|
3. Validate by hitting Enter
-]
1 NB: The duplicated lights
retain the parameters of the ref-
erence light (power, shadows, etc.).
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e Cuta light

Deletes the current light, but
holds it in memory so it can later
be pasted into a light group from
the lights list. (To paste into the
lights list, right click on the name
of a group and select Paste)

e Copy a light

Copy the current light without
deleting it. It is held in memory
so it can later be pasted into a
light group on the lights list. (To
paste into the lights list, right
click on the name of a group and
select Paste)

NB: Selecting more than
one light enables you to copy
them at the same time.

L]
@ 3
o
e o
r g
o
L
-] L
-] o
L -] L
-] -]
® ° o
e °
® o
®
°
L
/ T|.4rr|| I;}H |
Duplicate |
Copy ! |
Delete |
Edit View Using This Light [ ] '
v
| Turn Off
Duplicate
Cut
| Delete
| Edit View Using This Light L
.
/. Turn Off
Duplicate
| o '
| Copy
[ Edit Wiew Using This Light e .

o Delete a light

e Right click on the light then
select "Delete" in the pop-
up menu. The light is
deleted. To recover the
light, go to Edit > Undo
Delete Lights
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e Edit a view using this e Right-click the light. In the
light. pop-up menu, choose "Edit

View Using This Light".

Select the name of the

S view.

/ 'l'u(;l Oﬂ

Duplicate

NB: The inspector palette
Cut q o
Copy switches from the Lights mode to
Do | Viewpoints mode (Perspectives or

Parallel Views).
Paralles view
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Modifying Heliodons

Sun Position

Display Wireframe Mode

State or Action

Comments

Position the
sun based on
the geo-
graphical
location, date
and place

Orientation

True North (compass
point).

San Francisco

e Setting the orientation

of North

Pivot the yellow point
around the compass.
The yellow arrow
will move accord-
ingly around the cir-
cle.

The rays of the sun
(yellow lines with
arrow points) are
positioned depending
on the location, true
North and the date
and time.

NB: Use the
Heliodons inspector
to configure these ele-
ments, except for true
North.

Shadows are then
recomputed in the
Preview window.

Manually
move the
sun.

o Manually positioning

the sun.

Shadows are then
recomputed in the
Preview window.
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Limit the
sun  to
alwayscast-
ing shad-
ows at 45°
depending
on  view-
point  posi-
tion.

View_1

Graphically moving
the viewpoint redi-
rects shadows cast to
45°.

Shadows are then
recomputed in the
Preview window.
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Working with the Clipping Box in 2D View

Wireframe Display Mode

State or Action

Comments

Limiting box

Represented by a blue cross-
hair and rectangle.

e Click/drag inside
the box to move
it.

e Resize Clipping
Box

Move the blue points located
at the corners.

o Turn Clipping
Box

Turn the blue handle of the
crosshair around its center.

&

Move the center of the cross-
hair to redefine the axis of
rotation

Elevated view

Editing operations on the
same as on plane except that
the box does not pivot.
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Working with VR Objects in 2D View

Wireframe View on Plane Mode Display Wireframe State or Action Comments
Hemispherical View in
3 Elevation
. T Mode Display
: mode
F Spherical
L
VR object dese- Represented grayed by the
lected target and a circle.
o
VR object Top view: represented by
Q selected. the camera (gray dot on
the circle), the target (cen-
tral red dot).
The camera moves around
the blue circle. The focus
opening angle is defined by
the two blue lines and the
| angle bisector (gray line).
/— ™ In Elevation: The target
t point is red. 2 gray points
\ linked by a shaded line rep-
) resent the camera altitude.
e The small red points on the
circle represent the cam-
era movement pitch (pitch
value dissociated in top
and elevated views).
/‘\\ e Move VR Top view:
/ \ objects.
e Move the target in
red, or the bisector
= ‘ in gray.
VROBJECT 0~ . In Elevation:
M o Move the target in
y red or the shaded
horizontal line.
. E1
.
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s

VREOBJECT D

— e Move the Top view:
// “\\ camera.
_ |
o Move the gray point
in the blue circle.

In Elevation:
VROBIECT O

o Adjust the camera

7 ISR height by moving
U the shaded hor-
izontal line that
runs through the
’ = | two gray points.

i \ NB: In these views,
] the camera position defines
\\b/ Va the starting image when the

VR objects are read.

p—
N/A e Change the o Move one of the 2
focusing blue lines.
angle.
WVROBJECT O
N/A Angle Opening Indicates the starting posi-
Constraint tion of the angle opening

relative to 0° in a trig-
onometric circle.

e Pivot the blue
radius around the

BH

° ITOCk post- red point in the
tlo.n of VR center. This
f)bJeCt start- changes the con-

R _— ing angle. straint value in the
oriE. il ne. gle us .
20 350 16.00 m VR Object/Co-

ordinates inspector.
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N/A e Limit VR Enter an angle value of
Object Open{  <360° in the VR Object/Co-
ing Angle ordinates inspector.
Horizontally.
Horiz. Shift  Horiz. Angle Radius
20 120 L6.00 m

Once open, the circle can

% be edited graphically.

Horiz. Shift  Horiz. Angle Radius
63 120 LE6.00 m

The opening angle value

depends on the Constraint
angle value.

Horiz, Shift  Horiz. Angle Radius
63 240 LE.00 m

Same  as o Duplicate ® Press ALT and
Alt plane view VR move the camera
Object. target in red..

+
or

e Right click on the
camera then select
"Duplicate" in the
pop-up menu.

VROBJECT O -

or
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Duplicate

] b Perapechive View Lisk
Add bo Paralel View List
Add to Pancrama List

] b Sesqusnaces List

Edit Hellodon
Edt Light

Duipbesks

Add ko Parspactive Yisw List
Add to Parallsl Wiew List
Add to Panorama List

Add to Sequence List

Exik Heliodon

T T
]

Same as plane e Delete VR e Right click on the
view Object. camera then select
"Duplicate" in the
pop-up menu.
Duphcake
| oeete ||
Add bo Perspactive Yiew List
Add to Parallsl View List
Audd to Panorama List
Add to Sequence List
Ecli Light »
Same as plane e Edit Light e Right click the red
view active with target. In the pop-up
this VR menu, select "Edit
Object. Light", select the

name of the light.

NB: The inspector pal-
ette switches from VR Object
mode to Lights mode.

Dol abe

Add ko Perspactive Vs List
Audd b Parallel view List
Add to Panorama List
Add b Secuince Lt

Edi: Light

Same as plane
view

e Edit active
Heliodon
with this VR
Object.

e Right click on the tar-
get in red and select
"Edit Heliodon" in
the pop-up menu.

NB: The inspector pal-
ette switches from VR Object
mode to Heliodons mode.
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Working with Panoramas in 2D View

| Wireframe Display Mode State or Action | Comments |
Panorama  dese- Indicated by the camera (gray
lected dot) and the horizontal or vertical
viewpoint movement cir-

cle.Viewpoint active.

Panorama selected Represented by the camera (red
point), with the target (blue) mov-
ing in a circle (blue circle), the
focus angle (blue lines) and the
angle's bisector line (red line).

NG

e Move the o Use the red point for this.
panorama.

e Move the ® Move the blue point in the
target. blue circle.

NB: The target point posi-
tion defines the starting image
when the panorama is read.

PANORAM

o
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e Move the
panorama in
a parallel
direction.

® Move the red bisecting
line.

e Change the
focusing
angle.

e Move one of the 2 blue
lines.

Alt

or

Delete

Add to Perspective Wiew List
Add te Parallel View List
Add to VR Object List

Add 1o Sequence List

Edit Heliodon

Edit Light

e Duplicate
the view-
point

® Press ALT and move the
camera (red point).

or
e Right click on the camera

then select "Duplicate" in
the pop-up menu.

Duplicate

Add to Perspective View List
Add to Parallel View List
Add 1o VR Object List

Add 1o Sequence List

Edit Helisdon

Edit Light L

o Delete view-
point

e Right click on the camera
then select "Delete" in the
pop-up menu.
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ﬁ?‘“\ e Edit Light e Right click on the camera
V i active with (red point). In the pop-up
‘f Add 1o View List this view- menu, choose "Edit Light",
"\\ fertes :n::‘:,“f.:':” point. select the name of the light.
Add to Sequence List
— Edit Heliodon

Edit Light > Lumidre i
- S NB: The inspector palette
switches from the Panorama mode

to Light mode.
ST e Edit active e Right click on the camera
Duplicate Heliodon with (red point) then select "Edit
this view- Heliodon" in the pop-up
Add to Perspective View List s
Add to Parallel View List point. menu.

Add to VR Object List
Add to Sequence List

__, | EditHeliodon | NB: The inspector palette

switches from Panorama mode to
Heliodons mode.

Edit Light | 3

Working with Camera Animation in 2D View
2D View Window
Path edits are clearly distinguished from keyframe edits.

This concerns the paths for cameras, lights, and objects as well as the relevant pop-up menus.

Editing Paths

Camera path is in red.

NB: Camera target points can be edited graphically at any time, regardless of whether record mode is on or
not.

Use the Edit Path WV tool in the window bar to select the mode.
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®  Button raised: |ﬁ Keyframe editor is active (As a result, the path is visible but cannot be edited).

Create Path

* In |ﬁ mode, move the camera viewpoint.
e This draws a red path in a straight line.
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e White dots circled in gray indicate start and end points that have tangents.
e The tangent handles are indicated by red dots circled in black.

Move Path
e Click on the path and move it.

Modifying the Path

e Use the handles to graphically edit the tangents.

Add a Control Point

e Right-clicking the red path line and selecting "Add Control Point" displays a gray circle and a tangent with two
editing handles.

Add Control Point [ et
Remowve Control Paint

Unlock tangent

Close path --—

Delete Path —
————
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To edit a portion of the tangent at a point

e Right click on the point and select "Unlock Tangent" to create an inflection point on the path.

e } :
Add Contral Paint -_7*477”(

Remove Control Point

Unlock tangent | !

Close path _

Delete Path

To delete the inflection point

e Right click on the point and select "Lock Tangent".
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o [

Add Control Point -—;——7'!

Remove Control Point

Close path =74

Delete Path
—

Extend Path

Extends the path without touching the existing animation.

e Alt+Click on the last control point created for the path.
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e Creates a new control at the end of the path.

NB: The timeline can be used to play the sequence at any time.

Path Edit Pop-up Menu
e Right clicking on the red path displays a pop-up menu with the following options:

Add Control Point

Close path

Delete Path

e Add Control Point: adds an editable point to the path.

e Delete Control Point: deletes the point from the path (except the end points).
e Close Path: closes the path on itself.

e Open Path: re-opens the path.

e Delete Path: deletes the path.

Editing Keyframes

Camera path is in red.

NB 1: You must be in record mode in order to edit in the Timeline.

Keyframe Edit Pop-up Menu:

o Add Keyframe: adds a keyframe.
e Delete Keyframe: deletes a keyframe

Add a keyframe

° W

In mode, button is raised (not active).

In the Timeline window, click on record o in 2D view, right click the path, select "4dd key frame" from
the pop-up menu.

Page - 58



Artlantis Interface - The 2D View Window W

o "\\ -
‘\'-\.‘ A /
Add Key Frame [

This creates the keyframe.

The keyframe can be moved graphically on the path, making it possible to speed up, slow down, etc.

NB: A keyframe selected in 2D View appears with a red pin on the Timeline. A pause can be created in the
movement of the element by duplicating a keyframe in the Timeline.

NB 2: When editing or reading a sequence, the Preview window displays the content in OpenGL Navi-
gation mode if "Automatic Switch to OpenGL" has been checked in the preferences.

The 2D View Edit Filters Pop-up Menu:
This displays and/or hides paths in order to improve editing in 2D View.

e Right clicking on the white background of the 2D window displays the following pop-up menu that makes it
easier to edit in 2D View, as well as display and hide paths.

¥ Show All
Show Only Current Type Elements
Show Only Current Element

e Display All: displays all camera, light and object paths.

o Show only current type elements: Depending on which inspector is active (Animations, Lights or Objects), dis-
plays all camera, light or object paths.

e Display Only Current Element: displays only the path currently being edited.
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Viewpoint Edit Pop-up Menu:

Regardless of whether the user is in path or time edit mode, right clicking on a camera's target or one of the blue lines

that represent the focus opening will display a pop-up menu with the following options:

Cuplcate
Dislate

A bo Paralel Wisw List
Add bo Pancrama List
Add bo VR Objact List
At by Saquisrice List

Edit Heliodon
Edit Light ]

Duplicate: duplicates the sequence, the current camera position becomes the default view, the path is not dupli-
cated. Uses the original to create a new superimposed viewpoint.

Add to Perspectives View List:
Add to Parallel Views list
Add to Panorama list

Add to VRODbject List

Depending on option selected, adds current view from Perspectives to Parallel Views, Panoramas, or VR Objects.

Edit Light Activated With This Viewpoint
Choose a light. The inspector palette switches to Lights mode and the light is selected.

Edit Heliodon Activated With This Viewpoint.
The inspector palette switches to Heliodons mode and the heliodon is selected.

Delete: The viewpoint is removed from the list.

Working with Light Animation in 2D View
2D View Window:

Path edits are clearly distinguished from keyframe edits.

This concerns the paths for cameras, lights, and objects as well as the relevant pop-up menus.

Editing Paths

N

The light path is in yellow.

Use the Edit Path ' tool in the window bar to select the mode.
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ol

4

Button pressed: |ﬁ Path editor is active (As a result, editing the keyframe in the view is inactive).

Button raised: |ﬁ Keyframe editor is active (As a result, the path is visible but cannot be edited).
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Create Path
| -
o
® In |\f\| mode, move the light source.

e This draws a yellow path in a straight line.

e White dots circled in gray indicate start and end points that have tangents.
e The tangent handles are indicated by red dots circled in black.

Move Path
e Click on the path and move it.

Modifying the Path

e Use the handles to graphically edit the tangents.

TR
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Add a Control Point

Add Control Point
S Remove Control Point |

7
Unlock tangent

Clase path

Delete Path

e Right clicking the yellow path line and selecting "Add Control Point" displays a gray circle and a tangent with

two editing handles.

:
| I

Result.

To edit a portion of the tangent at a point:

1
’

.
._/—-‘( Add Control Point

— Remove Contral Point II
-|/ Unlock tangent |,

Close path

Delete Path
R ———
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e Right click on the point or on an "Unlock Tangent" item handle to create an inflection point in the path.

:
| I

Result.

To delete the inflection point

A

,/‘J Add Control Point

Remove Contrel Point

Lock tangent .

Close path

I Delete Path

e Select "Lock Tangent".

Result.

Extend Path
Extends the path without touching the existing animation.

e Alt+Click on the last control point created for the path.

Page - 64



Artlantis Interface - The 2D View Window

——a

NB: The timeline can be used to play the sequence at any time.

Path Edit Pop-up Menu

e Right clicking on the yellow path displays a pop-up menu with the following options:

Add Control Point

Close path

Delete Path

e Add Control Point: adds an editable point to the path.

e Delete Control Point: deletes the point from the path (except the end points).
e Close Path: closes the path on itself.

e Open Path: re-opens the path.

e Delete Path: deletes the path.
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e Right clicking on a control point or tangent handle displays a pop-up menu with the following options:

Delete Control Point
Linkock: barpent
Chore path

Dielate Path

Lock Tangent: to delete an inflection point.

Unlock Tangent: to create an inflection point. This makes it possible to create an inflection point to
manipulate sections of the tangents independently.

Editing Keyframes

NB 1: You must be in record mode in order to edit in the Timeline.

Keyframe Edit Pop-up Menu:

o Add Keyframe: adds a keyframe.
o Delete Keyframe: deletes a keyframe.

Adding a key image

* M mode, button is raised (not active).

In the Timeline window, click on record o in 2D view, right click the path, select "Add key frame"
from the pop-up menu.

£ Add Key Frame [

| l

This creates the keyframe.

The keyframe can be moved graphically on the path, making it possible to speed up, slow down, etc.

NB: A keyframe selected in 2D View appears with a red pin on the Timeline. 4 pause can be created in the
movement of the element by duplicating a keyframe in the Timeline.
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NB 2: When editing or reading a sequence, the Preview window displays the content in OpenGL Navi-
gation mode if "Automatic Switch to OpenGL" has been checked in the preferences.

Keyfiame Edit Pop-up Menu:

This displays and/or hides paths in order to improve editing in 2D View.

e Right clicking on the white background of the 2D window displays the following pop-up menu that makes it
easier to edit in 2D View, as well as display and hide paths.

v Show All
Show Only Current Type Elements
Show Only Current Element

e Display All: displays all camera, light and object paths.

o Show only current type elements: Depending on which inspector is active (Animations, Lights or Objects), dis-
plays all camera, light or object paths.

e Display Only Current Element: displays only the path currently being edited.

Working with Object Animations in 2D View
2D View Window

Path edits are clearly distinguished from keyframe edits.

This concerns the paths for cameras, lights, and objects as well as the relevant pop-up menus.

Editing Paths

Object path is in green.

000 Vue 2D

\_/ °

.
.

A
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® Use the Edit Path iy tool in the window bar to select the mode.
® Button pressed: T Path editor is active (As a result, editing the keyframe in the view is inactive).

® Button raised: s Keyframe editor is active (As a result, the path is visible but cannot be edited).

Create Path

In p mode, move the object.

e White dots circled in gray indicate start and end points that have tangents.
e The tangent handles are indicated by red dots circled in black.

This draws a green path in a straight line.
Move Path

e Click on the path and move it.
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Modifying the Path

e Use the handles to graphically edit the tangents.

Add a Control Point

Add Control Point

Remove Control Point m

Unlock tangent

Close path
Delete Path

e Right-clicking the green path line and selecting "Add Control Point" displays a gray circle and a tangent with

two editing handles.

|

\

Y

\

Result.
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To edit a portion of the tangent at a point:

Add Contral Point |
Remove Control Point |

Unlock tangent [~
Close path ___“;;;—m

Delete Path

e Right click on the point or on an "Unlock Tangent" item handle to create an inflection point in the path.

Result.

To delete the inflection point:

Add Control Point |

Remave Control Point |
Lock tangent

Close path P :‘

Delete Path Yy
e ——

e Select "Lock Tangent".
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Result.

Extend Path
Extends the path without touching the existing animation.

e Alt+Click on the last control point created for the path.

Result.

NB: The timeline can be used to play the sequence at any time.

Path Edit Pop-up Menu

e Right clicking on the green path displays a pop-up menu with the following options:
m  Add Control Point: adds an editable point to the path.
m  Delete Control Point: deletes the point from the path (except the end points).
m  Close Path: closes the path on itself.

Page - 71



Chapter 5

m  Open Path: re-opens the path.
m  Delete Path: deletes the path.

Audd Control Point

Chos path

Dielate Path

e Right clicking on a tangent handle or control point displays a pop-up menu with the following options:

m Lock Tangent: to delete an inflection point.

Dedete Control Point
Uindock: bargpent:
Chose path

Delete Path
or
m  Unlock Tangent: to create an inflection point.

After unlocking the tangent, you can create an inflection point to work independently with half tangents.

Editing Keyframes

Object path is in green.

NB 1: You must be in record mode in order to edit in the Timeline.

Keyframe Edit Pop-up Menu:
Right clicking on the green path displays a pop-up menu with the following options:

m  Add Keyframe: adds a keyframe.
m  Delete Keyframe: deletes a keyframe.
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Add a keyframe

b

Add Key Frame \j

.y _—

o

° WE

In mode, button is raised (not active).

O

In the Timeline window, click on record
the pop-up menu.

in 2D view, right click the path, select "4dd key frame" from

This creates the keyframe.

The keyframe can be moved graphically on the path, making it possible to speed up, slow down, etc.

NB: A keyframe selected in 2D View appears with a red pin on the Timeline. 4 pause can be created in the
movement of the element by duplicating a keyframe in the Timeline.

NB 2: When editing or reading a sequence, the Preview window displays the content in OpenGL Navi-
gation mode if "Automatic Switch to OpenGL" has been checked in the preferences.

The 2D View Edit Filters Pop-up Menu:

e Right clicking on the white background of the 2D window displays the following pop-up menu that makes it
easier to edit in 2D View, as well as display and hide paths.

¥ Show All
Show Only Current Type Elements
Show Only Current Element

e Display All: displays all camera, light and object paths.

e Show only current type elements: Depending on which inspector is active (Animations, Lights or Objects), dis-
plays all camera, light or object paths.

e Display Only Current Element: displays only the path currently being edited.

Page - 73



Chapter 5 i

Editing the Clipping Box

This is a blue box with corner handles that can be edited.

W Shew ™ activate g

e Activation and display in Viewpoint inspectors: Perspectives, Parallel Views, Panoramas, VR objets,
Animations.

e Entering an angle value in degrees in the numeric field pivots the box within the plane.

In 2D View

Change the view (above, front, right, left, rear) to define more than one clipping plane in the space (up to a maximum
of 6 clipping planes).

e Edit the blue handles to define the clipping planes.

Elements outside the blue box are cut out of the scene.

When viewing from above, the rotation angle can also be defined graphically in 2D View.

NB: When elements are clipped, the shadows projected are adapted.

Preview Representation

Example of a clipping box in Perspective view.
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ana % Sopnirmirked Tirid kid =N
T B A & & #

Inactive Clipping Box

‘BOn % Sopnirmirked Mirid kid =N
BT ey ] A e & #

Active Clipping Box

The Preview Window

The main working window. It displays the final render in real time before any calculation is initiated!
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Both the toolbar commands (Navigation, Zoom, Pan, Front View) and the Keyboard and Mouse Shortcuts specific to
the Preview window are used to navigate within a scene.

Preview display and navigation tools

Customizing the Preview Toolbar

Preview display and navigation tools
“r 5 Q J‘ ’__1 e @ b E= :‘ = [FRadoské Flauto | L Plartes 30 ¥
Grouped by topic

Navigation tools:
Display/hide navigation bar in the project:

=
** Activates and deactivates display in OpenGL mode. Useful for navigating within large databases.

NB: Shadows and lighting effects in OpenGL depend on the Preference settings.

3 Pan To: Positions the camera perpendicular to the surface clicked.
Back: Resets the camera to the position defined when the view was activated.

q‘—Zoom: Moves the camera (the zone in question is defined by a rectangle). The Alt+Zoom option moves the cam-
era backwards.

A5

= . .
—~—Pan: Pans the scene by moving the active camera.

® Update: Saves the viewpoint position (viewpoint, target, focus distance and camera roll). This tool only works
when the Automatic Update option is not activated in the General Preferences.
Artlantis tools:

Display/hide the following toolbars:

—1 Displays the 2D View window.

o Catalog: provides access to Catalogs and Media (Shaders, Objects, Images and Postcards).

=
2 Render: Opens the dialog box for preparing and launching rendering.

- | Partial Render: Within the scene, this initiates rendering of the zone bounded by the rectangle.

Rendering Parameters: Displays the rendering settings dialog.

P #

= Refine Preview: Radiosity display becomes close to end result.

" Create Postcard: saves current viewpoint as a Postcard.

belRadisky Radiosity: activates or deactivates radiosity.

[Jae | & 30 Flants ¥. - . . . I
Current layer: destination of an object when dragging and dropping an object in the

scene.
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e If Auto is checked:

Drag-drop an object in the scene, this object will go into the layer appropriate to its type or into the active
layer if there is no default destination layer for this object type.

e If Auto is unchecked:

The popup menu for the layer shows the destination layer for an object during a drag-drop in the scene as
long as there is no default destination layer for this object type.

Viewpoint selector:

Show/hide the viewpoints drop-down menu bar:

00 Mavigation W . . . . .
o Navigation in viewpoints.

Show/Hide Tool Group in the toolbar

e Right click on the toolbar, then choose an item:

ur" Haviation Tooks

[w ] arttantis Tools

| . Viewpoint: Selector
Customize...

Customizing the Toolbar

SpaceNavigator Peripheral Compatibility:

o Ergonomics: hardware compatibility with SpaceNavigator from 3D Connexion, a 3D navigation tool.
Lets you navigate through the scene and edit items in the scene using the mouse.

Customizing the Preview Toolbar

From Display menu > Toolbars > Customize...

Customize Toolbar

Hovalable tookhar buttons:

Sepseao (] 20 view *| (et ]
| Add-s E2% Casleg
w Rendet

To add or delete tools, select them from the "Available toolbar buttons" column or under "Current Toolbar Buttons".

NB: ifthe Artlantis toolbar is not displayed, it is not possible to customize the preview toolbar.

The Timeline Window

Introduction: __J

Animation work is done using the Animations, Lights, Heliodons or Objects and the 2D View, Preview window
and the Timeline window.
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The timeline enables the user to record, edit and play a scene. The scene is made up of sequences that are managed in
the Animations Inspector list.

re' 56 Seguence
7 T X h r
X X % - 4
=1 s
Ll
al] A0 = P W Cosrvent Time: _ Duration:  Frame:  FPS: ™ Laop
—- | (W) () (™ @ D0:00:17 sequenca: | 00:02:00 17 |25 fo |
Display

Activating the Animations inspector displays the Timeline window.
If the Timeline window closes again, click on the Animations inspector icon or go to Windows > Timeline.

Animating

Artlantis animates practically all commands relating to the inspectors:

e Cameras (animations)

e Lights
o Heliodons

e Objects

e Animated Textures

Begin as follows to animate the parameters for cameras, lights, heliodons, objects and animated textures:

1. Activate the Animations inspector, then
2. Activate the Light, Heliodons, Object or Shaders inspector

Comment: The Timeline window will remain open to enable you to edit animation times.

NB: In 2D View, the Timeline and the appropriate inspector must remain open in order to create
and edit animated paths for lights, objects or cameras.

The Timeline window is divided into the following 4 areas:

Cuatrenk lime: Dusabior:  Frame:  FPS: | [JLoop
000415 Sequence: |45 | 115 5

Title Bar: Shows the name of the current sequence.

2. Time scale : Gives duration of the scene with a slide bar and cursor for positioning and editing keys and
sequences.

3. Recorder : Controls recording and playback of animations.

4. Sequence Length Control: Used for editing the duration and rate of images.

Title Bar
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806

Castel exterior

Name of the current sequence, as defined in the animations list. The timeline updates relative to

the current sequence (blue band). The other sequences in the scene (gray bands).
Time scale

Car_11_1 »

| | | |
T Tor T T T

T T
Position de I'objet p
b

The slide bar is the time scale that shows the total time in the scene. The time runs from left to
right.

The cursor shows the current scene time at instant T.

NB: The current position also displays in 2D View, if the element is animated on a path.

Click and drag to move the cursor. The cursor is blue. When a keyframe passes, it sticks to the
pin and becomes red.

The cursor moves away from it when:
* The time is edited

* The current sequence is played.

* The mouse wheel can be used to zoom on the scene when rolling over the time scale.

(Jul] A0r
Time scale zoom cursor: Enables the user to show the entire scene or focus on
just a portion of it.

Current sequence: The sequence is delimited by its start < and end & pins.
[ )

The start, end or duration of the sequence can be modified by clicking and dragging the pins
to change them individually.

The entire sequence can be moved without changing the duration by clicking and dragging it
on the blue line.

00:01:08 &
o LIRAHE:

A tooltip with a yellow background indicates

the current position in min: sec: on the Time-
line.

NB: The keyframes and guides do not follow the movement. Subsequently, the
numeric Time and Duration fields are updated.

The top of the time scale indicates the events that relate to an animated element.

The bottom of the time scale shows the events relating to one of the values for the animated ele-
ment in question.

Selecting keys of an animated element.
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—=ai st
Heliodon | |
Light 02

° Right clicking above the slide bar: displays the keys of an animated element, and selects
one of the elements.

Consequences:
] All animated keys corresponding to the element in question display on the slide bar.

] The inspector corresponding to the element becomes the current inspector enabling
the user to edit its parameters rapidly.

NB: The user can also access the animated element by clicking on the triangle
located in the upper right-hand section of the window (above the slide bar).

o 0@

—a
Object Position b

Selecting keys of the current animated element.

Light 02 »
|

1
: ———=wimmsumens
Light Position
Light LensFlare Values e
Light OnfOff

. Right clicking below the slide bar: Displays the animated settings for the current element.
The sub-keys matching the setting appear below the slide bar.
Result:
All sub-keys corresponding to the parameter for the element in question appear on the slide
bar.

NB: The user can also access the animated parameter by clicking on the triangle
located in the lower right-hand section of the window (below the slide bar).

Car.01.1 p
PN

Object ?:siw

=
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NB: In order to select the parameter for an animated element, you must first
select the element and then select the parameter.

Recorder

OICICICICNO;

. This enables the user to navigate in time through the scene, and to play or stop playback of
the sequence. The cursor moves as a result.

. Description of buttons from left to right:
n go to start of sequence
u go to previous image
m  play or stop sequence
L] go to next image

= go to end of sequence

. o ®

Record animations: starts or stops the recording.

NB: Sequence playback can be started or stopped by pressing the space
bar.

Sequence Duration Control

Current Time: Deration Frama: FPS: ™ Loos
00:03:18 Sequence: | 00:10:00 | | 79 | [28 3
Currena T
. 00:03:18 . . ' .. .
Current time of the scene: | indicates the cursor's current position in

the time scale. Expressed in: minutes: seconds: image number. Entering a value
updates the position of the cursor. Dragging the cursor updates the scene time
again.

Deararsos.

Sequence: | 00-10:00 |

Duration of the current sequence : . indicates the duration of
the sequence between the start and end pins. Expressed in: minutes: seconds: image
number. Entering a value updates the position of the end pin. Dragging the pins
updates the sequence duration.

Frame:

73

Current sequence image: displays the number of the current image. Enter-
ing a value positions the cursor on the time line.

FPS

FPS: (frames per second), rate at which images are played per second
Entering a value updates the number of frames played.

# Looa

Loop: Indicates that the sequence will be repeated = Type in a value to spec-

ify the number of loops. The loop will be applied only to the current parameter of
the current animated element.
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v yv T ¥
i A A
Keyframes: e appear as colored guides distributed throughout

the time scale.

A pin represents a particular animation event at an instant T. A camera, light, hel-
iodon or object element for which one of the position, rotation, scale, etc. param-
eters has been modified.

Animation is interpreted between two keys.

Guides: == serve as visual markers for synchronizing animated parameters.

° Animations : Makes a sequence or edit of animated elements the current
one, whereupon the appropriate inspector displays.

° Shortcut: Right click above the time scale.

. Modification indicator: Shows the type of animation attached to the current
element (position, rotation, lighting power, atmosphere, etc.). Updates depend-
ing on which item is selected in the Animations pop-up.

Shortcut: Right click below the time scale.

Keyframes and Guides

Keyframes

A keyframe indicates a particular event at an instant T in the scene. Keyframes are linked to the following animated
elements: camera, light, heliodon, object, animated textures.

Current animated elements at an instant T: Camera, light; heliodon, object, animated texture.
Animated setting for current element:

Camera: position, rotation, focal, etc.

Light: position, state, type, power, color, etc.
Heliodon: date, time, etc.

Object: position, rotation, scale, etc.

Animated texture: plays the avi or mov sequence.

Animation is interpreted between two keys.

How Keys are Represented

(s

_<||
=
b1~

General Information:

e Upper pin indicates a key relative to the current animated element.

e Lower pin indicates that an animated setting of the element is current.

Pin Description

An animated element with edit setting activated (in key). Keyframe not selected (gray).

An animated element with edit setting deactivated (no sub- key). Keyframe not selected (gray).
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v An animated element with edit setting(s) activated. Keyframe selected (red).
=
v An animated element with edit setting deactivated (no sub- key). Keyframe selected (red).
- An animated element. Synchronized editing of animated settings for the element in question. Represents
73 overlap of at least 2 keyframes.
;f More than one synchronized animated element. Move the yellow pin and the superimposed keys follow.
:»l— Keyframes selected (red).
m  Moving the cursor over a synchronized key (yellow pin) displays the name of the current element,
the position in time and the parameters associated with the element.
wij More than one synchronized animated element. Move the yellow triangle and the superimposed keys follow.
% Non-selected keyframes.
m Moving the cursor over a synchronized key (yellow pin) displays the name of the current element,
the position in time and the parameters associated with the element.
¥ More than one animated elements are synchronized. The elements are not standard. Moving the yellow pin
with the arrow moves all superimposed keyframes. Non-selected keyframes.
m Moving cursor over synchronized keys: Displays the information concerning them
m  Moving the cursor over a synchronized key (yellow pin) displays the name of the current element,
the position in time and the parameters associated with the element.
00:12:07: Lumiére 1, Sequence, Lumiére 1_1, Bench_01_1
1 : © i
I b

Selecting keys of an animated element.

Car_01_1 |
Sequence_L L 1p H

—p  Lumiére 1 r {
Lumigre 1_1 B 1

e Right clicking above the slide bar: Enables you to select an animated element.
e Consequences:
m All animated keys corresponding to the element in question display on the slide bar.
m The inspector in question becomes the current inspector enabling the user to edit its parameters rapidly.

NB: The user can also access the animated element by clicking on the triangle located in the upper
right-hand section of the window (above the slide bar).

Bench_ Q
..

Position de l'objet b
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Selecting keys of the current animated element.

Light Position
Light LensFlare Values e

Light On/Off K .

e Right clicking below the slide bar: Displays the animated settings for the current element. The sub-keys match-
ing the setting appear below the slide bar.

e Consequences:

= All sub-keys corresponding to the parameter for the element in question appear on the slide bar.

NB: The user can also access the animated parameter by clicking on the triangle located in the
lower right-hand section of the window (below the slide bar).

NB: In order to select the parameter for an animated element, you must first select the element and
then select the parameter.

Creating keys

3 options:

1. Upon creating a trajectory in 2D View: two keys are created in the Timeline window - one at the start and
one at the end of the sequence.

2. With record mode turned on in Timeline, right click on the path for the "4dd Keyfirame" pop-up menu (valid
only for one path).

3. In the Timeline window with record mode turned on, modify a parameter of the current element.

NB: When an element is no longer animated, turning on record mode will create 2 key images. The
one located at the start of the sequence assumes the parameter value before the modification. The second

one located in current time assumes the post-modification parameter value.

If the parameter of an element already has keyframes, the record mode creates a single keyframe.This key-
frame is located in the current time and has the post-modification parameter value.

NB: Turning on record mode in the Timeline window forces the 2D View to appear when editing key-
frames.

Cursor pop-up menu:

Right click on the cursor (blue or red bullet icon).
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1. Add Keyframe:

= Position the cursor on the Timeline.

@

7 ¥
B Add Key Frame [ |
— <
=== addGuide
fa F we Gu

= Right click on the cursor to choose Add Keyframe.

b- [~
i~
b- [~

Result: The keyframe is added.

2. Delete a Keyframe

L T
A Ky

= Add Guide

A0

= Right click on the keyframe and choose Delete Keyframe.
Keyboard Shortcuts
1. Move a Keyframe:
m  Click and drag the pin.
2. Duplicate a Keyframe:

»  Alt+Click and drag the pin. (The 2 keyframes have the same value. Hence, they can freeze a parameter
at a given time.)

3. Moving a set of keyframes for an element (either the camera, lights, heliodon or objects):

»  Shift+Click/Dragging the pin results in: all pins to the right of the click moving in a proportional time.

Guides:

These serve as visual Timeline tags ——(blue vertical line).

Enables the user to synchronize more than one animated element (e.g.: : moving a camera must match the same instant
T as opening a door) or to synchronize animated settings tied to the same element.
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o Creating a guide: Double clicking in the Timeline (not on the slide bar) causes a vertical blue line to appear .
e Deleting a Guide: Double clicking on the vertical blue line makes it disappear.
e Moving a guide : Drag and drop.

NB: Moving the cursor on the slide bar near a blue guide magnetizes the cursor. This makes it easier to syn-
chronize parameters among several animated elements.

1. Add Guide at the cursor
m Position the cursor on the Timeline.

e Right click on the cursor and choose the Add Guide item. Double clic in the Timeline near the cursor
will also add the guide for the cursor position.

The guide is created.

2. Deleting a guide at the cursor

e Right click on the cursor and choose the Add Guide item. Y ou can also double click the guide.
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The Perspectives Inspector

Manages viewpoints defined by a camera, a target and a focal length. Each viewpoint is considered to be an auto-
nomous document with its own parameters which can receive its own environment:

In this chapter you will learn about the following subjects:

The Perspectives List . ... ... 88
Foreground Images. . ... ...l 89
Background Images. . . ... .. 90

2|

!Viewpoints List: for handling viewpoints displayed on the list.

co
— ocalFrim
.o 3 3
~ [FlDepth of ield [ ]
v —
@ .. :
T [Flshow [“lactvate o®
Lighting
Heblodon_3 v
@ Lusribre_Cuisine v
- Bue: Glass : Neon Light b
Visible Layers
£ | Scene, 30 Planks, Light cbiscts, 4.,
Ervirorenent
I_“"‘J'l”‘d o Eorporid B
- el
@ 20 Image v
Coordinates
N Target on: | Fooed Yertex >
L4 ¥: Z;
478.75cm || -2544.91 cm 791.42em
smera roll: L] %)
-771.300m || -i628.25am | 470.55am
@

1. Camera: settings, check elements to activate.
e Focal Length: by using the cursor or entering a value (Change the camera angle). The units depends on
the preferences settings.
® Depth of Field: click ' * ' then, in the Preview window, click to define the clear point of the scene,
with the rest remaining blurred. The cursor adjusts the blur amount.
e Clipping Box: for defining clipping planes.
e Show:In 2D View
e Activate: Preview Representation
2. Lighting: To handle light schemes linked to the view, select them from the drop-down
menus.

e Heliodon: links a heliodon to the view. Selecting "None" deactivates the heliodon.
e Light Group: links one or more light groups to the view. Selecting "None" deactivates the light groups.
e Neon Shaders: Links one or more Neon Shaders to the view. Selecting "None" deactivates the lighting.
3. Visible layers: check them in the drop-down menu.
4. Environment: handles the background and foreground of the scene.
o Defining a background: Background type: 3D Sky, Gradient, 2D Image, 3D Image, 3D Cubic

e Foreground Images
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e Site insertion tool automatically sets the camera with a background image.

Clicking g opens the dialog.
5. Coordinates:
e Camera XYZ Position.

*r arget XYZ Position. Clicking on " locks them and clickingon *  unlocks them.

e [tis possible to limit a camera's target to an object's movement: In object mode, right click on and object
and select "Define As Target" in the drop-down menu. Then, in Perspectives mode select the name of
the object in question in the Target on menu.

e Camera Roll: Pivots camera laterally. Turn the circular cursor or enter a value in degrees in the related
field.

6. Post-production
e Applies effects to the current viewpoint: The effects combine with and between the parameters set in
the inspector.
7. Rendering Parameters

e Prepares the document for final rendering.

NB: editing the scene information such as the infinite ground, movement of the origin, redimensioning of
the model and the coordinates may be accessed via the Window menu.

The Perspectives List
[

opens the viewpoint list. Each is displayed by name and preview thumbnail. To edit, double-click on the name.

W e

-

Pers 2

us
5

List drop-down menu

adds a viewpoint

deletes it.

e Right-clicking on a view displays the pop-up menu:

Cuplcate
Dislete

A bo Paralel Wi List
A bo Pancrama List
Add bo VR Objact List
Bt by Seisricer List

Edit Heliodon
Edit Light L]
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Duplicate: Uses the original to create a new superimposed viewpoint.
Delete: The viewpoint is removed from the list.

Add toParallel Views List:

Add toPanorama list:

Add toVRODbject List

Add to the Animation list

Depending on option selected, adds current view from Perspectives to Parallel Views, Panoramas, VR
Objects or Animations.

Edit Heliodon: The palette inspector switches to Heliodon mode and the heliodon is selected.
Edit light: select a light, the inspector palette switches to Lights mode and the light is selected.

Foreground Images
Defining a Foreground

Foreground

. Ll a double-click opens the search dialog for image files.

Load foreground image:

. By dragging and dropping into the inspector's Foreground image area.

. Using the Foreground image dialog: double click in the image zone.

NB: The foreground image must have an alpha channel (representing the opacity or transparency
of the image); for example, to view the scene through vegetation.

The file formats accepted are Photoshop, TGA, TIFF, PICT.
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Background Images

In the local Viewpoints menu:

Hiligdes Sy
Crad
0 Image

30 Cwbic

or

& White
Cradient
20 Image
30 Image
30 Cubec

Background
type

Description

Background

Heliodon Siy 18]

3D Sky:

In the Viewpoints inspector, the current view is associated with a configurable 3D Sky:
day/night, type of clouds, cloud density.

This is assuming that the clouds have been associated with the heliodon.

BiClouds — 5nd the heliodon in question has been associated to the current Viewpoint.

NB: If'the viewpoint doesn't have associated heliodon then the sky is white.

Background

=]

Gradient =

Graduated:

3 colors that mix linearly. By default, one top color, one middle color and one bottom color,
with one graduating horizontally towards the other.

Background

20 Image )

2D Image:

adjusts to the size of the Preview while respecting its ratio (width x height). Use this option

Er
to make an insertion in the site. To move the background image, Ctrl-click on the
thumbnail and drag the cursor.

Resetting the image position : double-click right on the thumbnail.

Background

30 Image )

3D Image:

Creating a 3D environment from an image. To move the 3D background, Ctrl-click on the
thumbnail and drag the cursor..

Resetting the image position : double-click right on the thumbnail.

NB: Check the left-right continuity of the image being used.

Background

30 Cubic )

3D Cubic:

Creates a 3D environment from a .mov file comprised of 6 surfaces of equal size. To move
the 3D background, Ctrl-click on the thumbnail and drag the cursor.e.

Resetting the image position : double-click right on the thumbnail.

NB: Check the left-right continuity of the image being used.

Loading a background image:

Background

By dragging and dropping into the inspector's e area

Background

By using the background image dialog: double-click in the background image area
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Deleting a background image

e Click within the background image and then use the DEL key on your keyboard. A dialog will appear asking
you to confirm the deletion.

a Do you really want to delete this image?

v D) G

NB: the file formats that are supported are: Photoshop, TGA, TIFF, PICT, BMP, and JPEG.
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The Parallel Views Inspector

Manages viewpoints defined by a viewpoint, a target and a display width. Each viewpoint is considered to be an auto-
nomous document with its own parameters which can receive its own environment:

In this chapter you will learn about the following subjects:

The Parallel Views List . . 94

8

! Parallel Views List: for handling parallel views on the list shown.

Ot &

Parslel
.
L]
@w: 275 =

0 Flshow Flacate a |
Lighting
i s
Lisrebre_Cuisine v
Bdue Glass : Neon Light v

Visible Layers
£ | Scene, 30 Planks, Light chiscts, A,
Enviroranent
Barckground Foreground
whie v

Coordnates
B it :

856,75 cm || -1114.00cm || 102095 cm
IS am || -1104.00 cm 2248

1. Parallel views:
e Type of projection : Click on Elevation, Top, or Axonometry.

e Camera Roll: Pivots camera laterally. Turn the circular cursor or enter a value in degrees in the related
field (available only in Top View).

o Scene width: defines the width of the selected view (current unit).

NB: value modification depends of the ViewPoint Update Mode settings in Preferences.

e Clipping Box: for defining clipping planes.
o Show: in the 2D View
o Activate: Preview Representation.
2. Lighting: To handle light schemes linked to the view, select them from the drop-down
menus.

e Heliodon: links a heliodon to the view. Selecting "None" deactivates the heliodon.
Light Groups: Links one or more light groups to the view. Selecting "None" deactivates the light
groups.
e Neon Shaders: Links one or more Neon Shaders to the view. Selecting "None" deactivates the lighting.
3. Visible layers: check them in the drop-down menu.
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4. Environment: handles the background and foreground of the scene.
o Defining a background: Background type: 3D Sky, Gradient, 2D Image, 3D Image, 3D Cubic
e Foreground Images.
5. Coordinates:
e Camera XYZ Position.
e Target XYZ Position.
6. Post-Production:

e Applies effects to the current viewpoint: The effects combine with and between the parameters set in
the inspector.

7. Parallel View Rendering Parameters:

e Prepares the document for final rendering.

NB: editing the scene information such as the infinite ground, movement of the origin, redimensioning of
the model and the coordinates may be accessed via the Window menu.

The Parallel Views List
=

opens the viewpoint list. Each is displayed by name and preview thumbnail. To edit, double-click on the name.

& &

-

Elévation

Plan masse

Axonométrie

adds a viewpoint.

2

—  deletes it.

List drop-down menu

e Right-clicking on a view displays the pop-up menu:
Cuphc ste

Add b Perspective Yiew List
Add bo Panoramas List
Add bo VR Object List
A by Sequsnde List

Edit Heliadon
Ecit Light »
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e Duplicate: from the original, creates a new superimposed viewpoint.
e Delete: The viewpoint is removed from the list.

o Add to Perspectives list

e Add to Panoramas List

e Addto VRODbject List

e Add to the Animation list
Depending on option selected, adds current Parallel view to Perspectives, Panoramas, VR Objects or
Animations.

e Edit Heliodon Activated With This Parallel View:
The inspector palette switches to Heliodons mode and the heliodon is selected.

o FEdit Light Activated With This Parallel View:
Choose a light. The inspector palette switches to Lights mode and the light is selected.See " Example:
light model" page 3
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The Media Catalog

A media allows the project to be dressed by dragging and dropping the thumbnail view onto a scene medium (mate-

rial, object or background from the Preview window).

In this chapter you will learn about the following subjects:

Catalog Manager. ... .. ...

Dressing the Scene with Media.
Postcards.

4 types of Media: Shaders, Objects, Images and Postcards divided into 2 categories.

The Media Catalog window is divided into 3 areas: Favorites, Thumbnails and Preview.

Capetdl Carpetd? Capet(s
Campetd C

Capet0? Corpet0s Carpet0 b

[ Fevomes T |

£ Beick
L Carpet
{23 Costing
2 Gravel

# 3 Images

# ) Objects

3 1 Lights

# (] Posteards.

1. Favorites:

m Lists the catalogs, editing catalogs.
2. Thumbnails:

= Displays Media thumbnails and adjusts their size.
3. Media Preview

m drag/drop Media or Postcard elements to the scene.

....... 98

...... 929

NB: Additional samples of Media catalogs are available from Artlantis on DVD or firee for download from

our site at www.artlantis.com
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Catalog Manager

Favorites area

&
¥ Medias
b= Images
= Objects
wShaders
a Surface
Bricks
Moguette
Enduit
Craviers
Pelouse
Parquet
Pavage
B Textures_procédurales
Toiture
Miirs
Bois
Postcards

| -

Navigating Media Types
Used for going from one Media folder to another:

e Click on the catalog to be displayed in the favorites area. The Catalog structure is the one on the hard drive.

Adding a Catalog

* | Opens the dialog for locating folders.

e Selecting the Media folder to be added.
Updating Catalogs

8o8e

wMedias
P images
b Objects
Postcards

Reload Favorites
—————

[+]-
Updates the content of a catalog folder whose content has been changed.

e Click right in the favorites area and select "Reload Favorites".

Removing a Catalog

Deletes the selected catalog from the favorites area.

NB: Deleting a folder does not erase it from the hard drive. It is available only at the first level of the hier-
archy folders.
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Filtering Catalog Media Display

Shiva Shaders
Show Obpects
Show Images
Shire Movida
Shiora Postcards

T ]

| | Update Cache

e Click on the local menu of the Display button.
e Select the desired option so that the media type you have selected will not be displayed.

Modifying the Size of Catalog Thumbnails

e @ g [&] Change the cursor to display or reduce the size of the thumbnails.

Dressing the Scene with Media

Dragging/Dropping a Media from the Catalog to the Preview Window

In the Media view area, select the desired media and then drag and drop it into the scene over a material, object or
background (for only one image). The element that is ready to receive the Media is highlighted when the cursor rolls
over it.

In this example, we are applying a shader to the wall:

808 @ Island_Final-4.atl (=]
@ 2azao B B &

B

Last rendering time: 3.753¢c.

‘@00 < Island_Final-4.atl =N
®@ @2azas] B B & M 4K

Last rendering time: 3.75sec.

U

R [ ——
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‘8080 < lsland_Final-4.atl =)

® @Pazao 0O BB @ E E =

Result

Postcards

Collecting and Organizing Postcards. Collecting a PostCard is equivalent to taking a snapshot of the contents of the
current scene at any time, storing all parameters assigned to the materials: Colors, Shaders and textures. The idea is to
facilitate recovery of its settings and, if necessary, to be able to quickly send the information it contains to any other
user, or from one project to another.

Saving a PostCard

Saves the current view as a Postcard.
Tools Menu > Create a Postcard, a dialog box enables the user to name and specify the location where it is saved.

e Clicking on Save stores the Postcard. There is an unlimited number of saves.

NB: Postcards are saved to jpeg format either in a Postcards folder or another folder that you will have to
catalog.

NB: Although the Postcard is in jpeg format, editing it with an image touch-up program will cause it to lose
Shader and texture-specific information and makes it unusable in Artlantis.

From the Favorites area, navigate to a catalog containing Postcards and select the Postcard in the thumbnail area.

Using a Postcard

In the Catalog Preview area, simply drag and drop Postcard elements to an element displayed in the Preview win-
dow.

Sending a Postcard
To send Postcards, find the folder on your hard drive where the Postcards are saved.

e Find the Postcard on the hard drive and transmit it to another computer.To catalog the Postcard, use the Favor-
ites area in the Catalog window.

Under Windows, Postcards are saved in the Postcards folder C:\Program Files\Artlantis Studio 3\Media\Postcards or
Artlantis Render 3\Media\Postcards.

Deleting a Postcard

Locate the Postcard saved on the hard drive and delete it.
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Using Postcards

Select the Postcard.Drag and drop the attributes of a material (color, Shader, texture) to the receiving material in the
Preview window .

1. Starting scene

®0e L R ————— )\
® Pazao O B & B H =

Last rendering time. 3.68sec

2. Drag and drop

e0e 5 tstand. Final-4.a1 =

® @Pazaol B B R B

3. Result

®06 o lsland_Final-4atl )

® Pazao 0 B @B @ & =R

NB: Textures associated with a Shader are maintained and go with the assignment.

When a Postcard includes textures associated with a Shader, once it has been dragged and dropped to a material in the
scene, these textures will also be applied.
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The Shaders Inspector

Shaders

The following different types of shader are available: Basic Shader, Expert Shader, Realistic Glazing
Shader, Luminous Glazing Shader, Neon Light Shader, Realistic Water Shader, Texture

Procedural shaders (formerly Artlantis 4.5 Shaders)

Shaders: Procedural, Mirror, Transparent, Marble, Lines

NB: Shaders can be found in the Media Catalog. Different types of Shaders may have different Shader inter-
face palettes.

NB: editing the scene information such as the infinite ground, movement of the origin, redimensioning of
the model and the coordinates may be accessed via the Window menu.

In this chapter you will learn about the following subjects:

Create Shader. ... . e 103
Materials LSt . . e 106

List Organization. . . ... ... e 107
Realistic Water Shader. . ... ... . e 108
The Neon Light Shader. ... .. e 110
The Basic Shader. . .. ... e 110
Expert Shader. .. ... . e 112
Shaders: Procedural, Mirror, Transparent, Marble, Lines.. ... ... .. . . . ... .. .. ... ... ........ 113
Luminous Glass Shader. .. ... e 114
Realistic Glass Shader. ... .. e 114
Editing TeXtures. . . ... e 116

Materials LSt . . . e 116

Texture MapPing . .. 116
Reafect a Material .. ... . 118
The Materials and Textures Pop-up Menus. . ... ... ... ... e 119

Material . .. e 119

X U, | e 120

Create Shader
This is done using an existing Shader either:

e from the active Shaders inspector, menu: Tools > Create Shader fiom...

or by right clicking on the name of a ~ #dd Texture... material and selecting the option Create Shader
From...

The edit dialog opens with the image of the current Shader. If the current Shader is a procedural, the dialog is empty.

The dialog must be populated with images and values. Do this by dragging and dropping where appropriate or dou-
ble click on the thumbnail to open a dialog to choose an image.

Once stored, the new Shader will appear as a Standard Shader.
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Edit Shader...

60,00
120.00
M 0.00
Shder Range
Max 050
Tratial vahse J 0.10
Shiriress
| i Shider R . e
snge
Max | 100000
Irtialvaue ] .00
Burp
= Me | <100
m——— s Range
R Ma: 1.00
r—— L)
Il vabue 000
Hoemal
B M +1.00
Shder
el 1.00
o
Initial vabue 0.00
Transparency
[_soveasshader.. | [ concel |

e Enter the name of the Shader. This name will appear in the top left of the inspector.
2. Preview

This is the thumbnail that appears in the Shader Inspector and in the thumbnail field of the Catalog.
The thumbnail representing the Shader must be a 128 x 128 pixel jpeg file.

The width of the thumbnail gives the size of the image in cms to a scale of 1.

NB: If you do not provide a thumbnail, Artlantis will use the diffuse image resized to 128 x 128 pix-
els.

3. Diffuse:

The image must be present. This is the visible part of the Shader. Depending on the pattern, we recommend
an image size of 512 x 512 or 1024 x 1024 pixels.

NB: If the image is not square, Artlantis will stretch it to make it square.

The diffuse width gives the the image in cm on a scale of 1.

Depending on the representation, this size may differ from the preview thumbnail. The diffuse image does
not necessarily represent the same image as the thumbnail.

NB: The diffuse image represents 4 times the size of the thumbnail image but its pattern is 3 x 3 the
size of the thumbnail in order to avoid a repeat effect.

The diffuse image is not visible in the Shaders inspector but displays in the Catalog Preview field.
4. Reflection
The image is optional. It is generally in gray scale but may be in color.
Its size in pixels must be the same as the diffuse image. Otherwise, Artlantis will stretch it depending on the

size of the diffuse image.
The purpose of the reflection image is to modify the value of the reflection cursor:
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e In black pixels, the slider value is multiplied by 0.

e In white pixels, the slider value is multiplied by 1.

e In intermediary pixels, the slider value is multiplied by the intermediary value.
It is useful to limit the effects of reflection at certain parts of the diffuse image.

NB: The slider is limited to a minimum and maximum value. For example, entering a value of 0.35
will define a slider that will range from a minimum of 0 to a maximum of 0.35.

You can test the effects of each of the settings in real time in the Preview window.
5. Shininess

The image is optional and should be in gray scale.

Its size in pixels must be the same as the diffuse image. Otherwise, Artlantis will stretch it depending on the
size of the diffuse image.

The Shininess image is used to modify the slider value: Same as Reflection.

6. Bump:

If the Shader has no Bump image, the slider will be available in the Shaders inspector and Artlantis will use
the diffuse image to provide bump. Hence, the bump image will always be available and will use less system
memory.

7. Normal:

The image is optional. The colors use strict rules to define the bump simulation. Generally, it replaces Bump,
but Artlantis can support both.

Important: It is not simple to create a "Normals" image. If the Shader has no Normal image, the
slider will be disabled in the Shaders inspector.

8. Transparency:

The image is optional and should be in grayscale.
It is used to simulate holes and transparencies in the Shader.

e In black pixels, the Shader is opaque.
e In white pixels, the Shader is transparent.
9. Save Shader as:
Opens the save dialog.
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Create Shader and Shader Interface Match:

Hin Smoothness. Max : Trarparency
3 [0 |
(] Materialis viskie
[ Material casts shadows
| Save &5 Shader... ' Cancel
(] Material racerves shadows = - [comel |

Some Basic Shader settings are not available in Create Shader: Rotation, Mix Color, Transparency, Projection
Options, and Materials Identifiers have default values.

Materials List

‘-—‘ opens/closes the list of Materials.
They are displayed by name. To edit, double-click on a name.

[ ——
[

= ene -
Surf-whitewash_| : bask
Mekal-Stainkess Steed
Wood-Flooring strip : Wood D03
Glass : Fresnel Glazing
= Wid-Flooring Strip

Pre.ipg
Exct-Brick, new : Costing014

Hair tgs
Mil-Stainkess Steel
‘Wiood-Fine | Wood_D023
Metal-Ahuminium
Metal Dark : basic
Surf-Plastic Laminste
Surf-Whitewash : Costing013
Mil-Cheome
Wood
Surface-Flastic laminate
Metal-Chrome
Metal-icke!
GOLMIE plate
GOAMI_hot plate
Surf-Ceramics, Glazed
Mel-hckel
Mtk-Zin
GlaszLamg
Surface-Ceramics, glazed
Cabinsts

GOAMES_GDL_MATERIALZS
GOLM30_GDL_MATERIAL )
GOLMIL_GDL_MATERIALS
GDLMIZ_GDL_MATERIALTZ
GOLM33_GDL_MATERIAL S
Eue : Fresnel Water
Surface-Ceing
Wood deck : Parqust_04
GDL_MATERTAL3T
= Concrebs_3
= Concrete_3_1
& vhTopf _Betonl
i vh_Erde_1
= Tore
= Tore_t
Rowge : Necn Light *
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Toolbar:

[ (5] (b .

. creates a new material based on the material selected.

m The material created appears at the end of the Materials List (before the Object Materials). The textures

linked to the duplicated material are also duplicated.

Add a texture to the selected material. Select a TGA, JPEG, BMP, PICT, PNG, TIFF, EPIX, Photoshop,

MOV, AVI, or MPG file.

associated with the geometry.
Shortcut: Hit the Back key.

- [@fe .
~  Enables the user to reassign a material.

List Organization

Infinite Ground Material ® o]

3 Jeene
Surf-Whitewash_1 : basic
Mekal-Starkess Steal

Wioad-Flooring strip : Wood_DO23
lass : Fresnel Glazng
= Wid-Flooring Sty
Pine.pg
= Ext-Brick, new™ ing014
Hair.tga
ME-Staindess Steed
® Wiood-Fine | Wood_DOZ3 @
Metal-Alumingum
Metal-Dark : basic
Surf-Plastic Laminate
Surf-Whitewash : Costing013
Mil-Chrome
Wiood
Surface-Plastic laminate
Metal-Chrome
Metal-tickel
GOAMIE plate
GOAMIS_hot plate
Surf-Ceramics, Glased
Mti-ickel
Mth-Zinc
Glase-Lamp
Surface-Ceramics, glased
Cabinets
Sn-Limestorss, Shiny
Brick-Alpha
GOLMEE_Wood-Pins
GOLMEZS_GDL_MATERIALZS
GDRM30_GDL_MATERIAL3G
GOAM31_GDL_MATERIAL3]
GOLM3Z_GDL_MATERIAL3Z
GDLM33_GOL_MATERIAL33
Blue : Fresnel Water
Surface-Cading
Woed deck : Parquat_D4
GOL_MATERIALIT
= Concrete 3
= Coerate_3_1
) vbTepf_Betont
# b _Erde_1
ore ( )
= Tore | 9 s

1. Material

x
Delete the selected material or the selected texture linked to a material. Activates when the material is not

Names of Materials in the scene are listed in alphabetical order and followed by the name of the Shaders.

2. Ground Material

This is the material applied to infinite ground (Scene Information). It appears at the top of the materials list.

3. Scene

Clicking on the Scene tab opens/closes the listed materials that are specific to the scene or internal com-

ponent.
4. Object Name:
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Clicking on the Object tab opens/closes the list of Materials with Shaders and Textures linked to the object in
question.

5. Material Name

When the material is assigned, the name is written in black.
6. Shader Name

Follows the two full stops of the material name.
7. Texture Name

Follows the material or Shader name.

You can use drag/drop to re-arrange the order in which textures associated with a material are mapped. Drag-
ging/dropping one texture to another makes it dependent. This enables you to move them at the same time.

8. Newly created materials not associated with geometry

The material name is shown below the listed materials.

9. Object Instance Name
The Object Instance is made up of several materials
The user can drag and drop a Shader onto a material in the list.
The Copy /Paste shortcuts can be used within this list.

NB: Limitations - in an ATL reference file, any material that has been renamed or re-assigned will not be
recognized by the "Use Reference File...” command.

Here, we recommend that you go back to your modeler to distinguish the material names and then, if your mod-
eler allows it, update the atl file or use the "Use Reference File" function.

Realistic Water Shader

5

—I Materials List: displays the materials of the scene.

Fresnol Water Shader

(Z) Reflection I
= ==
o | 100000
Fresned transition @
‘Waker Surface
Wave Site
=
5.00
Animation parareters

=

Materials ID Parameters :
Min Smoothness Max
) 0.00

[#] Material is wisible

[#]msterinl casts shadows
[FlMaterial receives shadows
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10.

Color Selector:
Click to select a diffusion color or enter numerical values (1 to 255) in the RGB fields.
Saturation:
Use the slider to choose the color saturation level.
Transparency
Reflection, Shininess
Gives a reflective appearance to the material.

May be used in conjunction with the color from Diffuse, Transparency or both. Drag the slider to make the
material reflect its environment or enter a value in the related field. The reflection intensity is managed using
gray scale values or RGB values from 0 to 255. Click on the selector to choose a color.

Entering a Limit value defines the maximum distance of the reflection.
Fresnel Transition
Water surface:

Wave size: Drag the cursor to adjust the wave amplitude or enter a value in the related field. The wavelength
value can be from 0 to 500.

Flatness: Drag the wave amplitude cursor or enter a value in the related field.
Animation settings:

Allows the user to automatically adjust the moving water effect which will only be visible in sequence
animation mode. If the box is unchecked, the movements are suspended.

Allows the user to animate the water movement speed. Values from 1 to 3.
Material ID Parameters:

Use the slider to choose the smoothness level for the material.
Material Characteristics:

The material is visible or invisible.

The material either projects shadows or it does not.

The material either receives shadows or it does not.
Shader/Textures Navigator:

For a material, this makes it possible to navigate between related Shader and Textures editors.

NB: effect only in Artlantis Studio in animation mode
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The Neon Light Shader

B . .
|_ ‘Materials List: displays the materials of the scene.

Glass-Lamp
Heon Light
=20
| 20
|| 200

0.00
o

o &0

Mn Smoothness Max
1) 0.00

[l material is visible
[Flmaterial casts shadows e
[#lMaterial receives shadows

1. Color Selector:

Click to select a diffusion color or enter numerical values (1 to 255) in the RGB fields.
2. Saturation:

Use the slider to choose the color saturation level.
3. Lighting Power:

Drag the slider to change power or enter a value (from 0.1 to 5000) in the related field. Click to choose a
color from the system color picker.

4. Transparency
5. Neon:

Drag the slider to adjust the neon power or enter a value in the related field. Click on the selector to choose a
color.

6. Shininess
7. Material ID Parameters:
Use the slider to choose the smoothness level for the material.
8. Material Characteristics:
The material is visible or invisible.
The material either projects shadows or it does not.
The material either receives shadows or it does not.
9. Shader/Textures Navigator:

For a material, this makes it possible to navigate between related Shader and Textures editors.

The Basic Shader

]

— Materials List: displays the materials of the scene.

Page- 110



The Shaders Inspector - The Basic Shader ¥

Metal-Aluminiam

Reflection
£ 0.00
| @ Reflection bmi: 0.00 cm
Shirirmss
8] .04
[specal -
Transparency
e .
A ~ L0

Makerial

Mn Smocithress Max
| 2 0.00

[F]Material is visble
[FlMaterial casts shadowrs
[#] Material recoives shadovs

1. Color Selector:

Click to select a diffusion color or enter numerical values (1 to 255) in the RGB fields.
2. Saturation:

Use the slider to choose the color saturation level.
3. Diffusion Color:

Another way to select a color is to click to choose a color from the system color picker.
4. Reflection, Shininess

Reflection: Drag the slider. When the diode is red, the material reflects its environment or enter a value in the
related field. Click on the diode to cancel the command.

Limit: Entering a Limit value defines the maximum distance of the reflection.
S. Transparency
6. Material ID Parameters:
Use the slider to choose the smoothness level for the material.
7. Material Characteristics:
The material is visible or invisible.
The material either projects shadows or it does not.
The material either receives shadows or it does not.
8. Shader/Textures Navigator:

For a material, this makes it possible to navigate between related Shader and Textures editors.
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Expert Shader

El

— ‘Maten‘als List: displays the materials of the scene.

Espert Shader @
|[ 100
| 100
| 100
& Dffusion
) Reflection
Reflection kmi: 0.00 cm
Shiriress
1 6.00

Min Smoothness  Max
s} 0,00

=

[FMaterial is visibie:
[ Material casts shadows
[l Material receives shadows

)

Color Selector:
Click to select a diffusion color or enter numerical values (1 to 255) in the RGB fields.
Saturation:

Use the slider to choose the color saturation level.

. Diffusion Color:

Another way to select a color is to click to choose a color from the system color picker.
Reflection, Shininess
Gives a reflective appearance to the material.

The reflection intensity is managed using gray scale values or RGB values from 0 to 255. Click on the selec-
tor to choose a color.

Entering a Limit value defines the maximum distance of the reflection.
Transparency
Neon:

Drag the slider to adjust the neon power or enter a value in the related field. Click on the selector to choose a
color.

NB: Neon color does not emit light.

Material ID Parameters:

Use the slider to choose the smoothness level for the material.
Material Characteristics:

The material is visible or invisible.

The material either projects shadows or it does not.

The material either receives shadows or it does not.

Shader/Textures Navigator:
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For a material, this makes it possible to navigate between related Shader and Textures editors.

NB: Before editing a color, click on the button associated with the command.

Shaders: Procedural, Mirror, Transparent, Marble, Lines

(=

! Materials List: displays the materials of the scene.

[FlMaterial s vishle
[FlMaterial casts shadows
[l Material receives shadows

o
.

Color Selector:
Click to select a diffusion color or enter numerical values (1 to 255) in the RGB fields.
2. Saturation:
Use the slider to choose the color saturation level.
3. Color Picker:
Shader defined by 2, 3 colors or more (e.g. checkerboard).
4. Shininess
Drag the slider to make the material reflect its environment or enter a value in the related field.
5. Roughness:
Moving the slider lets more or less light move on the material.
6. Color Table:

Defines the gradient mode between 2 colors. The mixture depends on the Shader's geometry. e.g. Check-
erboard, Lines, Stone, Marble, etc.

Click on the curve, keep the mouse button depressed and move to redraw the curve.
A horizontal line at the top or bottom of the table indicates that a single color is applied.
A diagonal straight line indicates a regular shading.

—
(&)

Flip: The ™ button turns the Shader around its object.
Scale: Moving the slider adjusts the Shader proportionately.

7. Material ID Parameters:

Use the slider to choose the smoothness level for the material.
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8. Material Characteristics:
The material is visible or invisible.
The material either projects shadows or it does not.

The material either receives shadows or it does not.

Luminous Glass Shader

=l

—— Materials List: displays the materials of the scene.

Surf-Ceramics, Glazed [

i ©

Reflection
3 0.50
Reaflaction Eni: 0.00 cm
Shininess
J 6,00

Min Smocthness Max
& 0.00

[l Msterial is visible
[Flmatecial casts shadows
[ Msterial recsives shadoves

1. Color Selector:

Click to select a color or enter numerical values (1 to 255) in the RGB fields.
2. Saturation:

Use the slider to choose the color saturation level.
3. Lighting Power:

Drag the slider to increase power or enter a value (values from 0.1 to 5000) in the related field. Click to
choose a color from the system color picker.

4. Transparency
Reflection, Shininess

b

6. Material ID Parameters:

Use the slider to choose the smoothness level for the material.
7. Material Characteristics:

The material is visible or invisible.

The material either projects shadows or it does not.

The material either receives shadows or it does not.
8. Shader/Textures Navigator:

For a material, this makes it possible to navigate between related Shader and Textures editors.

Realistic Glass Shader

0

—IMaterials List: displays the materials of the scene.
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surf-Ceramics, Glazed 3]

Fresnel Glazing Shader i: i

@ Reflection [ ]
@ Reflection bmi: 0.00 em
‘Shirirmss.
Frasnel transition
3 s
Glazing qualty
Xf¥ proportion
J 0,50
Flatreess

Matenal

M Smocthness Max
1) 0.00

O Transparency [ @

1 6.00
Distortion size: | 100.00

J 0.50
[o] windowpane suto detection

[FlMaterial is visble
[#]Material casts shadows
[#] Material receives shadows

Color Selector:
Click to select a diffusion color or enter numerical values (1 to 255) in the RGB fields.
Saturation:
Use the slider to choose the color saturation level.
Transparency
Reflection, Shininess
Entering a Limit value defines the maximum distance of the reflection.
Fresnel Transition
Glazing Quality:
Allows a discontinuous reflection to be created when there is a break between several surfaces on the same
plane. This effect accentuates the realistic effect of reflection on a wall of glass.
Distortion size:
Determines the length of the undulation. Enter a value into the related field.
XY
To orientate the undulation mostly on the X- or Y- axis or both. The slider allows the proportion to be var-
ied. Enter a value into the related field.

Flatness:

Determines the amplitude of undulation. Enter a value in the related field.
Automatic glass detection:

When checked, finds the limits of a contiguous shape to generate a glazed surface.

7. Material Characteristics:

8.

9.

Smoothness: Use the slider to choose the smoothness level for the material.
Shader/Textures Navigator:

The material is visible or invisible.

The material either projects shadows or it does not.

The material either receives shadows or it does not.
Shader/Textures Navigator:

For a material, this makes it possible to navigate between related Shader and Textures editors.
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Editing Textures

A texture is an image or sequence that is imported onto a material. A material can receive one or more textures.

'Materials List

Applying a texture is done either by:

® Using the =] Add Texture button in the Shaders inspector

e Create Shader...
wcanag A io All Inst
b weanap_1 (i i L
t.nap.-r.mm_p
Right clicking on the name of the material ‘= anis-2 *  and selecting the Add Texture...

option
e By dragging/dropping the texture thumbnail from the Catalog to a material in Preview mode or in the list.

e Dragging and dropping the texture from a location on the hard drive onto a material in Preview or in the list.

Deleting a texture is done either by:

Clicking on the o button to delete the current texture.
e Using the Delete background key.
e Right clicking the name of the texture and selecting Delefe in the pop-up menu.

Texture Mapping

Texture mapping @

e
3 100.00 %

+| | 80.00 cm 3+ 60.000m
- | 0.0Dcm 2| | 0.00em
%] Keep Proportions
aic| =8
O o

Crthagonal w

1. Preview:

Displays the thumbnail of the selected Texture. The blue cross represents the anchoring point of the texture.
Clicking in the image repositions this point.
2. Rotation:
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10.

Use the circular cursor (Shift + Click, to step every 15°) to turn the texture on its axis or enter a value in the
related field.

Mix Color:
Check and click on the selector to choose a color.
Reflection

Move the slider to change the reflection or enter a value in the related field. When the diode is red, the texture
reflects its environment.
Double click on the red diode to cancel the effect.

Entering a Limit value defines the maximum distance of the reflection.
Shininess
Use the slider or enter a value into the related field.
Ambient:
Use the slider or enter a value into the related field.
Bump:
Use the slider or enter a value into the related field to simulate the effect of bumps or hollows on the surface

of the material using the levels of gray contained in the image.
Double click on the diode to cancel the effect.

Normal mapping
Transparency:

Apply a level of transparency to the texture or enter a value into the related field. Click on the diode to cancel
the effect.

Use Alpha Channel: Activates/deactivates the transparency of the alpha channel.
Using a transparency color: Click on the selector to choose a transparency color.

Scale:

Button ' : The texture is automatically adjusted to cover the maximum surface of the material horizontally
and/or vertically.

The slider changes the texture scale firom 50 to 200% of the current size. Or enter a value into the related
field.

Dimension, Spacing:
Width/Height:

Size
0.51 m
0.5l m

Enter the size of the texture, clicking on “ retains the proportions. Click again to cancel the limitation.
Horizontal/Vertical Spacing:

Space |
0.00 m

0.00 m

Used for repeated textures. Defines the size of the spacing between each repetition.

Enter a spacing value as H and/or V. Clicking s keeps the same proportions. Click again to cancel the lim-
itation.

db . . . . . . "
Flip: horizontally or vertically inverts the texture with a mirror option between 2 repetitions.
Horizontal, Vertical repetition: duplicates the texture along the horizontal and/or vertical axis.
Horizontal Mirror, Vertical Mirror: Horizontally and/or vertically inverts each duplication.
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11. Projection:

Adjusts the image to the surface on which it is placed. Automatically selects the adjustment best suited to the
project.

Planar

+ Drthogonal
Wertical
Spheric
Yylindric
¥Cylindric
uv
Planetary

Planar: is applied to a plane.

Orthogonal: is applied to an element. If the element is composed of surface planes, the texture follows the
surface planes.

Vertical: vertical projection on the element. The horizontal parts receive the image while the vertical or tilted
parts are stretched.

Spherical: adopts a spherical form that depends on the size of the texture. Hence, it may leave empty spaces.
YCylindric: the texture is projected around the axis of a vertical cylinder.
XCylindric: the texture is projected around the axis of a horizontal cylinder.
UV: maintains the texture coordinates on an object coming from software that manages UV maps.
Planetary: vertical projection of the element while passing through the poles, without leaving spaces.

12. Shader/Textures Navigator:

For a material, this makes it possible to navigate between related Shader and Textures editors.

Reafect a Material

The geometry selected in the Preview window is used to reassign materials.

al
Use the toolbar o =

+
Create and name a new material:
2y

Activate @*

[

@@ 4

hed
o

Choose the type of selection in the ~  drop-down menu, by triangles, planes, parallel planes, objects, mate-
rials or magic wand.

In preview mode, click on the items you want to reassign with the new material.

NB: Elements making up an object cannot be selected.

Click on to apply the material.

Cancel a Selection

6. Click on again
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NB: The File > Use Reference File command does not recognize reassigned or renamed materials.

The Materials and Textures Pop-up Menus

The pop-up menu depends on the name of the material or texture clicked.

Material

e Right-clicking on a material name displays the following pop-up menu:

Craste Shader Froem,..

Add Texture...

Merge Makerisks with Same Shader
Merge Vertex

v Yishis
o Cast Shadow
w REceive Shadow

Db Al Urassed Materials

e mm e —

Create Shader From...

Opens the Create Shader dialog.

Apply to All Instances

Applies the modified material of an object to all identical objects in the scene.

Reset to Default

Applies the original material to the object.

Add Texture...

Open the dialog box and choose a TGA, JPEG, BMP, PNG, PICT, or Photoshop file.
Merge materials with Same Name

Materials with the same name will be replaced by the selected material.

Merge Material with the Same Shader

Materials with different names but having the same shader are grouped under the same name.
Merge Vertex

Merges superposed points of the polygons using this material.

(Avoids the problems of modeled object artifacts whose superposed points are not merged and allow the smoothing
of the polygons).

Visible
e Ifunchecked, the material becomes invisible.
Cast Shadow
If checked, the material casts shadows on the other elements.

Receive Shadow

If checked, the material receives the shadows cast from other elements.
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Delete All Unused Material IDs

Clears the materials that are not assigned to the geometry.
Delete

Deletes the selected material.

NB: Does not delete a material from the original model.

Texture
e Right-clicking on a texture name displays the following pop-up menu:

Delete |
Merge Texture Origin [ Top Left

Top Right
Bomom Left
Bamorm Right
Center

Delete: erases the related texture.

Merge Texture Origin: upper left, upper right, lower left, lower right, center.
Determines the texture's anchor point. In Preview, the origin is represented by a black cross.
In the thumbnail, the anchor point is represented by a red and white cross.
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Used to edit geometry, materials, coordinates, dimensions and animation settings

Editing the geometry from the list
There are two ways of displaying the elements in the scene: by Hierarchy or by Layer

» By Hierarchy allows the user to select the elements making up the scene in view and edit them. See " The
Objects Inspector by Hierarchy" page 122

m By Layer allows the attached objects to be ordered by layer. See " The Objects Inspector by Layer" page 124

NB: editing the scene information such as the infinite ground, movement of the origin, redi-
mensioning of the model and the coordinates may be accessed via the Window menu.

In this chapter you will learn about the following subjects:

The Objects Inspector by Hierarchy. . .. ... ... i 122
L1 11T 122
OB eCt . e 123
SaAVINg A SCOM:. . . e 123

The Objects Inspector by Layer. . . ... ... .. e 124
BT 125
GOMICETY. | . . 126
OB el . e e 127

Editing the Scene. . .. .. .. e 127

Editing Objects. . . ... 129
In the case of a Standard object:. _ . ... 129
Object ANIMAation. . ... ... e 130

Creating an Object from a selection of polygons. .. ... .. .. .. .. . . ... 130
Selecting PoOlygOMS. - . ... .. e 130
Creating the object. .. . . ... 131
Canceling a Selection. . .. ... ... e 131

The Objects List. . . ... 131

Billboards. .. .. .. 132
Availability:. e 132

Light Objects. . ... 134

Standard Objects. . . .. ... .. e 135
Object AnNImation. . .. ... . ... e 135

Vegetation Objects. . . ... .. 136

Animated Character Objects. . .. ... ... .. e 137
Behavior. . . .. 138
Shader:. . ..t 138
Coordinates. . ... 138
Object AnIMAation. . ... ... e 138

Instanced Object. . . ... e 138
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The Objects Inspector by Hierarchy

The elements listed represent the geometry of the scene and objects.
The contents of the inspector differs according to which option is selected from a list:

1. Scene geometry
2. Object added to the scene

Geometry

Scanm x| Object List =
||| Himarchy |Layers

&),
N g -
% T mcnév;ezum_:

e | Moisstier Sen_L
Chéne 20m_2
Chiine 20m_3
Coordnates Chine 20m_4
) Chéne 20m_5
Noisstier Sm_2
Poskion: Chiras 20m_6
x LE F Bv-car_L
CMan0016_1
=i Tabla
Rotation: P
Ganiyou_002_1
Peopis_035_1
o) &) &,
Stz
: ¥: 2!
Animation parameters
%) Noemnal
) Orientation on path

The name of a geometry selected in the list displays its coordinates, dimensions and animation parameters. These
parameters may not be edited.

NB: the settings related to the geometry cannot be edited (name, coordinates, dimensions).

o Delete the geometry from the list: does not affect dependent objects

- e

= 1' Define Az Targst
Ciaate |
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Object

Bergamot 2_1 * | Object List x
¥E Visual Plarits Yodume 1 ; Flowers Herarchy | Layers

[ &

S Terrain2_|
Chére 20m_1
Hcisetier Sm_1
Chéne 20m_2
Chire 20m_3
Chire 20m_4
5 Chéne 20m_S
Height: T 67.43¢ Noisetisr Sm._2
Coloe: [med v Chine 20m_6
v-esr 3

£

Bergamot 2_1
Transparency: MarD016_ 1
J 12 = Table
Date Vaze
Ganiyou_002_1
() Usa hebodon date
= People_035_1

X i zZ:
690,75 om “1345.17 om 212.55am

Rotation:
o o 250
7 ¢
0, -/ /)
Aurimation parameters
(& Mormal @

(s Orierkation on path
) Orienkation on path, X only

The object settings can be edited as they are independent of the scene geometry.

Geometry pop-up menu selected

B @ Define As Target
Dielate |

When the geometry is selected in the list, right-clicking the layer name displays a popup menu with the following
options:

o Use/Do not use as target: to define (depending on the activation in the viewpoint inspector) whether a geometry
element or an object is suitable for being used as a target for the cameras

e Delete object from the list.

NB: multiple selection is available with these commands.

The objects are available in the Media catalog

Object geometry

1. Edit Object

-
2. Types of objects: Standard, Light, Vegetation, Animated person __| | Billboard.

3. Creating an Object

Saving a scene:

To export a scene as an object, see Saving an AOF Document
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The Objects Inspector by Layer

Geometry elements are always contained in layers.
The layers come either from the CAD software, or are created in Artlantis.
The Inspector dialog changes according to which option is selected from a list.

There are three selection options:

1. Layers
2. Geometry
3. Objects.

Selecting more than one layer enables their visible/invisible status to be changed depending on the viewpoint.
Selecting multiple objects enables them to be moved to another layer.

Clicking the name of an object in the list makes its insertion point flash in the Preview window.

Renaming a layer

The name of the layer selected in the list is highlighted, select it to rename it.

NB: in Artlantis, renaming a layer created in the CAD software breaks the link to this layer. In this case,
modifications made using the "Use a reference file..." command will not be recognized.
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Layers
o000, x| Ot Lt x
~ Laers
Layer informations: Iiacte)_aes
0
Mame: | 30 Plants il B 1&‘ “‘)i
HNumber of instances: §
= Scene
Huber of trisngles: 45228 B
R | Dores |
Chéne 20m_1
Hoisetier Sm_1
——— Chéne 20m_2
[_pdemncmenview | Chéne 20m 3
e Chéne 20m_4
AL Chéne 20m_5
Otione Hoisetier Sm_2
8 O objects Chéne 20m_6
4 G0 PMants =l M Light objects
4 O emboards CManDO16_1
A O animated chjects i, Animated objects
X O light obiects = [ Batoards
Ganiyou_002_1
Actions on View having this layer vible: Peogle 035 1
Edk: = | otects
Activate: - Terrain?_|
Avear )
vaze
[ Scer ivemanons. e
Layer
@ -

1. Layer data:

name, number of instances contained, number of triangles making up the geometry
2. Actions on layers

o Use by default:
When you click the "Use by default" button, the layer selected becomes the default layer for dragged objects
dropped into the scene or objects created from the scene stored there.

e Hide/Display in the current view: displays what is necessary for the active viewpoint. Advantage: improves the
display and rendering.

3. Layer type:
None, Objects, 3D Vegetation, Billboards, Animated objects, Light objects

When you drag and drop objects into the Preview window, they can be stored automatically in the layers.
This is done by telling these objects what their destination layer is beforehand.
When a project is opened, Artlantis always assigns a default layer, its name is displayed in bold. This layer
receives any object added into the scene until another layer is declared as the "Default layer".
However, you can automatically associate certain types of object with certain layers
None: by default, the component dragged and dropped into the scene is stored in the layer whose name is
shown in bold, except if this type of component has already been associated with a specific Objects, 3D
Vegetation, Billboards, Animated objects or Objects with light layer.

To define a specific layer which is to contain a certain type of component, a new layer must be created in the
list or an existing layer chosen, then in Layer type, select the type.

Any layer in the list can be chosen. In the list, the symbol concerned will be assigned to the layer icon.

Example: you create a new layer. Then in Layer type, you click on Objects. All components (objects)
dragged and dropped will be stored automatically in this layer.

4. Actions on the view containing the visible layer:
Edit: depending on the layer selected, lists only the viewpoints where this layer is visible. In the popup menu,
select the name of the view. The Inspector changes to Viewpoint inspector and the selected view is dis-
played.
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Activate: depending on the layer selected, lists only the viewpoints where this layer is visible. In the popup
menu, selecting the name of the view activates it without changing Inspector.

5. Scene information: Displays the edit dialog for the scene

Geometry

= SCae

‘ Diefine As Target .

S LIDP e
G MaveTe 3

L —r———

Right-clicking geometry contained in the layer displays a popup menu with the following options:

o Use/Do not use as target: defines (depending on the activation in the viewpoint inspector) whether a geometry
element or an object is suitable for being used as a target for the cameras or lights.

e Delete: deletes the selected geometry contained in the layer.

e Move to: moves the geometry to another layer.

NB: the settings related to the geometry cannot be edited (name, coordinates, dimensions).

Object by Layer toolbar

Obpect List ®
Heerarchye | Layers

O &. ¢

Create a layer

1. il
Create a layer — in the layer list. A new layer is added, click on the name of the layer to rename it.

(N
To delete a selected layer, click
When the layer contains geometry, a warning dialog offers to transfer the elements in this layer to another via a

popup menu or to delete all the elements it contains.

NB: renaming or deleting layers which have been created by the CAD software breaks the link with
it when the "Use a reference file..." command is used.

Creating an object

Selected layer popup menu

When a layer is selected in the list, right-clicking the layer name displays a popup menu which lets you:

e Default: define this layer as default

e Hide in the current view: makes the layer invisible for the current view.

o Edit the view containing the layer: the inspector view changes to the Viewpoint Inspector.

o Activate the view which has this layer visible: the view becomes active without changing the inspector.

e Default layer for: defines the default type for this layer: Objects, 3D Vegetation, Billboards, Animated objects,
Light objects.

e Delete : deletes the selected layer, then displays the following dialog to move its content.
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WAO.0 Eagely

The selected layer is not empty.
Please, choose what to do with its content.

) Move content to the following layer: '_ Scere 3‘
(0 Delete content:

[ Cancel )

o Delete all empty layers: deletes all layers which do not contain geometry.

o [ 1
T
Hide in the cumment view
_"_ Edit views having this Liver visibis ]
S activabe view having this layer visble ¥
Dzl Layer for »
Delete
# |G Dedsbe Al Emply Layers

NB: multiple selection is available with these commands.

Object

wrrg

Types of objects: Standard, Light, Vegetation, Animated person —_I, Billboard.
The objects are available in the Media catalog

Editing the Scene

Data related to the whole scene is displayed using a command from the Window menu or from the Object inspector in
display mode by Layers.

Model info 3

~

URL s Gk and SettirgsAlL
Layers: 7
Trianghes: 33154
Object triangles: 269136 (15)
Paralel views: 5 S
VR Obrjects: |
Panoramas: 1
v
< >

8%6.75cm | +1114.10 cm | @

0.00 | 0.00 0.00
S, Y, L)
[ ]
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1. Scene Information:

e File location:

e Number of triangles making up the scene,

e Number of triangles making up the objects,

e Types and numbers of viewpoints,

e Structure of Light, Heliodon and Material Groups.

2. Infinite Ground:

e Checking/unchecking activates and deactivates the ground. The ground receives shadows,
Shaders and objects.

® Click on the Altitude cursor. Then, in the Preview window, click on the scene element
that will define the height of the ground, or enter a value into the related field.
e FEdit Shader selects the Ground Shader and activates Shader edit mode.

3. Transfer the origin of the anchor point:

e Select the location of the new origin of the Scene.

Select Qrigin E
Center X,Y and Boattom
Center X, ¥ and Top
Center XY
‘Camara Target

Determine the object entry point (blue Moves the scene origin.
ball)

Center X, Y and below

Center X, Y and above.

Center X, Y

Camera target.
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NB: for an .aof the default anchor point can be changed in the 2D view.

4. Scene Size:
Resizes: geometry, objects, cameras, lights, etc. No impact on the size of Shaders and textures.
Editing dimensions; if Keep proportions is checked, X, Y and Z remain homothetic.

5. Coordinates:

e Model XYZ Position. Enter values in the related fields to move the scene origin.

Clicking on ~ ' Jocks them and clicking on “ unlocks them.

e Rotation: Pivots the scene along the X, y and z axes.
Shift+click and dragging the cursor restricts the movement to 15° steps.

Editing Objects
Select an object from either:

o List of Objects
e The Preview Window

e The 2D View window

The inspector palette displays the information.

In the case of a Standard object:

Objet Z00M GDL ©

;

Editer la matidre : | plate v ®

Coordonnes
Position :

X1 ¥ Z

~330.34 am ~1813.30 om 150, D?cm@
Rotation :
o o 0

2 9 D

Dimensions

X ¥ 2
110,32 om 50,00 cm 40,04 om

] Consarver les proportions

Parametres d'anmation

@ hormal
O Grientation d'apris Iy trajectoire
) Orientation d'apeés Ia trajectoire du plan X,

1. Preview Thumbnail.
Edit Shaders...
e Choose the material to edit from the list, the Objects inspector switches to Shaders mode.
3. X, Y, Z Coordinates

e Position: Provides the X,y,z coordinates for the object's anchor point. Entering new values redefines
the position.
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NB: for an .aof the default anchor point can be changed in the 2D view.

e Rotation: Pivots the object along the X, y and z axes.
Shift+click and dragging the cursor restricts the movement to 15° steps.

Clicking on 1 Jocks them and clicking on ' unlocks them.
4. Dimensions: changes the length, width and height settings.
e Click on the checkbox fo maintain the proportions. Clicking again removes the restriction.
5. Animation Parameters:
Object Position: 3 options

Normal: The object always moves parallel to its starting position. (e.g. a vector that always retains its orien-
tation regardless of the object's path).

Orientation on the Path: The object moves in X, y, z in the direction of the path (e.g. an aircraft performing a
loop).

Orientation on the path, XY only : The object moves in X, y, z in the direction of the path but always remains
parallel to ground level X,y (e.g. a helicopter taking off).

NB: using the timeline, in a single sequence, the object can change behavior several times.

Object Animation

See " The Timeline Window" page 77
See "Animatable Object Parameters" page 187

Creating an Object from a selection of polygons

From the geometry selected in the Preview window.

Selecting polygons

K
Use the toolbar in the object list =~

Activatel— .

rO0@0 4

Choose the type of selection in the = drop-down menu, by triangles, planes, parallel planes, objects, mate-
rials or magic wand.

3. In Preview, click on the elements that will make up the object.

NB: an object cannot be created from elements already used for another object.

4, &

Activate' =",

NB: for an .aof the default anchor point can be changed in the 2D view.
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The Objects Inspector - The Objects List d

Creating the object

Create object @

Iolag;

(%) Create intermal object
) Crashe extamal obiect (. A0F)

Destination layer: |30 Flants b

The object remains linked to the project but is saved either in the atl document, or in an independent aof file. In this
case, the aof file can be used in other projects.

Name the object

2. Create an internal object, or Create an external object (.aof). In this case select the location where it is to be
saved.

3. Destination layer: choose the layer for the new object.

NB: the geometry used to make up the object no longer exists since it has been converted to an

object.

NB: the use of the "Use a reference file..." command maintains control of the layers except in the fol-
lowing cases when:
in Artlantis:
- the geometry from the CAD or modeler software contained in a layer has been moved to another layer.

- the names of the layers or the geometry contained in the layers have been renamed.
in the CAD or modeler software:
- the layers have been renamed or deleted.

Canceling a Selection

Click on -l again.

NB: geometry selection does not work on Artlantis objects.

The Objects List
[£ Opens the list of object groups.
The geometry is displayed either by hierarchy or layer.
m By Hierarchy lists the elements of the scene together with the associated objects.

= By Layer lists the geometry of the scene by layer together with the associated objects.
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* @ deletes the selected object (and its dependencies). Double-clicking on the object name edits the name.
Changing the dependence of an object in the hierarchy is done by dragging and dropping.
e The objects can be placed in a hierarchy so the group of objects can be translated by moving the parent object

NB: The Delete, Undo/Redo commands are available on the object list.

Pop-up menu for objects:

e Right-click on the name.

= Scene
= Terrand_|

i.E Define As Targst
I Delste |

e Define as target: forces a camera to use the object as a target.

In the list, the object will have a red target in front of it.
In the Coordinate Viewpoint inspector, select the target object from the drop-down menu. Select target.

Coordinates of the Perspective View Inspector:

Coordinates
b ¥ rt
s 00,00 cm 130,00 om 100 0 ey
j Target o | Fided Yerbex b
o0 e —
Camera rol: o}.7)

e The selected object has been created from the contextual menu as explained above.

Billboards

Billboards are composed of a surface plane and an image.

Availability:
Available in the Catalog Manager, "2D Billboards" folder.
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ene Catalog

¥ Objects
72D Billboards

Tree 001 Tree 002 Tree 003

40

Basic Geometry

Details Tree B Twe 005 Tree.006
- Exterior
»Furnitures ¥ “ , #
objets g

Eedi= D—E

Two types of Billboards

e Vertical with relation to the ground (People and Vegetation).
e Flat, which lies flat on the receiving surface (Signs and Pictograms).

-272.04 ¢ -1 184.67 cm 234.82 cm

Rotation:

=, L =
[] Crient be camers
Animation paramsters
(%) Normal
O rientation on path
) Crisntation on path, XY only

Qﬂ

[S

Preview Thumbnail.

N

Horizontal and/or vertical symmetry.
Size of the element:

w

e Using the slider or by entering a value in the field (to go beyond the limits of the slider, type in a value.

The values of the slider will be updated accordingly).

4. Color:
Use the menu to change the color.
5. Transparency:

Used to render a Billboard with greater or lesser transparency depending on the desired level of trans-
parency: values from 0 to 100. 0 means opaque.

6. Display: Display Parameters in Preview
e Brightness: for changing brightness values from -0.25 to 0.25.
e Contrast: for changing contrast values from 0.5 to 1.5.

7. Coordinates:

Position:

e Provides the x,y,z coordinates for the object's anchor point. Entering new values redefines the posi-

tion.
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Clicking on * ! locks the coordinates and clicking on “ unlocks them.

e X Y, Z Rotation: Pivots the object.
Shift+click and dragging the cursor restricts the movement to 15° step.

* Check ® 1

8. Animation settings

Light Objects

Edit bght: | pomTLIGHTY v

Cocrdnates
X ¥ g
30970 em B45.82 o 242.86¢m
0.00 0.00 0.
5,
Damensions

X ¥ r
28.20 cm 51.02 cm 27.15 om

Animation parameters
() hoormal
() Orentation on path
() Crenkation on path, X onfy

Edk matesial: | bub_metal v @

K_ <
LS
®

[Flkeep propartions @

to restrict the billboard to always face the camera.

=l

1. Preview Thumbnail.
2. Edit Shaders...

e Choose the material to edit from the list, the Objects inspector switches to Shaders mode.

3. Light Objects...

e Choose the light to edit from the list, the Objects inspector switches to Lights mode.

4. X,Y,Z Coordinates

e Position: Provides the x,
tion.

y,z coordinates for the object's anchor point. Entering new values redefines the posi-

Clicking on 1 Jocks them and clicking on “ unlocks them.

e Rotation: Pivots the object along the X, y and z axes.

Shift+click and dragging
5. Dimensions: for mod
e Click on the checkbox to

6. Animation settings

the cursor restricts the movement to 15° step.

ifying the parameters: length, width, height.

maintain the proportions. Clicking again removes the restriction.

NB: using the Timeline, in a single sequence, the object can change behavior several times.
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NB: A light object's light cannot be deleted from the Lights inspector list. This must be done from the

Obyjects list.

See " The Timeline Window" page 77

See "Editing Paths" page 60

See "Animatable Light Parameters" page 187

Standard Objects

Objet Z00M GDL ©

;

[CJconsarver les proportions

Parametres d'anmation

1. Preview Thumbnail.
2. Edit Shaders...

e Choose the material to edit from the list, the Objects inspector switches to Shaders mode.

3. X, Y, Z Coordinates

Editer la matibre : | plate v ®

Coordonnées
(s
Foskion :
X1 ¥ Z:
~330.34 am ~1813.30 om 190.07 et
Rotation :
o o 0
P s ¢
= / !
Dimensions

%3 X 2t
110.32 om 50,00 cm 40.04 om
&) Normal
O Orientation  aprés ls trajectoire
) Orientation d'apeés Ia trajectoire du plan X,

e Position: Provides the x,y,z coordinates for the object's anchor point. Entering new values redefines the posi-

tion.

e Rotation: Pivots the object along the X, y and z axes.
Shift+click and dragging the cursor restricts the movement to 15° step.

4. Dimensions: for modifying the parameters: length, width, height.

e Click on the checkbox to maintain the proportions. Clicking again removes the restriction.

5. Animation settings

Clicking on 4 locks them and clicking on - unlocks them.

NB: using the Timeline, in a single sequence, the object can change behavior several times.

Object Animation

See " The Timeline Window" page 77
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See "Editing Paths" page 67
See "Animatable Object Parameters" page 187

Vegetation Objects

Available in the media manager "Free VB Visual Plants Samples" Vol. 1 and 2.

VB visual 30 Planks :

Height: 3 1

() Use hebodan date
© Custom date

Coordnates
Position:
X ¥ ]
-2409.69 cm -3247.41 cm 187.40 cm
Rotation:
o o o
T T Y
=/ _/ 2,
Animation parameaters

) Normal

() Orientation on path
O cvientation on path, XY orly @

1. Preview Thumbnail.
Height:

e Using the slider or by entering a value in the field.

3. Transparency:

Used to render a vegetation object with greater or lesser transparency depending on the desired level of trans-
parency. values from 0 to 100. 0 means opaque.

NB: When the slider is at the end, typing a higher numerical value allows the sizes to go beyond the
end. The slider values will be updated accordingly.

4. Representation date:
e Choose: active heliodon date or calendar date.

m  Heliodon date: use the date of the active heliodon
m  Calendar: use the selected date.

5. X,Y, Z Coordinates

e Position: Provides the X,y,z coordinates for the object's anchor point. Entering new values redefines the posi-
tion.

¢ Clicking on ~ " Jocks them and clicking on “ unlocks them.
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e Rotation: Pivots the object along the X, y and z axes.
Shift+click and dragging the cursor restricts the movement to 15° step.

6. Animation settings

NB: using the Timeline, in a single sequence, the object can change behavior several times.

See " The Timeline Window" page 77
See "Working with Object Animations in 2D View" page 67
See "Animatable Object Parameters" page 187

Animated Character Objects

errg

Available in the Media Catalog: Exterior, Furniture, Transport... |

183.58

— : @
i} 0!
1

Shader ——| CMan0DI6 v .
Reflection: 0.

(6)
P )
8)

M color:
Coordniates
)
X ¥ i)
-1519.66 om 114426 cm 479,32 ag
e
) Crientation on path

(=) Orientation on path, XY only

1. Preview Thumbnail.
2. Rotation:

e Pivot the object on itself or enter a numerical value.
Shift +click dragged using the cursor limits the movement to a step of 15°.

3. Height:

e Using the slider or by entering a value in the field.

NB: When the slider is at the end, typing a higher numerical value allows the sizes to go beyond the end. The
slider values will be updated accordingly.
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4. Color:

e Use the menu to choose the clothing color.

Behavior

5. Behavior: Use the menu to choose the character's attitude: standing, sitting, running, etc.

Shader:
6. Shader
e Select the material to be edited from the list.
7. Reflection, Shininess, Bump:

e Reflection: drag the slider. When the diode is red, the texture reflects its environment. Double click on the red
diode to cancel the effect.

e Shininess: drag the slider to make the material become bright or enter a value in the related field.

e Bump: drag the slider to apply bump to materials or enter a value in the related field. Click on the red diode to
cancel the effect.

8. Mix Color:

e Check and click on the selector to choose a color.

Coordinates
9. X,Y,Z Coordinates

e Position: Provides the X,y,z coordinates for the object's anchor point. Entering new values redefines the posi-
tion.

Clicking on * 1 Jocks them and clicking on “ unlocks them.

Object Animation

See " The Timeline Window" page 77
See "Editing Paths" page 67
See "Animatable Object Parameters" page 187

Instanced Object

Principle: 2 objects: one table, one vase. The vase is placed on the table. If the table is moved, the vase follows the
movement

Instancing an Object

@ l =+ ()
| Name
| wScene
canap.1
wTable-2_1
larmpe_1

B tapis_1

Using drag and drop:
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e In Preview to another object
e In the list to the name of an object.
e In the list, the instanced object is shown off-center to the right under the reference object.

Delete a Dependency

e Drag and drop the dependant object to the "Model" name at the top of the list.

NB: the level of instances is unlimited.
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The Heliodons Inspector

Manages the calculations for sunshine according to the position of the sun, determined by the place, time and type of
sunshine. One heliodon may be associated with one or more viewpoints.

In this chapter you will learn about the following subjects:

City EdtOr. . . e 143

The Heliodons LSt . . . e 143

Advanced Heliodon Parameters. - . . . .. 144
El

— | Heliodons List: for handling heliodons on the list shown.

'@
@ @locaton  OiMancad (146

San Francisco ~ NP

01/10/2006 |5
110

7 @m’@
SR WP

Py

s °
1) m.:@
O
[Hcouds
Crrus

-
} s0

_ Susus
- 20

Cumuss

3 60
Crrocumaius
n oo Mm&km@

Sunlight:

1. Projection of the Sun's rays: Location, Manual or 45°.
e Location: Select a city from the local menu.

2. City editor: edits the list of cities

Set date and time:
o cither by clicking the arrows, editing the date dd/mm/yyyy and time hh:ss, or by moving the associated sliders.
4. Sunlight Power:

e Move the slider or type in a percentage value in the field. Clicking on the red diode resets the power to its initial
value.

5. Color Filter:

e Click on the color box to modify the color of the light coming from the sky. All elements in the scene receiving
projected light will be tinted with this color.

NB: Does not tint the sky.
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6. Shadows:
e The heliodon can cast shadows.The slider enables you to vary the shadows from hard to soft.

Light from the sky:

7. Power of light from the sky:

e Move the slider or type in a percentage value in the field. Clicking on the red diode resets the power to its initial
value.

8. Color Filter:

e Click on the color box to modify the color of the light coming from the sky.

NB :tints the sky and the elements in the scene.

Clouds:
9. 4 types of cloud Cirrus, Stratus, Cumulus, Cirrocumulus.

e Move the slider or type a value into the numeric field to vary the size of the clouds.

10. Cloud distribution:

® Clickon " to vary the distribution of the clouds or enter a value in the numeric field.

11. Clouds mask sun:
e If'the box is checked, the sun remains behind the clouds. The sun rays will not be projected.

12. Click to open the Advanced Parameters dialog: pollution, halos, fog.

NB: clouds are visible in the current view if the 3D Sky option is set in the Viewpoints inspector.
Background

Helisdon Sy 18]

City Editor
Heliodon List

Advanced heliodon settings

NB: editing the scene information such as the infinite ground, movement of the origin, redimensioning of
the model and the coordinates may be accessed via the Window menu.

Heliodon Animation

See " The Timeline Window" page 77
See "Animatable Heliodon Parameters" page 186
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City Editor

.| San Franciscn

132 ) East
i) () \wWhast

- |3y (& Horth
z ) South

THS3
Sari Disg B Drapbight savings

o — (LCoee ]

World Map

e The chosen city is circled in red. Clicking on the map points to the closest city.

m  Add creates a "New City":
=  Double click on "New City" to rename it. Adjust the longitude and latitude parameters.

NB: Alt+click to edit the longitude and latitude of the current city.
The mouse wheel provides dynamic zoom capability.

e Delete deletes a city
City

e Lists all cities. Clicking on a name selects this city and the position is instantaneously effective on the world
map.

Longitude and latitude

e Geographic position of the current city.
GMT
e Time difference (Greenwich Mean Time).

+ 1 in summer

The Heliodons List
c

| opens the heliodons list. Double-click on the desired name to change it.
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Narme
Hellodon 12/01

Helisdan 20/06
Heliadan 20/ 10

L 3
R adds a heliodon, p? deletes the selected heliodon.

The heliodons are classified alphabetically, clicking on "Name" at the top of the list modifies the alphabetical order of
the classification.

e Right-clicking on a heliodon displays the contextual menu:

Delete

Deactivate for Current View
Edit View Using This Heliodon
Activate View Using This Heliedon

v

Delete: The heliodon is removed from the list.

Activate for theCurrent View: Activates the heliodon for the current view (Name in bold).

Deactivate for Current View: Deactivates the heliodon for the current view.

Edit View Using This Heliodon: to choose a viewpoint, the inspector switches to Perspectives or Parallel
views, Panoramas, VR Objects or Animations mode.

Activate View Using This Heliodon: displays the chosen viewpoint in the preview window (the inspector
remains in Heliodon mode).

The Cut/Copy/Paste shortcuts are effective for the list.

Advanced Heliodon Parameters

Advanced Heliodon

Sky
) 020
[] Merge Sky Color with ® ——

[#] 5un Lensfiare

@i}@@

Flreg
‘Start Distance @
@Mrﬁm
-
(8-
Animation parameters 1
[“Iwind W rJE @
5
Poner 1) 1

Sky:

1. Pollution factor:
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e Move the slider or type in a percentage value in the field.
2. Merge Sky Color With:

e Check the box to activate/deactivate the effect. Click the colored box to choose a color. The color is mixed with
the calculated sky color.

3. Luminous halo:

e Check the box to activate/deactivate the effect.
e Choose effect: Click on one of the 4 thumbnails.

4. Halo Power:
e Move the Power slider or type in a value between 0 and 100%.
Fog: set fog parameters

e Check the box to activate/deactivate the effect.

[Fog

Visibdty distance

3 Z500.00
Alttude

3 300,00
Cokor

5. Starting distance: click ' * | then, in the Preview window, click on the point from which the fog will be able to
be perceived, or enter a numeric value in the field.

Visibility distance: visibility distance begins at the starting distance. It provides the fog with a volumetric effect.

Altitude: Altitude takes effect from bottom to top. It depends upon the starting distance and the visibility dis-
tance.

8. Color: for assigning a color to the fog.

Animation settings:
used to animate the movement of the wind along with its direction.

9. Wind

e Check the box to activate/deactivate the effect.
e Movement speed values go from 0 to 100.
e The direction is specified using the circular slider, direction being relative to project North (see 2D view).

NB: effect only in Artlantis Studio in animation mode
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The Lights Inspector

Edit lighting schemes based on viewpoints. Interactive settings and immediate results in the Preview window. Using
the appropriate and correctly adjusted light model promotes the work carried out on the materials. Light groups may
be attached to 1 or more viewpoints. The lights are characterized by an illumination limit and a maximum illumination
area.

In this chapter you will learn about the following subjects:

List of Laghts . . e 148

=l
| Lights List: for handling lights on the list shown.

Lighting

Lighting
@ @-O
Power: S00.00
Akbenuation: = 0,00 am @

4 ¥ 2z

651,56 am || -1212.72 om A44. 38 cm
L ]

Target on: | On Ficed Vertex
651,56 cm || -1212.72em | 234 @
[
Lo

1. Select projection type
determines the lighting projection (falloff) from 9 predefined types
2. On/Off
3. Color:
Double click to modify the source color.
4. Source power
Values from 1 to 1,000,000. Move the slider to change the power or enter a value.
5. Attenuation Distance
Calculates the attenuation distance for the lighting power.
Between the attenuation distance and source, the lighting power remains constant and at maximum.

The distance beyond distance A corresponds to the gradual diminishing of lighting power at 1/d>. When the
attenuation value equals 0, the light diminishes at 1/ d* beginning at the light source.

Enter the distance in the numerical field (current unit).

NB: in this area, the illumination principle is based on reality. The closer an object is placed to the
light source, the more illuminated it appears.

6. Change the Lighting Angle:
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By sliding from 10 to 360° or by typing in a numerical value.
Example: A value of 360° provides an omnidirectional light.
7. Shadow projection
Activate/Deactivate shadow projection: Click on the box to check it.
8. Shadow type

Sharpness slider on the edge of the illuminated area. Values from 0 (diffuse area between the shadow area
and the illuminated area) to 100 (straight limit). Accepts a numerical value.

9. Luminous halo:
Activate/Deactivate: Click on the box to check it.

Choose effect: Click on one of the thumbnails: - e
Halo Power: Move the Power slider or type in a value between 10 and 200%.
10. X, Y, Z Coordinates: of the position of the light source and its target.

Clicking on ~ " Jocks them and clickingon " unlocks them.
Activated target: choose between target on a fixed vertex or on an object defined as target.

NB: editing the scene information such as the infinite ground, movement of the origin, redimensioning of
the model and the coordinates may be accessed via the Window menu.

Animations:

See "Editing Paths" page 60

See " The Timeline Window" page 77

See " General Preview Display Shortcuts'" page 201
See "Animatable Light Parameters" page 187

List of Lights

-

opens the list of light groups.

= Lumbire_Cuksine
Lum_Culs_1
Lum_Cuis_g2
Lum_Cuis_3

= Eclsirage traval
Lusreérn

% Trawal

e Double-click on the name of a group or a light to edit the name.
e Moving a light from a group to another group is done by dragging and dropping.

= ladds a light group,
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[ ]
El adds a light at the current camera position if a group is selected. Duplicate the light if a light is selected..

« O

deletes the selected light or group.
Light Group Pop-up Menu:

e Right-clicking on the name of the group displays the contextual menu:

Dot

Ackivabe For Cument View

Edit ¥iew Lising This Light Group

Paste : Pastes the clipboard contents
Delete: removes the selected elements.
Activate/Deactivate for Current View: the group takes part or otherwise in the lighting of the current view.

Edit View Using This Light Group: Choose the view point, the inspector switches to Perspectives or Par-
allel views, Panoramas, VR Objects or Animations.

Light Pop-up Menu:
e Right-clicking on the name of the light displays the contextual menu:

Turn OFf
Cugplicate

Cut
Copt
Dwlste

Edit Visww Ui This Light »

Activate/Turn off: the light

Duplicate: Creates a light identical to the current light.
Cut: The cut light is stored in the clipboard.

Copy: The copied light is stored in the clipboard.
Delete: Removes the selected lights.

Edit View Using This Light : Choose a viewpoint from the list. The chosen viewpoint is displayed in the pre-
view window.The inspector switches to Perspectives, Parallel views, Panoramas, VR Objects or
Animations mode accordingly.
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Selection and multiple editing of lights:

Plafond_3 x| LightList
o
= = Lumiere_Salon
[Elonjoff  Color: &
Power: s = Lumiitre_Cuisine
I Attenustian: 0.00¢m
= Edisrage traval
[ Ange 3600 Lisribew
4 =i # Travad
g g
=
[E] Lensfiars
Coordinates
x ¥: z
-
Target on: | On Freed Verbax -

The Cut/Copy/Paste shortcuts are effective for the list.

To instantaneously assign a setting to several sources.

Select the sources by using:

Ctrl click for a discrete selection. Shifi click for a continuous selection.

The multiple selection is represented by hatching icons as well as dots in the numerical fields.
Change a parameter, it will be changed for all selected lights.
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In the Perspectives inspector , Insertion enables the user to position a camera precisely vis-a-vis a model or photo.
Position a background image before using this command.

In this chapter you will learn about the following subjects:

Step 1 - Setting the Axis Markers in the 2D View.
Step 2 - Setting the Tag in the Preview Window. .. ... ... ... . . .. .. ...... 152
Step 3 - Running the Insertion Calculation

Opening the insertion command

[ [ » |mo [§]

‘t<: caby {t\

® ex cy 2

Use mouss wheel or amow
“J\ Rerys b zoom inor out

[ 5howe 30 model

Calculats insertion Start

® (Click on

e The insertion dialog enables you to define the focal distance of the image, gives you the option of adjusting the
axes, and allows you to choose the reference axis, display the model and run/stop the calculation.

NB: When opening the dialog, the model from the preview window is hidden. The background image
remains, with a marker for the axes, which appear in red, green and blue.

Insertion is carried out in 2 steps: placement of a trihedron into the 2D view and into the Preview window.

Step 1 - Setting the Axis Markers in the 2D View

Setting the orthonormal marker on the geometry is performed in 2 steps in top view and in another view. If needed, in
the top view, pivoting one of the red or green axes will rotate the marker on the origin.
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10,

@
) @
@

+
¥

The changes made to the axes in 2D View are not updated in the Preview window. This is why we must also set the
marker in this window. See step 2.
Step 2 - Setting the Tag in the Preview Window

[eoe Supermarket Startatl o]
i W) = B =

Place the origin of the axis marker on the photo, then pivot the red, green and blue axes one by one.

NB: Make sure that the positions of the axes in 2D View and Preview do not conflict.

In the insertion dialog: Depending on the placement of the axes in preview, choose one of the following two view-
ing options:

‘ [X]

The Y axis moves away from ~or towards (| the camera.

. . e p . .. . .
Determine the axis ® that will serve as a reference for sizing the 3D model in relation to the back-

ground image. Then, in the Preview window, adjust the size to the model by moving the yellow handle m Do
the same in 2D View.

In the Preview Window: The magnifying glass helps you place the axis marker precisely on the background image.

To activate the magnifying glass, turn the mouse wheel. Each incrementation increases the zoom from 2x up to a max-
imum of 8x.
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‘808 Supermarket Final.atl =

] A ] k2

Délai du dernier renduZ. 7dsec.

Step 3 - Running the Insertion Calculation

C)

In the insertion dialog, check @ Show 3D Model . The model displays in Preview, and then launch caiculer | At any
time, the axes can be modified in real time in the Preview and 2D View windows. If the setting appears incorrect,

o] | 13 o [§]

modify the value of the camera focus
it directly into the appropriate field.

sop stops the calculation.

, adjust the slider or, if you know the value, re-enter

LX) Supermarket Finalatl =)
v 2 a 28 = [

Délai du dernier renduz. 74sec.

NB: in order to avoid any inadvertent modification, when the insertion dialog is closed, the view locks auto-
matically.

To unlock it in the Perspectives inspector, open Coordinates, then click on the padlock &

To restart from the beginning, use the Cancel button.
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Post-Production Effect Filters

Enables the user to apply effect filters to the current view:

e The effects are added among them, as well as to the parameters set in the viewpoint inspectors.
e The Post-Production effects are "viewpoint dependent". Their settings do not affect other viewpoints.

e The check boxes activate/deactivate the effects.

In this chapter you will learn about the following subjects:

Examples of Effects in Post-Production.

| [mane Satkings
Contrast
e o
J 1]
Brightness
1. ¥ L)
7 0
Saburation
0o o L)
3 0
[5] me oo |
[FlEposre
= Exposure £
E == :
2 <0
[#) Grain
* Brightness
» 4
mﬁ = @
[Fledge and Pastel
Edge intensity
I 50
A Transparency @
Nmadcffeu
=i
m
Appl,-Defus
Lo |

1. Image settings
Use the sliders or enter numeric values to set Contrast, Brightness and Saturation. Values from -100 to

100.

Clicking on the red diode cancels the effect.
The Mix Color box enables you to select a tint mix from the color picker, which will cover the entire image.

2. Exposure

Exposure: Determines the amount of light that enters the camera.

Size: Fluffs the effect to a greater or lesser extent.

Values from 0 to 100 for these two settings.

3. Grain:

Brightess: Gives the image a granular appearance.
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Size: Determines the size of the grains.
Values from 0 to 100 for these two settings.

4. Edge and pastel
Provides a photorealistic rendering mixed with crayon, or a completely crayoned rendering.
Edge intensity: Marks more or less the weight of the lines that determine the geometry contours.

Transparency: More or less masks the geometry while retaining the intensity of the contour and the pastel
effect.

Pastel Effect: Provides a crayoned rendering effect.
Values from 0 to 100 for these three settings.
Validate or cancel these settings to close the dialog again.
5. Saved settings
Define as default/Default settings/Apply to all perspective viewpoints :

Respectively allow the user to revisit Artlantis initial settings, to define current settings as the default or prop-
agate these settings to all other perspectives.

NB: Post-production effects are immediately visible in the Preview window.

When rendering, Artlantis always calculates in photorealistic rendering and applies the filters when the calculation is
finished.

Examples of Renderings

Examples of Effects in Post-Production
The effects can combine together to provide extremely rich variety.

o

Starting Photorealistic render

-

Desaturation Contrast brightness and saturation
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Contrast brightness and saturation Contour and pastel

-

Exposure Grain
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Grain exposure contour and transparency Contour with no transparency
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Rendering

In this chapter you will learn about the following subjects:

Perspective Rendering Parameters. . . ... ... ... 159
Viewpoint rendering settings in Expert mode in the ""Photorealistic" engine. .. ... . . ... ... ... ..... 160
ReNdeer. . .. 163
Rendering Animations. . . ... 163
Artlantis Batch Render. . .. .. i 164
The Batch Rendering Window. . ... ... . e 165
The Partial Rendering Window. . . .. ... e, 166
Parallel View Rendering Settings. . .. . .. ... . 167
Panorama Rendering Settings. . . ... ... 168
VR Object Rendering Settings. . ... . ... . .. 169
Animation Rendering Settings. .. ... .. .. ... 171

Perspective Rendering Parameters

Accessible by:

® C(Clicking the icon: % lavailable in the Perspectives inspector: The set values determine the rendering and dis-
play in the Preview window.

Perspective View Rendering El
Rendsring size: v
width: | 2000
Height: | 1332 —
Resolgtion: | 72 dpd

Printing wadth: | 70,56 om
Prinking hesght: | 46,99 am

[#] anti-skasing  High @
[Flradsty
Accuracy: | High @

Lighting: | Custom v

[ Set a5 Defauks ]
@ [ Apply Defauks |
I

Apply to .l views ]

(ot [ come ]

1. Display of rendering options for the "realistic photo'" engine in the current mode
Rendering size
Print Resolution for Perspective View

2. Anti-aliasing

Anti-aliasing: anti-aliasing Normal / High.
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Tip: to save calculation time, select a low value while increasing the Width/Height of the rendering.

3. Radiosity

The calculation times depend on the value chosen.

This menu allows you to set the precision parameters with predefined values. I you change the values with the sliders
or the text fields, the menu will be set to custom.

Precision : Normal / Average / High / Custom .
Lighting : Interior / Exterior / Custom.

NB: these settings have a very strong influence on the rendering time.

Tip: Calculate small-sized images or use the Batch Rendering command.

4. Application settings

Define as default / Default settings / Apply to all viewpoints for the selected inspector :

Respectively allow the user to define current settings as the default, to use the default settings or propagate these set-
tings to all other views for the inspector concerned.

NB: the display of options in expert mode is activated in the Preferences.dialog.

Viewpoint rendering settings in Expert mode in the "Photorealistic'" engine

® Click the icon: ¥ available in the viewpoint and animation inspectors. The set values determine the rendering
and displaying in the Preview window.

NB: the display of options in expert mode is activated in the Preferences dialog.
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Perspective View Rendering gl
Rendering size: | EEnC I ~
width: | 2000
Haight: | 1332 =
Resolution: | 72 dpd

Printing wadth: | 70.56 om

Prinking hasght: | 46,99 om

[#ltriti-shasing | High

Accuracy:  High

0
®

96 8
Long ranga: J 32,00
1] 48
Shost rangs: 1) 32,00
Lighting: | Custem w
1 16
First bounce: ] 1,50
¥ 16
Mext bounces: ] 1.50
1
ARESrIEEION: J 0,90
L1} 1
Coolicr blesding: J 0,70
| Set a5 Defaults ]
@ [ Apply Defauts |
[ appitosl views |

1. Display of options in standard mode
Rendering size

Print Resolution for Perspective View
2. Anti-aliasing

Anti-aliasing: Anti-aliasing Low/High.

Tip: To save calculation time, select a low value while increasing the Width/Height of the rendering.

3. Radiosity

The calculation times depend on the value chosen.

This menu allows you to set the precision parameters with predefined values. I you change the values with the sliders
or the text fields, the menu will be set to custom.

Precision: Normal/Average/High/Custom.

NB: these settings have a very strong influence on the rendering time.

Tip: Calculate small-sized images or use the Batch Rendering command.
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o Widened oversampling: Values from 96 to 8 pixels.

The radiosity is calculated over a small number of pixels, the others are extrapolated. This distance represents
the mean distance in pixels between two points where radiosity is calculated. The lower the distance, the
more the density of calculated pixels increases.

NB: these settings have a very strong influence on the rendering time.

e Reduced oversampling: Values from 0 to 48 pixels.

This is the radiosity from near surfaces (e.g. the corner between 2 walls). This requires special processing
enabling shadow quality to be refined. The value selected represents the processing range. If 0, no calculation
is carried out. The larger the value, the better will be the calculation of shadows with regard to radiosity.

NB: these settings have a strong influence on the rendering time.

Lighting: Interior/Exterior/Custom.

These settings affect the general ambient lighting for the scene. They are used to precisely control how the scene is
exhibited.

The predefined settings Interior/Exterior give default lighting settings depending on the space chosen.

The Custom setting is used for when the user opens a file prior to version 3 of Artlantis or when the lighting values
have been changed in expert mode.

NB: these parameters do not affect the calculation times.

Lighting power:

e First rebound: values from 1 to 16.

Controls the radiosity power of the first rebound (affects all surfaces receiving direct light from a heliodon or
light sources).

o Next rebounds: values from 1 to 16.
Controls the radiosity power of all rebounds after the first. This affects surfaces receiving indirect light.
Increasing the number of rebounds gives more light, particularly for interior scenes.

e Attenuation: values from 0 to 1.

Controls absorption of light after one or more surface rebounds. A low value increases the contrast of the
scene thus allowing strong shadows to be cast in an interior scene lit by indirect lighting.

NB: this parameter has almost no effect on exterior scenes.

e Color transfer: values from 0 to 1.
Controls the transfer of colors between surfaces.
Reducing the value desaturates the colors.

4. Application settings

e Define as default/Default settings/Apply to all perspective viewpoints:

Respectively allow the user to define current settings as the default, to use the default settings or propagate
these settings to all other views for the inspector concerned.
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Render

Inspector Menu > Render

W e | v

« Savesstps | JPEG " gl v [Rendes Later|

My Network ’E
Cancel

Specify the name, destination of the file and format in the dialog box: JPEG*, BMP*, TGA, PICT, TIFF, Piranesi,
Photoshop**.

NB: * formats that do use the alpha channel. ** Photoshop PSD multi-layer format.

. Clicking on Options... opens the Rendering Parameters dialog.

° Render Now: Opens the rendering window, then displays the rendering progress and the estimated and
elapsed computation times. To stop the rendering click on the close box of the window.

. Render later:
Postpones the rendering of the current viewpoint, the document is automatically saved. Rendering will be

done using Artlantis Batch Render.

NB: Batch renderings are managed later in the Inspector menu > Batch renderings.... They are processed
by Artlantis Batch Render.

Rendering Animations

Inspector Menu > Render

File name: Sequence e Piicee Now.
Save az lype: Quacktime Movie: [ mov| Byl Hendes me
Compresson: 5o v
Min Ma; Cancel
Qualty 1
Format:

e Specify the name, destination of the file and format in the dialog box: MOV, JPG, TGA

Gacklime Movie " mov] -
Quackline boae [ oy

JPEG Fiet " gl
Tauga Fies ["1ga)

Compression Parameters:

e Choose a Codec and a compression quality.
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Pan RYVE

Inked Irdeo Video 4.4
Sorerson Yideo
Sorerson Video 3
BMP

H. 264

s 1

D DVCPRO - NTSC
IO - PAL
IDWCPR - PAL
H.261

H. 263

Photo - PEG
FPEG 2000
Animation JPEG &
Animation PEG B
PG

Lana

Ak ion

Wido

3 aphigue

Tz,

TIFF

Composant vido

Quality:

e Choose a compression rate:

Min M
CQualty

For low compression, move the slide to the left. For high compression, move it to the right.

e Clicking on Options... opens the Rendering Parameters dialog.

e Render opens the rendering window
Shows the progress and the estimated and elapsed time of calculation. Work on the project cannot continue par-

allel to the renderings.

e Postponed rendering saves the document.
Postpones the rendering of the current animation.

Stop Rendering in Progress.
Click on the "Close" box.

NB: Batch renderings are managed later in the Inspector menu > Batch renderings.... . They are proc-
essed by Artlantis Batch Render.

Artlantis Batch Render

Artlantis Batch Render is an application that is independent of Artlantis. It launches the Artlantis batch renderings
calculation.

As soon as it is launched, Artlantis Batch Render starts the renderings on standby.

The dialog box makes it possible to track the progress of the listed renderings.Each rendering displays a small prog-
ress image (1). A report (2) provides details on:

e The location of the document and the image calculated on the disk.
e The size of each image and the time it took to render.

e Potential problems with the location of textures, Shaders, etc.Quit
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Artlantis Batch Render 3]s )

Autlantis Baich Render
vaoniz

Hit F1 to display Help

Custent rerdesing. |

Totak

Batch fle containg 31 document(s] including 29 to

compute
Loading Document: C:AD ocuments and Setfings\al Users\Documents\ARCHIVE-LOFT 1\Lolt_Stat2A\Lolt_Start22 o

(o= ]

Quit
e The Quit button closes the application, even if a calculation is in progress. The interrupted calculation infor-

mation remains in the batch render document (BatchRendererDocument.xml). Relaunching Artlantis Batch
Render will restart where it was stopped.

Pause

e Stops the image calculation in progress.

Resume

e Resumes the currently paused image calculation.

The Batch Rendering Window

All batch renders are processed by the "Artlantis Batch Render" application.

Inspector Menu > Batch Rendering.

The Artlantis rendering manager displays the list of items that are to be processed.

Toolbars

)

Deletes the selected view

—— Mark the selected view as needed to be calculated, even if it has already been rendered.
e [ndexed: names of renderings with the same name will be indexed numerically
or
e Replaced: the name of a render with the same name will replace the existing file.

Indexed
Imag

Add all views . . .
* T of the current project to the list of views that need to be rendered.

e Destination: the destination of the rendering file can be redefined by clicking on the Folder button.
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e [mage type: to redefine the rendering image format: JPEG, BMP, TGA, PICT, TIFF, Photoshop, Piranesi or
movie formats.

Viewpoints List:
e Check the box opposite the name of the image in the list. This image will be rendered later.

m  Document name: the name of the atl file
m  View Name: The name of the viewpoint

m  Kind: type of viewpoint; Perspective, Parallel, Panorama, Animation, VR object.

Diodes: color codes
Diode Status Comments

Gray Not rendered yet Waiting for processing by Artlantis Batch Render if the box is
checked.

Green Rendered

Orange  Error during rendering Check the information at the bottom of the Batch Rendering window
Red Not rendered due to one or more Check the information at the bottom of the Batch Rendering window
errors

% Batch Rendering

.Imq)e Calculated : \WDOCFLARE \DocFlane\Flat\PANORAMA 0.mov

Destinaion ] \DOCFLARE\DocFlarstFla

Image type: | Quicktime Mowi |+ Image name: | Index mage w
Flag State Diocument name = View Name: Kind of view
(v Flat_Stat atf PANDRAMA O PANDRAMA
= Flal_Stast alf Sequence ANIMATIO
= Flat_Stast i VAOBJECTO VR DRJECT
o] Flat_Stat al View 0 VIEWFOINT
] Flab_Stait at View 0] VIEWFOINT
= Flat_Stait il Ve paraliele PARALLEL

The Partial Rendering Window
Calculates part of the content of the Preview window.
Inspector Menu > Partial Render
1. Draw a rectangle in the Preview Window. The Render window showing the progress is displayed.
‘e080 < Island_Final-4.atl =)

® Pazae] B B @ H B =

Last rendering time: 2.14s¢<.

2. Defining the rectangle

Page - 166



Rendering - Parallel View Rendering Settings

3. Render window showing the progress of the calculation.

Parallel View Rendering Settings

Accessible by:

® Clicking the icon: © *¥ available in the Parallel Views inspector. The set values determine the rendering and

displaying in the Preview window.

Parallel Yiew Rendering E

Renderingsoe: TN

Width: | 320 [x]
Height:: | 240 :'

Reschtion: | 72 e
Scale: 1} | 306

[#] anti-abesing | Low @

[#] radiosity

Atirec e

Lighting: | Custom

[ Set a5 Defaults I
Ol=—=

|

apphy to all views ]

(o J( conn ]

1. Display of rendering options for the "realistic photo'" engine in the current mode

Same parameters as for rendering Perspectives, except for printing.

Rendering size

Print Resolution for Parallel View

2. Anti-aliasing

Anti-aliasing: anti-aliasing Normal / High.
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Tip: to save calculation time, select a low value while increasing the Width/Height of the rendering.

3. Radiosity

The calculation times depend on the value chosen.
This menu allows you to set the precision parameters with predefined values. I you change the values with the sliders
or the text fields, the menu will be set to custom.

Precision : Normal / Average / High / Custom .
Lighting : Interior / Exterior / Custom.

NB: these settings have a very strong influence on the rendering time.

Tip: Calculate small-sized images or use the Batch Rendering command.

4. Application settings

Define as default / Default settings / Apply to all viewpoints for the selected inspector :

Respectively allow the user to define current settings as the default, to use the default settings or propagate these set-
tings to all other views for the inspector concerned.

NB: the display of options in expert mode is activated in the Preferences.dialog.

Panorama Rendering Settings

Accessible by:

® Click the icon: - * 'available in the Panorama inspector. The set values determine the rendering and display in
the Preview window.

Panorama Rendering EF

Rendering size: | R IR

OJim:

Resolution: |Medus
[l anti-abiasing | Lows

[l Radesity
ACCuraty: | hoemnal @

Lighting: | Cushom

[ Set as Defaults ]
@ [ Apply Dsfads
I

Apply to ol views

(o J [coneel ]

—
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1. Display of rendering options for the "realistic photo'" engine in the current mode
Rendering size
Resolution of rendered image

2. Anti-aliasing

Anti-aliasing: anti-aliasing Normal / High.

Tip: to save calculation time, select a low value while increasing the Width/Height of the rendering.

3. Radiosity

The calculation times depend on the value chosen.

This menu allows you to set the precision parameters with predefined values. I you change the values with the sliders
or the text fields, the menu will be set to custom.

Precision : Normal / Average / High / Custom .
Lighting : Interior / Exterior / Custom.

NB: these settings have a very strong influence on the rendering time.

Tip: Calculate small-sized images or use the Batch Rendering command.

4. Application settings

Define as default / Default settings / Apply to all viewpoints for the selected inspector :

Respectively allow the user to define current settings as the default, to use the default settings or propagate these set-
tings to all other views for the inspector concerned.

NB: the display of options in expert mode is activated in the Preferences.dialog.

VR Object Rendering Settings

Accessible by:

® Click the icon: * # !available in the VR Object inspector: The set values determine the rendering and display
in the Preview window.
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Panorama Rendering EF
Rendering size; | STt I

Ok==1-

Resolution: | Medus

[¥] nti-abiasing | Lews @

[ Raduosity
Actursty: | Hormal @
Lighting: | Custeen
[ St s Defauks ]
@E=
[ sociytoal views |

ok | [ cancal_

1. Display of rendering options for the "realistic photo' engine in the current mode

Rendering size

Number of images: Information on the number of images to be rendered to make up the VR objects depending on ver-
tical and horizontal step.

2. Anti-aliasing

Anti-aliasing: anti-aliasing Normal / High.

Tip: to save calculation time, select a low value while increasing the Width/Height of the rendering.

3. Radiosity

The calculation times depend on the value chosen.

This menu allows you to set the precision parameters with predefined values. I you change the values with the sliders
or the text fields, the menu will be set to custom.

Precision : Normal / Average / High / Custom .
Lighting : Interior / Exterior / Custom.

NB: these settings have a very strong influence on the rendering time.

Tip: Calculate small-sized images or use the Batch Rendering command.

4. Application settings

Define as default / Default settings / Apply to all viewpoints for the selected inspector :

Respectively allow the user to define current settings as the default, to use the default settings or propagate these set-
tings to all other views for the inspector concerned.

NB: the display of options in expert mode is activated in the Preferences.dialog.
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Animation Rendering Settings

Accessible by:

® Click the icon: - # | available in the Animations inspector. The set values determine the rendering and display
in the Preview window.

Animation Rendering E'-
Rendering size: | 1024x 768 PC w
Waidth: | 1024 :lE
Haight: | 768 he
Render from: to [#] el
Humber of images:
[Flacki-sbasing | Low ®
[Flrackosity

Aocuracy: | Hormal
Lighting: | Cuskom
| Sat a2 Defaults ]
[ Apply Defauks |
| Apply to all views ]

Lo J[ ool ]

1. Display of rendering options for the "realistic photo'" engine in the current mode
Film size

. Select a size from the menu or enter the width and height in pixels.

X
Increase/decrease the values by 2 by clicking on the s signs.

Render from X to Y Image. Enter the numbers of the corresponding images to calculate a portion of the sequence.
First Frame is set to 0.

Number of images: Information on the number of images or selected frames to be rendered to make up the animation.

2. Anti-aliasing

Anti-aliasing: anti-aliasing Normal / High.

Tip: to save calculation time, select a low value while increasing the Width/Height of the rendering.

3. Radiosity

The calculation times depend on the value chosen.

This menu allows you to set the precision parameters with predefined values. I you change the values with the sliders
or the text fields, the menu will be set to custom.

Precision : Normal / Average / High / Custom .
Lighting : Interior / Exterior / Custom.
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NB: these settings have a very strong influence on the rendering time.

Tip: Calculate small-sized images or use the Batch Rendering command.

4. Application settings

Define as default / Default settings / Apply to all viewpoints for the selected inspector :

Respectively allow the user to define current settings as the default, to use the default settings or propagate these set-
tings to all other views for the inspector concerned.

NB: the display of options in expert mode is activated in the Preferences.dialog.
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The Panorama Inspector

In this chapter you will learn about the following subjects:

Panorama List.

=]

T [vepthoffed

1 [Fshow [7] activate

Hone
¥ Lurriere_Salon

&% Blue Glass : HeonLight

Coordinstes

1. Panorama

E]

@

i

-

Visible Layers
£F | Scene, 30 Flants, Light objects, n..@

Errvirorenant.
M;m.nd For
20 Image w
®i Y 2
47875 an | 2544.91cm | TOL4: 6

Panorama List: for handling panoramas on the list shown.

5. 070

Focal Length: Changes the focal length when the slider is used or a value is entered in mm or degrees
(adjusts the angular opening of the camera).

Depth of Field: click b then, in the Preview window, click to define the clear point of the scene, with the
rest remaining blurred. The cursor adjusts the blur amount.

Clipping Box: for defining clipping planes.
Show: in 2D View

Activate: Representation in Preview mode

2. Lighting

To handle light schemes linked to the view, select them from the drop-down menus.

Heliodon: links a heliodon to the view. Selecting "None" deactivates the heliodon.

Light Group: Links one or more light groups to the view. Selecting "None" deactivates the light groups.
Neon Shaders: Links one or more Neon Shaders to the view. Selecting "None" deactivates the lighting.

3. Environment

Handles the background and foreground of the scene.

Define a background: Background type: 3D Sky, Gradient, 2D Image, 3D Image, 3D Cubic

Foreground Images

4. Visible layers: check them in the drop-down menu.

5. Coordinates

Camera XY Z Position.

Clicking on
6. Post-production

1 Jocks them and clicking on -

unlocks them.
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Applies effects to the current viewpoint: The effects combine into, as well as with the parameters set in the
inspector.
7. Rendering Settings

Prepares the document for final rendering.

NB: editing the scene information such as the infinite ground, movement of the origin, redi-
mensioning of the model and the coordinates may be accessed via the Window menu.

nrry

Panorama List |

[ | opens the panorama list. Each is displayed by name and preview thumbnail.

PANORAMA 0_1

e To edit, double-click on the name.

S
adds a panorama, E? deletes it.
Panorama Pop-up Menu
e Right-clicking on a view displays the pop-up menu:

Duphcate:
Delete

Add bo Perspective Yiew List
Add to Paralel Yiew List
Add bo VR Object List

A b Seuesnce List

Edit Heliodon
Edit Light C

Duplicate: use the original to create a new superimposed panorama.
Delete: the panorama is removed from the list.

Add to the Perspectives List:

Add to the Parallel Views list:

Add to the VRObject list:
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Add to the Animation list:

Depending on the option selected, adds current view from Panoramas to Perspectives, Parallel Views, VR
Objects or Animations.

Edit light: select a light, the inspector palette switches to Lights mode and the light is selected.
Edit Heliodon: The palette inspector switches to Heliodon mode and the heliodon is selected.
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The VR Objects Inspector

Manages viewpoints defined by a camera, a target and a focal length. Each viewpoint is considered to be an auto-
nomous document with its own parameters which can receive its own environment.

A VR Object view is made up of several images taken from different points in a sphere. A view is defined by a cam-
era that moves in a sphere, a target, the center of the sphere and a focal length, as well as 2 horizontal and vertical
angular movement steps.

In this chapter you will learn about the following subjects:

VR Object LSt . .. e e 178
18]
— VR Object List: for managing VR objects on the list shown.
VR Objects |
Focalin mm
3 6
[¥]Depth of field l—E
T [Elshow [Fadivate [1
Lighting
hone:
| —)
&% | e dlass : Neon Light
Visible Layers
£ | Scerw, 30 Plants, Light objects, l\..@
Errvirorenant
e e e romor e
White .
Coordinates
] t i
478.75¢m | -2544.91 em 791.4
Horiz, Shift Hoeiz. Angle Radus:
o 360 110.00 cm
@)

1. VR object Navigation

VR projection choice: |Hemispherical, Torus, Spherical.

Modifying values in angular horizontal and vertical step degrees.

Number of images: Indicates the number of images that will be needed to calculate the VR objects. This
number is dependent on the values defined for the angular horizontal, vertical steps and the horizontal angle.
Focal Length: Changes the focal length when the slider is used or a value is entered in mm or degrees
(adjusts the angular opening of the camera).

NB: An angular step of 10 degrees provides a good compromise between the number of views
needed (size of the file) and fluidity (vour objects will not be jerky).

Depth of Field: click ' * | then, in the Preview window, click to define the clear point of the scene, with the
rest remaining blurred. The cursor adjusts the blur amount.

Clipping Box: for defining clipping planes.
Show: in 2D View
Activate: Preview Representation
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W

6.

7.

Lighting:

To handle light schemes linked to the view, select them from the drop-down menus.

Heliodon: links a heliodon to the view. Selecting "None" deactivates the heliodon.

Light Group: Links one or more light groups to the view. Selecting "None" deactivates the light groups.
Neon Shaders: Links one or more Neon Shaders to the view. Selecting "None" deactivates the lighting.

Visible layers: check them in the drop-down menu.
Environment:

Handles the background and foreground of the scene.
Defining a background type: 3D Sky, Gradient, 2D Image, 3D Image, 3D Cubic
Foreground Images

Coordinates:
XYZ Position of Center of VR

Clicking on 1" Jocks them and clicking on “ unlocks them.

Horizontal Constraint: According to the trigonometric circle, turns the opening point of the VR object. Enter
a value in degrees.

Horizontal Angle: For restricting the opening angle. Enter a value in degrees.

Radius: the radius of the VR.

Post-Production:

Applies effects to the current viewpoint: The effects combine into, as well as with the parameters set in the
inspector.

Rendering Parameters:

Prepares the document for final rendering.

NB: editing the scene information such as the infinite ground, movement of the origin, redimensioning of the

model and the coordinates may be accessed via the Window menu.

VR Object List |

|1—

opens the viewpoint list. Each is displayed by name and preview thumbnail.

& &

Name

e Double click on a name to edit it.
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&

VR Object Pop-up Menu

adds a viewpoint, ‘ﬁ deletes it.

e Right-clicking on a view displays the pop-up menu:
Cupicate
Delete

Add bo Perspective Yisw List
Add bo Paralel Wiew List
Add bo Panorams List

B by Sepesnace List

Edit Heliodon
Edit Light b

Duplicate: Uses the original to create a new superimposed viewpoint.
Delete: The viewpoint is removed from the list.

Add toPerspectives list

Add to the Parallel Views List

Add to Panoramas List

Add to the Animations list

Depending on option selected, adds current view from Perspectives to Parallel Views, Panoramas, or
Animations.

Edit light: Choose a light. The inspector palette switches to Lights mode, and the light is selected.
Edit Heliodon: The palette inspector switches to Heliodon mode and the heliodon is selected.
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The Animation Inspector

Animations: General Information
A sequence is defined by a camera: A viewpoint, an aim point and a focus distance.
Each sequence is considered as an individual document with its own parameters:

In this chapter you will learn about the following subjects:

General Animation Information. . . .. 182
SeQUEIICE. . . . . e 182
Real Time Display:. . . ... . e 183
Elements that can be animated. . . .. .. 183

AnImation LaSt _ e 183

Animation coordinates. . . ... 184

Animatable Camera Parameters. . ... ... . ... 185
What can be animated. . . .. 185
What cannot be animated. . .. ... 185

Animatable Heliodon Parameters. _ . ... ... . ... 186
What can be animated. . . ... 186
What cannot be animated. . i 186

Animatable Light Parameters. . ... ... ... 187
What can be animated. .. . ... 187
What cannot be animated. . . ... 187

Animatable Object Parameters. ... . ... ... 187
What can be animated. . . ... 187
What cannot be animated. . .. ... 188

El

| Animation List: for managing animations on the list shown.

Fols fi
1 ]
[Z]Depth of field —
| 9

1 [Fshow [ activate ot

£ | Scens, 30 Plants, Light objects, A.. %

Errvirorenant.
Backround _..FBEF?.‘?@
O ==

Target on: | Froed Verbex w
X by 2
-771.30¢m || -1628.25 em 470.55 cm

Camera rol: O
J
x ¥ Z:

478.75¢m || -2544.91 am 79142 cm

o
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1. Animations
Depth of Field: click ' * | then, in the Preview window, click to define the clear point of the scene, with the
rest remaining blurred. The cursor adjusts the blur amount.
Clipping Box: for defining clipping planes.
mn Show: in 2D View
m  Activate: Preview Representation
2. Lighting

To handle light schemes linked to the view, select them from the drop-down menus.

Heliodon: links a heliodon to the view. Selecting "None" deactivates the heliodon.
Light Group: links one or more light groups to the view. Selecting "None" deactivates the light groups.
Neon Shaders: Links one or more Neon Shaders to the view. Selecting "None" deactivates the lighting.
3. Visible layers: check them in the drop-down menu.
4. Environment:
Handles the background and foreground of the scene.
Define a background: Background type: 3D Sky, Gradient, 2D Image, 3D Image, 3D Cubic.
Background type: Foreground Images

5. Coordinates:

6. Post-Production: Applies effects to the current viewpoint: The effects combine into, as well as
with the parameters set in the inspector.

7. Rendering Parameters: Prepares the document for final rendering.

NB: editing the scene information such as the infinite ground, movement of the origin, redimensioning of
the model and the coordinates may be accessed via the Window menu.

See " Working with Camera Animation in 2D View" page 53
See " Working with Light Animation in 2D View" page 60
See "Working with Object Animations in 2D View'" page 67
See " The Timeline Window" page 77

See " General Preview Display Shortcuts" page 201

B
General Animation Information —_|

Animation makes it possible to produce and play a scene made up of one or more sequences.

Sequence

A sequence retraces the camera path in time.

NB: The camera may also be a fixed plane in which object lights, or a heliodon are animated.

The camera path is processed in:

e The Animation Inspector, (animating parameters, focal distance, association to lighting groups, depth of field,
roll, etc).

e The Timeline window, (time management).

e The Preview Window (managing camera targets).

e The 2D View. (Managing paths: cameras, lights, objects).
Animating in a sequence of parameters for other inspectors:

Parameters respectively accessible from:
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The Animation Inspector - Animation List ¥

e Light Inspector*: Illumination configurations
e Heliodon Inspector*: Heliodon configuration

e Object Inspector*: Object configurations
e 2D View: Creating and editing paths for moving cameras, lights and objects.

e Timeline Window: Creating and editing keyframes (changing parameter of an element at a T instant, inter-
polation of parameter changes between two keyframes), synchronizing keyframes of elements that either belong
or do not belong to the same inspector.

< NB: To animate the parameters for light, heliodon and object inspectors, they must first be displayed in

the Animation Inspector before being displayed in the relevant inspector, i.e. light, heliodon, object.

Real Time Display:

e Preview Window: Shows and plays in real time the result of adjustments.

Elements that can be animated

All elements can be animated except for those related to the Shader inspector, or which are listed as not being able to
be animated in:

e Animatable Camera Parameters Sec "Animatable Camera Parameters" page 185

e Animatable Heliodon Parameters See "Animatable Heliodon Parameters" page 186
e Animatable Light Parameters See "Animatable Light Parameters" page 187

e Animatable Object Parameters See "Animatable Object Parameters" page 187

Animation List |

=

opens the sequence list. Each is displayed by name and preview thumbnail.

P

Sequence_1

e To edit, double-click on the name.

* adds a sequence, @ deletes it.
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Animation Pop-up Menu

e Right-clicking on a view displays the pop-up menu:

Cuplicate
Delete

Add b Perspective Yiew List
Aded b Paralel View List
Add bo Panoramas List

A i YR Ot Lish

Edit Heliodon
Ecit Light b

Duplicate: Starting with the current sequence, a sequence is created that takes up the position of the camera
but not the existing path.

Delete: The current sequence is removed from the list.
Add to Perspectives list

Add toParallel Views List:

Add toPanoramas List

Add toVRODbject List

Depending on option selected, adds current view from Perspectives to Parallel Views, Panoramas, or VR
Objects.

Edit Heliodon: The palette inspector switches to Heliodon mode and the heliodon is selected.
Edit light: select a light, the inspector palette switches to Lights mode and the light is selected.

Animation coordinates |

From the viewpoint (Position) and Target of the camera.

Coordinates
X ¥ F
-12.18 m -97.30 m 30.29m
Target on: | Fixed Vertex [
X Y z
-19.32 m =74.35 m 20,38 m
Camera Roll:| 0.00 ;

The Camera Position defines:

e Viewpoint position: Provides the x, y, z coordinates.Entering new values redefines the position.
e Target Position. 2 options:

On a fixed vertex: The camera moves on its path aiming at a fixed vertex in the scene. The fixed vertex is
defined in the Preview window or in 2D View.

Target on: | Fixed Vertex 5
X Y z
-12.17m -97.30 m 028 m
Camera Roll: 0.00]

Orientation following the path : The camera moves tangentially to the path. Horizontal and vertical angles can
be defined relative to this tangent. The Distance provides the distance between the camera and the aim point.

Target on: choose between target on a fixed vertex or on an object defined as target.
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Targer on: | Path
Angle H Angle V Distance

0.00 0.00 1,00 m
CameraRoll:| 0,00 :

NB: Using the Timeline, in a single sequence, the camera can change behavior several times.

e
Animatable Camera Parameters |

What can be animated

From the Camera Inspectors

Editing in

Camera coordinates

Animation Inspectors - Coordinate tab - 2D
View

Target coordinates

Animation Inspectors - Coordinate tab - 2D
View

H target angle relative to the tangent to the
path

Animation inspector - Coordinate tab

V target angle relative to the tangent to the
path

Animation inspector - Coordinate tab

Activated and/or displayed clipping box

Animation Inspectors - Coordinate tab - 2D
View

Modification box

Focus Animation Inspectors - Coordinate tab - 2D
View

Colored background Animations inspector

Depth of Field Animations inspector

Atmosphere Animations inspector

Roll Animations inspector

Settings are available in the Animation Inspector. See "The Animation Inspector " page 181

What cannot be animated

Cameras

Ambient

Changing a heliodon

Changing light groups

Background and foreground images

Changing the Photorealistic/Hatch ren-
dering engine
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s
Animatable Heliodon Parameters |

What can be animated

From the Heliodon inspec- Editing in

tor

Time Heliodon inspector
Date Heliodon inspector
Power of the Sun Heliodon inspector
Celestial illumination Heliodon inspector
Celestial color Heliodon inspector
Color Heliodon inspector
Lens flare Heliodon inspector
Halo type Heliodon inspector
Lens flare power Heliodon inspector

Parameters are available in the Heliodon Inspector. See "The Heliodons Inspector” page 141

What cannot be animated

Heliodons

Cities

Shadows ON/OFF

Shadow type

Contribution to radiosity

Colored sun On/Off

Orientation of North
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Animatable Light Parametersm_fl:

What can be animated

From the Light inspector

Editing in

Status ON/OFF

Light inspector

I1lumination type (omni, spot,

Light inspector

direct.)

Power

Light inspector

Associating a halo

Light inspector

Changing halo

Light inspector

Shadows ON/OFF

Light inspector

Soft shadows

Light inspector

Shadow power

Light inspector

Source coordinates

Light Inspectors - Coordinate tab - 2D
View

Target coordinates

Light Inspectors - Coordinate tab - 2D

View

Spot Opening Angle Light Inspectors - Coordinate tab - 2D
View

Falloff Light Inspectors - Coordinate tab - 2D
View

Soft shadows bias Light Inspectors - Coordinate tab - 2D
View

Distance A Light Inspectors - Coordinate tab - 2D

View

What cannot be animated

Parameters are available in the Light Inspector. See "The Lights Inspector" page 147

Lights

Radiosity contribution

e
Animatable Object Parameters |

What can be animated

From the Object inspec- Editing in

tors

Coordinates Object inspector on the Coordinate
tab

Rotation Object inspector

Dimensions Object inspector
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e For 3D vegetation: Plant sizes, colors, date, etc.

e For Billboards: Size, luminosity, brightness, etc.

Parameters are available in the Object Inspector. See "The Objects Inspector” page 121

What cannot be animated

Objects

Scene coordinates

Scene rotation

Scene dimensions
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Preferences

Artlantis settings enable you to organize the work environment.

In this chapter you will learn about the following subjects:

Preference Settings. .. .. ...

Preference Settings

Artlantis settings enable you to organize the work environment.

Access: Edit Menu > Preferences

Preferences ﬁ'

General
Work units: | Centimalers w

Focalurit: (Ml (Oidagrees
Dkt Iocation: | Madid hd
ViewPoink Lipdate Mode: (T Manual update
(&) Automatic update
[#] Displary expert rendering parameters

Muace prerviews sipe; sm -

[ Automatic Switch to Opsndl
Opeanil
[ Caatrenrs hight
[l gt soarces
[Tiast maripulated Light Shadow
1 30

FFS - +

Final Renderer
Riendering cutput drectary
(%) Document dirsctory
(O Default cutput dractory

Default fl name: | YView Names et
Defaudk e farmat: | PEG v

I

General

General
Workcurits: | Centimeters b

Foclurt: (@mm (O degress
Default location: | Madrid bt

WiswPoirt Updste Made: () Manual update
(%) Automatic update
Ef']prla'.l eccpart pandering paramsters

e Work units: In the drop-down menu choose (mm, m, cm, inches, feet and inches).

o Focal units: select mm or degrees for the viewpoint inspector focus.
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e Default location: In the pop-up menu. The change becomes effective the next time a DWG, DWF, DXF, OBJ
and 3DS file that does not contain any location-related information is opened.

e Manual update mode: concerns the method of updating the positions of the camera, the viewpoint, the roll and
focal length.

In manual update mode, in the viewpoint list, the thumbnails will be updated when the use clicks the
"Update" button, or when a new view is activated.

The thumbnails in the list will not be updated when Shaders, lights or backgrounds are modified.

e Display expert rendering settings: checked, in the viewpoint rendering settings window, enables refinements to
be made using the setting supplements.

Preview

Prigorissw

Max preview size: | 800 w

[] ustcematic Suitch to OpeniL
DRl

[] Camera kght

] &l bght sources

] Last: mnanipulated Light Shadow
1 30
[2 A 4

o Maximum preview size:
Choose the maximum size of the window contents (using the shortcut Control + ). In the pop-up menu (640,
800, 1024, 1200), the value means the size of the preview image displayed in that window.

o Automatic permutation in OpenGL mode: when this box is checked, the display mode switches from pho-

torealistic to OpenGL mode when the camera is moved. Allows the display on small hardware configurations to
be accelerated.

NB: The refresh time of the window is proportional to the size of the display.

e OpenGL Options
The following options affect the Preview window rendering display in OpenGL mode.
o Camera light:

if checked, simulates the white omni-directional light emitted from the camera. The scene is always lit.

NB: This option is independent of the anti-aliasing of the final rendering.

o All light sources:
When checked, OpenGL takes into account all active light sources: lights and sun

NB: The refresh time of Preview slows down when the option is activated.

e Last manipulated Light Shadow:

When checked, OpenGL takes into account shadows cast from the last light or sun manipulated.

NB: The refresh time of Preview slows down when the option is activated.

o FPS:

Page - 190



Preferences - Preference Settings nd

Increases or reduces OpenGL navigation fluidity. The greater the number, the better the fluidity. On the other
hand, a low figure gives better image definition.

Move the slider or enter a value of between 1 and 30 images per second.

Final Renderer

e Rendering output folder:
2 choices for the default rendering output folder:
m  Document directory: The renderings are saved at the same level as the current file.
»  Default output directory: Click on the button to choose the folder.
Final Renderer
Rendering outpot drectory:
{¥) Document drectory

) Def ik output drectoey
[

| &

Dt st Fils nagmn: | Wiesw Names w

Dwefault fils format: | PEG W

Default file name: either the name of the viewpoint, or the name of the document plus the name of the
viewpoint.

Default file format: in the drop-down menu, choose: JPEG, BMP, TARGA, PICT, TIFF, Photoshop,
Piranesi.
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Mouse and Keyboard Shortcuts

Available in 2D View and Preview.

In this chapter you will learn about the following subjects:

General 2D Shorteuts. .. ... .. e 194
2D Shortcuts - Working with Perspectives. .. ... ... ..o, 195
2D Shortcuts - Working with Parallel Views. _ . ... .. ... 195
2D Shortcuts - Working with the Clipping Box_ ... ... ... ... ... 195
2D Shorteuts - Working with Objects. . ... ... ... .. ... 197
2D Shortecuts - Working with Lights. .. ... ..ol 198
2D Shortcuts - Working with Heliodons. .. ... ... ... . ... 198
2D Shortecuts - Working with Panoramas. . .. ... ... ...l 200
2D Shortcuts - Working with VR Objects. . ... .. ... .. 200
2D Shortcuts - Working with Animations. ... ... .. ... 201
General Preview Display Shorteuts. .. ... ... 201
Activated Object Inspector Preview Shorteuts. .. ... .. . . . . . ... 202
General Preview Shortcuts. . ... .. 203
Perspective Inspector Preview Shortcuts - Site Insertion. ... ... . ... . . ... ... . ... ... 204
Activated Heliodon Inspector Preview Shorteuts. . ... .. ... .. ... ...... 204
Activated Shaders Inspector Preview Shorteuts. ... ... . . . .. ... ... 206
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General 2D Shortcuts

Actions Combination and Key Strokes
Enlarge display. Ctrl +
N gy ——
Reduce the display. Ctrl =

PR [ ——

Fit in Window.

Ctrl =

PRS- ar—|

Camera pan movement.

]
AL

Cirl / |
& or -

Enlarge a part of the window by drawing a rectangle
with 2 opposing angles

Citrl * |
&

+ or - Dynamic Zoom depending on the target.

]
Al

Change 2D View.

Cirl
Depending on the view, press the
of the keys on the keyboard:

key followed by one

1 (Above), 2 (Front), 3 (Right), 4 (Left), 5 (Rear)

Previous view.

Next View.

Activate the Pop-up menu.

Force a movement on a 45° incremental scale.
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2D Shortcuts - Working with Perspectives

Actions

Combination and Key Strokes

Inspectors: Shaders, Lights, Heliodons, Objects and Per-

spectives.

Graphically move the camera, the target or the
bisector.

Graphically modify the focal distance.

N

Duplicate a Viewpoint.

2D Shortcuts - Working with Parallel Views

Actions

Combination and Key Strokes

Inspectors: Shaders, Lights, Heliodons, Objects, and Parallel

Views.

Graphically move the camera, the target or the
bisector.

Graphically modify the section width.

e

I

Duplicate a Viewpoint.

Alt

I

2D Shortcuts - Working with the Clipping Box

In order to use the Clipping Box tool, the "Show" option must be checked in the Perspectives inspector.

J Shawe [#] Activate 0

The command takes effect with all inspectors
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Actions:

e Blue contour line entry.
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e Move the origin of the circular cursor by clicking and dragging from the center.

The recall lines coming from the center help in positioning.

2D Shortcuts - Working with Objects

| Actions |

You can only manipulate objects in Objects

Move an object.

mode.

=

Duplicate an Object.

Alt |
& '\:-

Duplicate an object several times.

"
ElEl W,
El

increases

or

Ll

decreases the number of copies

Redefine the anchor point of an
object
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2D Shortcuts - Working with Lights

Actions

Combination and Key Strokes

Inspectors: Shaders, Lights, Perspectives, Parallel
views, Panoramas, VR Objects, Animations.

Graphically move the source, the target and the bisector,
modify the light cone and the lighting distances.

Duplicate a light.

Duplicate a light several times.

k|
& ——
"

ElEl @,
5

to increase

or

Ll

decrease the number of copies.

2D Shortcuts - Working with Heliodons

Depending on the operation chosen in the Heliodons inspector Location, Manual, 45°.

X .} LoCakion Manisal -I*:-f - |

‘S Franisco vi B

Location option:

e Defines the direction North by moving the yellow point around the compass.
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e Result: Shadows are recalculated.

Manual Sun Position option

e Result: Shadows are recalculated.

There is an option for shadows to be projected at 45° depending on the position of the viewpoint.

e The angle between the viewpoint bisecting line and the position of the sun always remains at 45°.

e Result: Even after the camera is graphically moved, the shadows always stay at 45° to the camera.
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2D Shortcuts - Working with Panoramas

Actions

Combination and Key Strokes

Inspectors: Shaders, Lights, Heliodons, Objects and

Graphically move the camera, the target or the bisector.

Panoramas

Graphically modify the focus (Perspectives, VR Objects,
Animations)

Graphically modify the view width (Panoramas)

o

Duplicate a Viewpoint.

Alt

2D Shortcuts - Working with VR Objects

Actions

Combination and Key Strokes

Inspectors: Shaders, Lights, Heliodons, Objects and

Graphically move the camera, the target or the bisector.

VR Objects

Graphically modify the focus (Perspectives, VR Objects,
Animations)

Graphically modify the view width (Panoramas).

e

Duplicate a Viewpoint.
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2D Shortcuts - Working with Animations

Actions

Combination and Key Strokes

Inspectors: Shaders, Lights, Heliodons, Objects

Path edit mode:

path, or a control point.

For graphically moving the camera, viewpoint, bisecting line,

and Animations

Time edit mode:

For moving a keyframe.

Graphically modify the focal distance.

Extend a path.

Alt

& o

To the path's final control point

General Preview Display Shortcuts

Actions Combination and Key Strokes
Enlarge the content of the Preview window.
+
P—
NB: the camera does not move.
Reduce the content of the Preview window.
P—
NB: the camera does not move.
Fit in Window. =
P—
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Activated Object Inspector Preview Shortcuts

Combination and Key
Strokes

Select and/or move the object.

f

Duplicate Object.

Desktop.

Replace the object with a different one from a drag & drop from Catalog or

Move with no change of the hierarchy.
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General Preview Shortcuts

Actions Combination and Key Strokes
Parallel
Views and VR
Perspectives Panoramas Objects Animations
Mode. Mode. Mode. Mode
Turn the camera around the clicked point N/A N/A

}

~]
&
o

Turn the camera around its target - N/A . .
| —— - -
Turn the camera on itself. N/A
o e o

The + or - Dynamic Zoom is focused on the position
of the cursor. - N/A N/A

'}
i

Change the focus distance. N/A . N/A
— e
]
I.
—
]
I NB:
For a cam-
era with no
Camera pan movement. g N/A N/A path.
|
X | X
Pan To: Place a viewpoint perpendicular to a surface. 3 & N/A N/A S &
Click Click
w
el &
Click
Move the camera through the scene.
When the cursor is pointed towards the top of the win- NB:
dow, the camera advances in the scene; when it is For a cam-
pointed towards the bottom, it moves laterally away W era with no
towards one of the sides. & N/A N/A path.

Click
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NB: In Shaders, Lights, Heliodons and Objects modes, you can navigate just like in the viewpoints inspector
Space Bar J

by releasing the current Edit Shaders mode. Press the
binations described in the table.

key and then use the com-

Example:

In Shaders mode with a Perspectives display, you must use the following shortcut to turn the camera around its tar-

Space Bar J Alt | - Space Bar J )
get: & & ™= . Onceyou release , Edit Shaders mode
reactivates.

Perspective Inspector Preview Shortcuts - Site Insertion

Actions Combination and Key Strokes

Move the origin of the trihedron, pivot the axes or slide the yellow cursor
to the defined reference axis. —

Alt
Move the origin of the axes while maintaining the directions. & =
'
Show/Hide the magnifying glass. Each incrementation increases the con-
tent of the magnifying glass from 2x to 8x. =

Activated Heliodon Inspector Preview Shortcuts

Combination and Key
Actions Strokes

Manually move the sun.

NB: Only available when the Manual option is selected in the Heliodon inspec-

tor. .
# Ot T O
L¥-

Define fog start (advanced heliodon settings).

# Fog .

Srarnt distance -3 | 050 m

Click on the target icon and then click on an element in Preview.
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Example of manually moving the sun:

Preview: Manually moving the sun.

Result after movement.

NB: If the sun is not visible in the current view, you can make it display by modifying its position in 2D View.

Example of positioning the start of fog:

Click on the airplane in the foreground to define the fog start.
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Click on the airplane in the second plane to redefine the fog start.

Activated Shaders Inspector Preview Shortcuts

Combination and Key

Actions Strokes
Select a Material or a Shader. .
NB: The material is highlighted —_

Select a material or a Shader located behind a transparent sur-
face.

L

»n '}

Select a material or a Shader by reflexion in another material.

=

NB: if the Shininess slider is at maximum.

n i

Alt

Duplicate a Shader or texture.

'}
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